Contents

Copyrights .................................................................................................................. 7

1. Introduction ............................................................................................................. 9
   1.1. This manual ......................................................................................................... 9
   1.2. Use of symbols .................................................................................................... 9
   1.3. Intended audience ............................................................................................... 9
   1.4. Product documentation ..................................................................................... 10
   1.5. Document revisions ......................................................................................... 10

2. Safety information .................................................................................................. 11

3. Installation of REF 542plus Configuration Tool ................................................. 13
   3.1. System requirements ......................................................................................... 13
   3.2. Installing the REF 542plus Configuration Tool .............................................. 13
       3.2.1. Installable components ............................................................................. 13
       3.2.2. Installing a new version of the REF 542plus Configuration Tool .............. 15
       3.2.3. Restart after an installation ..................................................................... 16
   3.3. Removing the REF 542plus Configuration Tool ............................................ 16
   3.4. Starting the REF 542plus Configuration Tool ............................................... 16
   3.5. Using the REF 542plus Configuration Tool ..................................................... 17
       3.5.1. Operating Tool .......................................................................................... 18
       3.5.2. First steps in creating or editing an application ......................................... 18
       3.5.3. Working with projects .............................................................................. 18
       3.5.4. Selecting the language version .................................................................. 20
       3.5.5. Setting the PC and REF 542plus connection ........................................... 20
       3.5.6. Configuring REF 542plus ......................................................................... 20
       3.5.7. Creating a function chart (FUPLA) ........................................................... 21
           3.5.7.1. Adding and moving function blocks ................................................... 21
           3.5.7.2. Adding and moving a connection ....................................................... 23
           3.5.7.3. Starting configuration dialogs ......................................................... 24
           3.5.7.4. Deleting objects in the function chart ............................................... 26
           3.5.7.5. Checking function chart .................................................................... 26
           3.5.7.6. Setting the LCD and display language .............................................. 27
       3.5.8. Uploading/downloading configuration ...................................................... 27
   3.5.9. Description of the Main menu items ............................................................. 29
       3.5.9.1. File ....................................................................................................... 29
       3.5.9.2. Connect ................................................................................................. 31
       3.5.9.3. View ..................................................................................................... 35
       3.5.9.4. Configure .............................................................................................. 35
       3.5.9.5. Utilities ................................................................................................. 54
3.5.9.6. Options ........................................ 55
3.5.9.7. Help ............................................ 58
3.5.10. Description of the Drawing menu items .......... 59
3.5.10.1. File ............................................. 59
3.5.10.2. Edit ............................................. 60
3.5.10.3. View ............................................ 61
3.5.10.4. Insert ........................................... 62
3.5.10.5. Utilities ........................................ 63
3.5.10.6. Options ........................................ 65
3.5.10.7. Help ............................................ 65
3.5.11. Description of the status bar ....................... 66

4. Setting REF 542plus ........................................ 67
4.1. Connecting inputs and outputs ......................... 67
4.2. General settings ........................................ 68
4.2.1. Serial Port ........................................ 68
4.2.2. TCP/IP port ........................................ 71
4.2.3. Global Settings ..................................... 76
4.2.4. Hardware .......................................... 81
4.2.5. Analog inputs ...................................... 84
4.2.6. Analog Input 20 mA ................................ 86
4.2.7. Analog outputs 20 mA ................................ 88
4.2.8. Single line diagram ................................... 91
4.2.8.1. User controls of the LCD editor........ 91
4.2.8.2. Working with the LCD editor............ 94
4.2.8.3. Configuration dialog box for symbols .......... 97
4.2.8.4. Configuration dialog box for lines ....... 99
4.2.9. Display language ..................................... 99
4.2.10. Char maps (For operation with HMI V4)..........101
4.2.11. LED Bars ..........................................103
4.3. Function and configuration of the function blocks ....104
4.3.1. Control panel on the HMI control unit ............104
4.3.1.1. Indication LED .............................105
4.3.1.2. Alarm LED ..................................109
4.3.1.3. Alarm Reset ................................110
4.3.1.4. LR-Key ....................................... 111
4.3.1.5. Emergency Buttons ..........................112
4.3.1.6. HMI Command .............................113
4.3.1.7. Enable/Disable .............................114
4.3.2. Binary IO (switching objects) .......................115
4.3.2.1. Switching Object 0-1 .....................121
4.3.2.2. Switching Object 0-3 .....................123
4.3.2.3. Switching Object 1-0 .....................126
4.3.2.4. Switching Object 1-1 ................. 129
4.3.2.5. Switching Object 1-2 ................. 132
4.3.2.6. Switching Object 2-1 ................. 136
4.3.2.7. Switching Object 2-2 ................. 139
4.3.2.8. Switching Object 2-2 H-Bridge ... 150
4.3.2.9. Switching Object 4-4 H-Bridge ..... 159
4.3.2.10. Module for truck (withdrawal unit) . 170
4.3.2.11. IO-Supervision ....................... 172

4.3.3. Digital logic 1 ............................... 174
4.3.3.1. Inverter .................................. 174
4.3.3.2. Constant 1/Constant 0 ............... 175
4.3.3.3. AND logic gate with inverting output . 175
4.3.3.4. AND logic gate with an inverting input ........................................... 176
4.3.3.5. AND logic gate .......................... 177
4.3.3.6. OR logic gate ............................ 178
4.3.3.7. OR logic gate with inverting output .. 179

4.3.4. Digital logic 2 ............................... 179
4.3.4.1. Exclusive OR logic gate .............. 180
4.3.4.2. Exclusive OR logic gates with inverting output ........................................... 181

4.3.5. Flip-Flops ................................. 181
4.3.5.1. R-S Flip-Flop ............................ 182
4.3.5.2. R-S Flip-Flop with timing input (clock) ........................................... 183
4.3.5.3. J-K Flip-Flop ............................ 184
4.3.5.4. D Flip-Flop ............................... 185
4.3.5.5. T Flip-Flop ............................... 186
4.3.5.6. Monoflop retriggerable ............... 187
4.3.5.7. Monoflop non-retriggerable .......... 188
4.3.5.8. Drop Delay/Rise Delay (slope delay) ........................................... 189
4.3.5.9. Counter .................................. 191
4.3.5.10. Pulse generator ......................... 193
4.3.5.11. Digital Store object .................... 195

4.3.6. Analog Objects ............................. 196
4.3.6.1. Analog Threshold ....................... 196
4.3.6.2. Measurement supervision NPS and PPS ........................................... 199
4.3.6.3. Analog Input 20mA object .......... 204
4.3.6.4. Energy management ...................... 208
4.3.6.5. Energy Counter ......................... 209
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.6.6</td>
<td>Energy Pulse Output</td>
<td>211</td>
</tr>
<tr>
<td>4.3.6.7</td>
<td>Power Factor Controller</td>
<td>214</td>
</tr>
<tr>
<td>4.3.7</td>
<td>Communication objects</td>
<td>223</td>
</tr>
<tr>
<td>4.3.7.1</td>
<td>Binary Write</td>
<td>224</td>
</tr>
<tr>
<td>4.3.7.2</td>
<td>16-Bit Write</td>
<td>227</td>
</tr>
<tr>
<td>4.3.7.3</td>
<td>Binary Read</td>
<td>230</td>
</tr>
<tr>
<td>4.3.7.4</td>
<td>16-Bit Read</td>
<td>233</td>
</tr>
<tr>
<td>4.3.7.5</td>
<td>Direct Read-Write</td>
<td>236</td>
</tr>
<tr>
<td>4.3.7.6</td>
<td>Event Generator</td>
<td>238</td>
</tr>
<tr>
<td>4.3.7.7</td>
<td>Bay Reserve</td>
<td>241</td>
</tr>
<tr>
<td>4.3.7.8</td>
<td>Switch Authority Allocation</td>
<td>245</td>
</tr>
<tr>
<td>4.3.8</td>
<td>CAN Communication Objects</td>
<td>248</td>
</tr>
<tr>
<td>4.3.9</td>
<td>Miscellaneous objects</td>
<td>248</td>
</tr>
<tr>
<td>4.3.9.1</td>
<td>Parameter Set Selector</td>
<td>248</td>
</tr>
<tr>
<td>4.3.9.2</td>
<td>Operating hours counter</td>
<td>252</td>
</tr>
<tr>
<td>5.</td>
<td>Terminology</td>
<td>255</td>
</tr>
<tr>
<td>6.</td>
<td>Abbreviations</td>
<td>257</td>
</tr>
</tbody>
</table>
Copyrights

The information in this document is subject to change without notice and should not be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB Oy be liable for incidental or consequential damages arising from the use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB Oy, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied or disclosed only in accordance with the terms of such license.

© Copyright 2016 ABB Oy

All rights reserved.

Trademarks

ABB is a registered trademark of ABB Group. All other brand or product names mentioned in this document may be trademarks or registered trademarks of their respective holders.

 Guarantee

Please inquire about the terms of guarantee from your nearest ABB representative.
1. Introduction

1.1. This manual

This manual describes how to use the REF 542plus Configuration Tool program.

1.2. Use of symbols

This publication includes the following icons that point out safety-related conditions or other important information:

- The electrical warning icon indicates the presence of a hazard which could result in electrical shock.

- The warning icon indicates the presence of a hazard which could result in personal injury.

- The caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in corruption of software or damage to equipment or property.

- The information icon alerts the reader to relevant facts and conditions.

It should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to information or property loss. Therefore, comply fully with all notices.

1.3. Intended audience

This manual is intended for engineers to support configuration and engineering of systems and/or applications.
1.4. Product documentation

<table>
<thead>
<tr>
<th>Name of the Manual</th>
<th>Document ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real Time Clock Synchronization, IRIG-B Input Time Master</td>
<td>1MRS755870</td>
</tr>
<tr>
<td>Product Guide</td>
<td>1MRS756269</td>
</tr>
<tr>
<td>Configuration Manual</td>
<td>1MRS755871</td>
</tr>
<tr>
<td>iButton Programmer User Manual</td>
<td>1MRS755863</td>
</tr>
<tr>
<td>Manual Part 3, Installation and Commission</td>
<td>1 VTA100004</td>
</tr>
<tr>
<td>Manual Part 4, Communication</td>
<td>1VTA100005</td>
</tr>
<tr>
<td>Motor Protection with ATEX Certification, Manual</td>
<td>1MRS755862</td>
</tr>
<tr>
<td>SCL Tool Configuration Manual</td>
<td>1MRS756342</td>
</tr>
<tr>
<td>Protection Manual</td>
<td>1MRS755860</td>
</tr>
<tr>
<td>Technical Reference Manual</td>
<td>1MRS755859</td>
</tr>
<tr>
<td>Technical Reference Modbus RTU</td>
<td>1MRS75888</td>
</tr>
<tr>
<td>Web Manual, Installation</td>
<td>1MRS755865</td>
</tr>
<tr>
<td>Web Manual, Operation</td>
<td>1MRS755864</td>
</tr>
<tr>
<td>IEC 61850 PXIT</td>
<td>1MRS756360</td>
</tr>
<tr>
<td>IEC 61850 Conformance Statement</td>
<td>1MRS756361</td>
</tr>
<tr>
<td>IEC61850 TISSUES Conformance Statement</td>
<td>1MRS756362</td>
</tr>
<tr>
<td>Lifecycle Service Tool</td>
<td>1MRS756725</td>
</tr>
</tbody>
</table>

1.5. Document revisions

<table>
<thead>
<tr>
<th>Version number</th>
<th>IED Revision number</th>
<th>Date</th>
<th>History</th>
</tr>
</thead>
<tbody>
<tr>
<td>1VTA100003</td>
<td>Rev.2, en</td>
<td>22.10.2002</td>
<td>First release</td>
</tr>
<tr>
<td>1VTA100172</td>
<td>Rev 3, en</td>
<td>22.11.2003</td>
<td>Updated to version 4D02</td>
</tr>
<tr>
<td>A</td>
<td></td>
<td>28.02.2006</td>
<td>Document updated</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- language</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- layout</td>
</tr>
<tr>
<td>B</td>
<td>2.5</td>
<td>30.09.2006</td>
<td>Updated to software version V4E02e.</td>
</tr>
<tr>
<td>C</td>
<td>2.5</td>
<td>31.05.2007</td>
<td>Updated to software version V4E04x.</td>
</tr>
<tr>
<td>D</td>
<td>2.6</td>
<td>19.12.2008</td>
<td>Updated to software version V4F06x</td>
</tr>
<tr>
<td>E</td>
<td>3.0</td>
<td>10.02.2010</td>
<td>Updated to software version V4F08x</td>
</tr>
<tr>
<td>F</td>
<td>3.0</td>
<td>27.06.2016</td>
<td>Content updated</td>
</tr>
</tbody>
</table>

Applicability

This manual is applicable to REF 542plus Release 3.0, software version V4F08x.
2. Safety information

Dangerous voltages can occur on the connectors, even though the auxiliary voltage has been disconnected.

Non-observance can result in death, personal injury or substantial property damage.

Only a competent electrician is allowed to carry out the electrical installation.

National and local electrical safety regulations must always be followed.

The frame of the device has to be carefully earthed.

The device contains components which are sensitive to electrostatic discharge. Unnecessary touching of electronic components must therefore be avoided.
3. Installation of REF 542plus Configuration Tool

3.1. System requirements

- IBM compatible personal computer
- Intel Pentium processor
- Minimum 128 MB RAM
- CD-ROM drive or DVD-ROM drive
- Free hard drive 50 MB
- Microsoft Windows NT 4.0 Service Pack 6, Windows 2000, Windows XP, Windows Vista
- Mouse

3.2. Installing the REF 542plus Configuration Tool

There are two different versions of the REF 542plus Configuration Tool. The REF 542plus Configuration Tool can only be used by ABB switchgear companies. The use of the Operating Tool has no restrictions. The REF 542plus Configuration Tool allows inserting protection function blocks. The Protection function menu is disabled in the Operating Tool.

The installation software automatically selects the language used to guide the user through the installation process based on the User Locale Settings of the Windows system. The following languages are available:

- English (US)
- German
- Italian
- Czech
- Slovak
- In all the other cases English is the default

Follow the instructions and observe the information provided by the installation program. Every step in the installation process can be reversed or the entire program can be cancelled.

To start the installation software, start the set up.exe program on the disk for example by double-clicking the left mouse button when the cursor is over the file.

3.2.1. Installable components

In the setup wizard it is possible to choose between two setup types: complete and custom.
Fig. 3.2.1-1 Choosing the setup type

The complete setup installs automatically the following components:

- The REF 542plus Configuration Tool (mandatory) which contains:
  - Executable and language libraries
  - Latin and Cyrillic fonts for the HMI
  - English and Russian
  - String files (STC)
  - The Analog Input Boards definition
  - The Web Server configuration file
  - An example of drawing (optional) and an empty drawing into the Drawings folder
  - The character map bitmaps (for Latin and Cyrillic ASCII chars). These bitmaps can be used to customize the characters downloaded to the HMI.

The Custom Setup allows the user to select/deselect the optional components.
Fig. 3.2.1.-2 Custom Setup

Select/deselect a program feature by clicking on the component in the Custom Setup window.

Fig. 3.2.1.-3 Selecting and deselecting features in the Custom Setup window

Complete Setup is recommended.

3.2.2. Installing a new version of the REF 542plus Configuration Tool

A new installation does not overwrite older configuration tools. All older configuration tools not used anymore should be uninstalled from the system.
First uninstall old configuration tools if you intend to reuse the target directory or group names of an older installation.

3.2.3. **Restart after an installation**

Depending on the update status of your Windows libraries, the installation software can ask for a computer restart at the end of the process. Restarting is recommended.

3.3. **Removing the REF 542plus Configuration Tool**

The installed REF 542plus Configuration Tool is compliant with MSI (Microsoft Installer) technology. Thus it is always possible to repair or remove the tool from the computer.

To remove the REF 542plus Configuration Tool:
1. Go to the Start Menu and choose Settings.
2. Go to the Control Panel and select Add/Remove Programs.
3. Mark the REF 542plus Configuration Tool you would like to uninstall and click Remove.
4. Follow the instructions.

3.4. **Starting the REF 542plus Configuration Tool**

After the installation has been completed as described in Section 3.2. Installing the REF 542plus Configuration Tool, the REF 542plus Configuration Tool can be started as follows:

The program groups are accessed through the Start button. By default the program group with the REF 542plus configuration software is in:

<programs folder>\ABB\REF 542plus\....

For example:

C:\Program Files\ABB\REF 542plus\ConfToolV4E06x\ 

This folder structure is not mandatory. Usually the common “ABB” folder is followed by the product name (REF 542plus). Leave the version of the tool in the folder name so that it would be easier to handle side-by-side installation of different configuration tools on the same computer.
Fig. 3.4.-1 Main view of the IED Configuration Tool

The menu is described in Section 3.5.9. Description of the Main menu items. The status bar of the main view is described in Section 3.5.11. Description of the status bar.

Pay attention to the version in the main view of the REF 542plus Configuration Tool or in the About dialog box (available in the Help menu). Ensure it is the latest available version and compatible with the firmware version of the REF 542plus to be configured.

3.5. Using the REF 542plus Configuration Tool

The following sections provide basic information on using the REF 542plus Configuration Tool. The most important activities in creating or editing an application are described.

Section 3.5.9. Description of the Main menu items explains the menu items in the main menu and the character menu in the sequence in which they are displayed in the REF 542plus Configuration Tool.

The limitations of the operating tool that are described in this section are not explained any further in the configuration tool manual.
3.5.1. **Operating Tool**

The Operating Tool has the following limitations:

Additional protection functions cannot be added to the application. If a protection function in the application is deleted, it cannot be added again later.

3.5.2. **First steps in creating or editing an application**

All the functions of the REF 542plus Configuration Tool are not described in the following sections. All menu items in the REF 542plus Configuration Tool are described in Section 3.5.9. Description of the Main menu items.

The sequence of the following sections corresponds to the same sequence of steps required when defining a new application. When an existing application is opened, all basic settings are of course already specified. The function chart is also complete. However, the procedure for editing an application is the same as for creating a new one.

3.5.3. **Working with projects**

The set of files that belongs to an application in connection with the REF 542plus Configuration Tool is referred to a project. Projects can be created, opened and saved in the REF 542plus Configuration Tool. After starting the REF 542plus Configuration Tool, a new project by the name new.ref is created.

When saving a new project for the first time, always use **Main Menu > File > Save as** F7. Otherwise the name "new.ref" is used.

Table 3.5.3.-1 describes the set of files associated with a project. Not all of them are created in every application. In addition, the table shows when the files are created or updated. If the files need to be created, the corresponding menu Generate Report File must be activated.

<table>
<thead>
<tr>
<th>File</th>
<th>Contents</th>
<th>Created</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.ref</td>
<td>File comprising: - Drawing - Parameter - HMI LCD configuration - LCD texts All other files can be recreated from this file, with the exception of the fault record files and of the SCL file (WEBREF configuration)</td>
<td>When saving</td>
<td>When saving</td>
</tr>
<tr>
<td>*.bak</td>
<td>Application back-up file</td>
<td>When opening</td>
<td>When opening</td>
</tr>
<tr>
<td>*.doc</td>
<td>- Device configuration - Rated values of the analog inputs - Configured protection functions with setting values</td>
<td>When printing or generating reports</td>
<td>When printing or generating reports</td>
</tr>
<tr>
<td>File</td>
<td>Contents</td>
<td>Created</td>
<td>Updated</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>*.wir</td>
<td>All connections in use are counted, the connection number and the associated text is saved. The object number sorts the connections to which they are connected and by the number of the connector pin. Also the object type to which the connection is linked is written to this file.</td>
<td>When printing or generating reports</td>
<td>When printing or generating reports</td>
</tr>
<tr>
<td>*.lst</td>
<td>All events generated by the application are listed here.</td>
<td>When printing or generating reports</td>
<td>When printing or generating reports</td>
</tr>
<tr>
<td>*.can</td>
<td>CAN related information (I/O blocks, addresses, and so on)</td>
<td>When printing or generating reports</td>
<td>When printing or generating reports</td>
</tr>
<tr>
<td>*.lcu</td>
<td>The mimic diagram configuration of the current application.</td>
<td>When exporting a mimic diagram</td>
<td>When exporting a mimic diagram</td>
</tr>
<tr>
<td>*.svg</td>
<td>The mimic diagram configuration of the current application in Standard Vector Graphic format.</td>
<td>When generating the SVG file if the Web interface is enabled</td>
<td>When generating the SVG file if the Web interface is enabled</td>
</tr>
<tr>
<td>*.ri1</td>
<td>The setting parameter set 1 of the distance protection. The Omicron test set uses this file for automatic testing.</td>
<td>When saving an application with distance protection</td>
<td>When saving an application with distance protection</td>
</tr>
<tr>
<td>*.ri2</td>
<td>The setting parameter set 2 of the distance protection. The Omicron test set uses this file for automatic testing.</td>
<td>When saving an application with distance protection</td>
<td>When saving an application with distance protection</td>
</tr>
<tr>
<td>*.rca</td>
<td>XML file contains the SPA registers of the objects which are applied in the specific configuration and used as input by the Modbus Suite Tool and the SCL Tool for IEC 61850.</td>
<td>When generating the SPA address file in the main menu</td>
<td>When generating the same menu again</td>
</tr>
<tr>
<td>*.rce</td>
<td>The default events for each FUPLA object based on the 61850 data model</td>
<td>Provided with the application</td>
<td>When clicking Save default in Event page of each FUPLA object</td>
</tr>
<tr>
<td>*.rcm</td>
<td>The setting parameter of the communication described in the ascii-file</td>
<td>When saving the file generated in the communication menu</td>
<td></td>
</tr>
<tr>
<td>*.cfg</td>
<td>Configuration file for the fault recorder module.</td>
<td>When exporting a fault record</td>
<td></td>
</tr>
<tr>
<td>*.dat</td>
<td>Fault record file with the recorded data.</td>
<td>When exporting a fault record</td>
<td></td>
</tr>
</tbody>
</table>

Only files with the names *.ref can be opened directly in the REF 542plus Configuration Tool.
3.5.4. **Selecting the language version**

Select the language of the menus, dialog boxes and messages of the configuration software in **Main Menu > Options > Language > [English, German, Italian, Czech]**. The setting takes effect immediately and it is also kept after closing the software.

3.5.5. **Setting the PC and REF 542plus connection**

To download the application from the PC to REF 542plus or to upload an application or other data from the REF 542plus, the connection must be established first. To properly configure the connection port, open the dialog box in **Main Menu > Connect > Port Configuration**.

**Serial connection**

A serial/optical cable is needed. One end is plugged in to the optical interface of the HMI and the other end is plugged in to the PC serial RS-232 interface. Ensure that the parameters of the dialog box "Serial Interface" in the configuration software are the same as the parameters for the serial interface configured in the operating system.

Ensure that the slave address of the dialog box "Serial Interface..." in the configuration software is the same as the slave address of the connected base unit. If not, the communication between the PC and REF 542plus cannot be established.

**TCP/IP connection**

A standard Ethernet cable is needed. One end is plugged in to the Ethernet interface of the device and the other end is plugged in to the PC Ethernet interface. Set the IP address of the REF 542plus device and ensure that the subnet mask of the PC Ethernet Adapter is the same as that of the REF 542plus device.

The TCP/IP settings of REF 542plus can be read from the Communication dialog box of the Configuration Tool under **MAINBOARD > TCP/IP properties**.

3.5.6. **Configuring REF 542plus**

To be able to configure the application, the hardware module installed in the REF 542plus must be entered into the configuration software. Enter the hardware module to the REF 542plus Configuration Tool in **Main Menu > Configure > Global Settings and in Main Menu > Configure > Hardware**.

The communication with the station control system can be configured by selecting **Main Menu > Communication**. In this submenu you can define the properties for the communication via the Ethernet interface on the mainboard of the REF 542plus.
The properties can be defined for the communication using TCP/IP, for example MODBUS TCP/IP, WEBSERVER or GSM/SMS, can be defined accordingly. Besides that, the communication setting using the optional communication module can also be selected. The setting is for example SPA, Modbus RTU, ABB LON or IEC 60870-5-103 can also be selected. The communication setting can then be saved to a file. Downloading the communication parameter can later be performed separately from the downloading of the FUPLA.

The analog inputs and outputs should be defined before making the application settings in Main Menu > Configure > Terminals > Analog Inputs and if necessary in Main Menu > Configure > Terminals > Analog Outputs. If an analog output board is not used, this menu item cannot be selected.

The analog inputs 0/4-20 mA can be defined if necessary in Main Menu > Configure > Terminals > Analog Inputs 4-20 mA. If an analog input 4-20 mA board is not used, this menu item cannot be selected.

The menu Main Menu > Component is prepared for future use. It has currently no functionality.

It is recommended to define the display language (Main Menu > Configure > HMI > Display Language) before continuing the configuration. This setting influences the translation to REF 542plus fonts of strings on the configuration software in case of non-Latin characters (for example Cyrillic, Chinese, Hebrew, and so on).

### 3.5.7. Creating a function chart (FUPLA)

To create the function chart, start the function chart editor in Main Menu > Configure > Drawing.

Before the function chart editor can be started, make the settings for a new application in Main Menu/Configure/Global Settings and in Main Menu > Configure > Hardware.

The first page of the application is displayed. To make an application more manageable, it can be distributed over several pages. One page is larger than the PC screen. All areas of the current page can be viewed by using the scroll bars to the right and at the bottom of the drawing editor window. The arrow keys (arrow keys) on the keyboard can also be used for this.

### 3.5.7.1. Adding and moving function blocks

Function blocks can be added and moved in the working mode.
Add a function block

Select **Drawing Menu > Insert**. A submenu with various function groups is displayed. Selecting a function group brings up another submenu listing the individual function blocks. The selected function block is placed on the top left of the page.

Example: Select **Drawing Menu > Insert > Control Panel > Indication LED** to select the indication LED function block.

Move a function block

To move, hold the left mouse button down when the cursor is on the function block and drag it with the mouse.

Restrictions

Note that not all function blocks can be combined together.

Restrictions for function blocks and connections are listed in Table 3.5.7.1.-1.

<table>
<thead>
<tr>
<th>Function block</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protection function</td>
<td>Max. 24 protection functions</td>
</tr>
<tr>
<td></td>
<td>Max. 250 protection parameters</td>
</tr>
<tr>
<td></td>
<td>100% DSP load</td>
</tr>
<tr>
<td>Fault recorder</td>
<td>Max. 1 fault recorder and Min. 1 configured</td>
</tr>
<tr>
<td></td>
<td>protection function</td>
</tr>
<tr>
<td>Digital store object</td>
<td>Max. 1</td>
</tr>
<tr>
<td>Energy counter</td>
<td>Max. 15</td>
</tr>
<tr>
<td>Switching object</td>
<td>Max. 62</td>
</tr>
<tr>
<td>Analog threshold objects</td>
<td>Max. 10</td>
</tr>
<tr>
<td>Analog Input 0-20 mA object</td>
<td>Max. 48</td>
</tr>
<tr>
<td>Direct read write object</td>
<td>Max. 99</td>
</tr>
<tr>
<td>Net number</td>
<td>Max. 512</td>
</tr>
<tr>
<td>Wire</td>
<td>Max. 1000</td>
</tr>
<tr>
<td>Signaling LED</td>
<td>Max. 32 on 4 sides of 8 LED's each</td>
</tr>
<tr>
<td>Number of pages</td>
<td>Max. 99</td>
</tr>
<tr>
<td>HMI commands</td>
<td>Max. 32</td>
</tr>
<tr>
<td>Control objects visible on HMI</td>
<td>Max. 48</td>
</tr>
</tbody>
</table>

Determining the cycle time

Once a new application has been created and loaded into the REF 542plus device, its cycle time must be checked. The cyclic time is displayed on the HMI menu Service/Statistics.
The application cycle time must be less than 30 ms to ensure proper functioning of REF 542plus. Longer times can result in poor and dangerous performances like missing events and binary I/O changes.

3.5.7.2. Adding and moving a connection

The function blocks can be linked to each other in the drawing mode. By positioning the cursor over a connection point on a function block or at the beginning or at the end point of a connection, the cursor changes to a shape of a soldering iron.

A total of 512 connections can be added. There are 502 numbers available for connections (11 … 512). Connection numbers 0 … 10 are for internal use.

Add a connection

When the soldering iron is displayed, hold the right mouse button down and drag the mouse to make a connection. The connection ends when the mouse button is released.

The terminals of two function blocks can be connected in this way. The connection can also end in the FUPLA without connecting to a terminal. The connection number is automatically 1 or 2 in this case to indicate that it does not connect two function blocks. Use the configuration dialog box to assign a previously used connection number to the connection. Connections with the same connection number can be linked even if they do not contact each other.

Connections run at right angles or in a straight line, therefore also diagonally, depending on their setting. The relevant setting is made in Drawing Menu > View > Wires > Right-angled or Drawing Menu > View > Wires > Straight.

Move a connection

When the soldering iron is displayed, hold the left mouse button down and drag the mouse to move a connection point. When the mouse button is released, the connection point remains at this position.

When a connection point is dragged or moved from one function block terminal to another, ensure that the connection is properly positioned at the function block.
Check connections after a move

There are two options how to check the connections:

- Move the cursor over the connection wire. Double-click the left mouse button to start the configuration dialog box for the wire. The terminal information area shows the number of the wire that is properly terminated. The numbers 11 and 12 indicate that there is still no connection.

  OR

- Move the function block in the FUPLA. If the connections are moved with it, the connection is correct.

3.5.7.3. Starting configuration dialogs

A dialog box can be opened for all function blocks and connections by moving the cursor over the function block or the wire and double-clicking the left mouse button. The configuration dialog box is displayed.

Configuration dialog box function block

The configuration dialog box for a connection enables the function block to be configured and/or provides information on the terminated connections.

Configuration dialog box for a connection

![Configuration dialog box for a connection](image)

Fig. 3.5.7.3.-1 Configuration dialog box for a connection

Net number

Enter the wire connection number in the Net number text box. The currently assigned connection number is displayed, a 1 or a 2. Only numbers 1 or 2 are displayed when the connection ends with a terminal point in the FUPLA. To find the currently assigned connection number, the configuration software searches the connection numbers from 11 upwards for a free connection.
The connection number is also displayed in the function chart beside the connection.

Setting range: 11 ... 512 (steps: 1)
Default: currently assigned connection, 1 or 2

**Next unused net number**

The next free connection is assigned in Next unused net number. The configuration software searches the connection numbers from 11 upwards for a free connection.

**Maximum number of wires**

The Maximum number of wires information field displays the maximum possible number of connections in the current function chart. A total of 1000 connections can be used. There are 502 connection numbers available.

**Used**

The Used information field displays how many connections are already set up in the function chart.

**Comment**

Enter a comment, a name, for the connection in the Comment text box. The name is also displayed in the function chart beside the connection. This name is assigned to all connections with the same connection number.

Setting range: 0 … 20 characters of the standard character set
Default: [Empty]

**Choose next free**

Click on the Choose next free button to assign the next free connection number to the connection. The dialog box is then closed, and the connection has the corresponding number.

**OK**

Click OK to save all settings in the configuration software. The dialog box is closed.

**Cancel**

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
### Deleting objects in the function chart

Deleting a function block:
1. Move the cursor over the function block to be deleted.
2. Double-click the right mouse button.
3. A confirmation query is displayed.
4. Click the **OK** button to delete the function block or **Cancel** to keep the function block.

Deleting a connection:
1. Move the cursor over the connection which is to be deleted.
2. Double-click the right mouse button.
3. A confirmation query is displayed.
4. Click the **OK** button to delete the connection or **Cancel** to keep the connection.

Deleting the current page:
1. Select **Draw Mode > Edit > Delete Page**.
2. A confirmation query is displayed.
3. Click the **OK** button to delete the page or **Cancel** to keep the page.

Deleting all connections in the application:
1. Select **Draw Mode > Edit > Delete All > Wires**.
2. A confirmation query is displayed.
3. Click the **OK** button to delete the connections or **Cancel** to keep the connections.

Deleting all pages in the application:
1. Select **Draw Mode > Edit > Delete All > Pages**.
2. A confirmation query is displayed.
3. Click the **OK** button to delete the pages or **Cancel** to keep the pages.

### Checking function chart

The function chart can be checked both in draw mode and in connection mode. Press the F9 key on the keyboard or select **Drawing Menu > Utilities > Check Drawing F9** or **Main Menu > Utilities > Check Drawing F9**.

The checking routine of the configuration software runs the following tests:
- Binary inputs and outputs: checks availability of the numbers of the binary inputs and outputs used in the application. The availability depends on the number and type of binary input and output boards in use.
- Device configuration: checks availability of a device configuration. Checks if the configuration dialog box in **Main Menu > Configure > Hardware** has been processed.
- Function blocks: all function blocks must be linked to at least one connection.
- DSP load: the DSP load (load on the protection and measuring unit) can be maximum 100%. Maximum 250 protection parameters and maximum 24 protection functions can be used.
- Connections: the number of connections must not exceed 512.
- Double connections: connections with the same number may only be connected to one function block output.
- Calculation of power: the configuration of the analog inputs must match the type of power calculation.
- Switching objects: a maximum of 62 switching objects may be configured. Every switching object must have its own Field bus address and binary output represented by the switching object must be physically present.
- Direct write-read command: a maximum of 100 function blocks of this type are permitted.

3.5.7.6. Setting the LCD and display language

When the application has been set up, the mimic diagram for the LCD can be configured and the language in which the messages are displayed on the LCD selected in Main Menu > Configure > Display and in Main Menu > Configure > Display Language.

3.5.8. Uploading/downloading configuration

Once the configuration is completed, the next action is usually to download it to the device. The REF 542plus Configuration Tool is able to perform such action if the following conditions are valid:

The communication between REF 542plus HMI unit and the REF 542plus Configuration Tool has been established and it is working. To check the connection, check the version of the REF 542plus device (refer to Section 3.5.9.2. Connect).

The following problems can happen:

1. General communication error is that the REF 542plus device is not available.
   The problems and the possible solutions could be:

   **Table 3.5.8.-1 Problems and solutions**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>REF 542plus base unit is not turned on.</td>
<td>Connect the right power cable to the power supply.</td>
</tr>
<tr>
<td>REF 542plus HMI is not turned on.</td>
<td>Connect the right power cable to the power port of the HMI.</td>
</tr>
<tr>
<td>REF 542plus HMI is not connected to the REF 542plus base unit.</td>
<td>Connect it with the serial cable the right ports.</td>
</tr>
<tr>
<td>REF 542plus HMI is not ready.</td>
<td>It is ready when waiting a configuration or when a configuration has been already downloaded.</td>
</tr>
<tr>
<td>Broken cable</td>
<td>Replace the cable.</td>
</tr>
<tr>
<td>Coupling of optical connector to the HMI is not perfect.</td>
<td>Re-insert the connector.</td>
</tr>
<tr>
<td>PC COM port malfunction</td>
<td>Change the COM port or the PC.</td>
</tr>
</tbody>
</table>
Problem | Solution
--- | ---
COM settings on the REF 542plus Configuration tool do not match the current connection. | Change the COM settings. Refer to Section 3.5.5. Setting the PC and REF 542plus connection and Section 4.2.1. Serial Port. In particular, pay attention to: baud rate, data bits and base unit slave address.

PC COM port is already used by another software. | Close the application (for example Tera Term), which is using the COM port, and set again the COM settings in the REF 542plus Configuration Tool.

2. Not all the version information is published by the REF 542plus device. If the mandatory information is not published then the download command is not allowed. A REF 542plus V4E02x version should publish the following information:

- REF 542plus software/firmware versions are mandatory. Whatever the version is, REF 542plus has to publish them.
- Configuration information is optional. Available partially in version older than V4D02x. Remember that sometimes the information can be also a blank space and it can be a valid value.
- Char map information is mandatory. Available only in V4D02x REF 542plus versions. Needed only for REF 542plus V4E02 with HMI V4, which is the HMI version until now. For the new version HMI V5 the Unicode fonts are mandatory for displaying international characters.

3. The version of the REF 542plus in general must be compliant with the REF 542plus Configuration Tool. For example, if the device is a V4E02x, then the configuration tool should also be of the same version. For more detailed information, contact your local ABB representative.

4. The Char Map for HMI V4 or the Unicode fonts for HMI V5 in the REF 542plus device must match with the String file (STC) active in the configuration to be downloaded. For example, if the device contains the Latin char map, then only configurations with String file using this char map are downloadable. The REF 542plus device with HMI V4 is provided by default with a Latin char map, thus if another one is needed, then download first the new char map (for example Cyrillic, refer to Section 4.2.10. Char maps (For operation with HMI V4)).

From the version V4E04x onwards, the application of the HMI V4 is not recommended anymore.

The configuration of REF 542plus is always uploadable from the device. The REF 542plus Configuration Tool is able to perform such action, if the following conditions are valid:

Communication between REF 542plus HMI unit and REF 542plus Configuration Tool is established and working. To check the connection, check the version of the REF 542plus device (refer to Section 3.5.9.2. Connect). Follow the troubleshooting procedure of the download above.
The version of the REF 542plus device must be at least V4B.0x. During the upload, the configuration information is translated to the V4E02x version.

3.5.9. Description of the Main menu items

The menu items of the configuration software are grouped into main and drawing menus. The following sections provide a description of main menu items.

The main menu is displayed after starting the configuration software. The drawing menu items are described in Section 3.5.10. Description of the Drawing menu items

3.5.9.1. File

New

A new project under the name new.ref is created. Save it immediately under a different name, because this name is always reserved for new projects.

Open … F2

A dialog box for opening a file is displayed. The default file ending for the file format is ref. If necessary, browse through the disk and directory structure to open a configuration file.

The dialog box for opening the file is also displayed when the F2 key on the PC keyboard is pressed.

After the project has been opened, a drawing check is run. Any error messages must first be acknowledged before the project can be edited.

Save F6

The open application file is saved. If a new application file has been created, the file new.ref is saved in the default work directory of the configuration software. In case of a new file saved for the first time, use Save as.

An application can also be saved by pressing the F6 key on the PC keyboard.

Before saving, the configuration software runs a check of the application. Any messages that are displayed must be acknowledged before saving.
Save as F7

A dialog box for saving a file is displayed. The file can be given any wanted name and location. The default file ending for the file format is ref.

The dialog box can also be started by pressing the F6 key on the PC keyboard.

The configuration software runs a check of the application before saving. Any messages that are displayed must be acknowledged before saving.

Send E-Mail

Calls the default e-mail editor and inserts the currently open *.ref-file of the configuration software as attachment.

Print

A Print dialog box is displayed. Its appearance depends on the operating system and the installed printer. Additional inputs regarding the print process can be made in the dialog box.

Print > Drawing

The function chart is printed out, if necessary on several pages.

Print > Parameters

A file is printed with a list of all the parameters in the application sorted by their origin. For example, this includes the device settings and also the parameter sets for the protection functions.

Print > Eventlist

A file that lists all possible events that could be generated by the application is printed out. They are sorted by the function block that generated them.

Print > Connections

The connection numbers and the associated comments are printed out in a list form.

Print > CAN Settings

All the configured CAN addresses are printed. Not applicable for the time being.
Print Setup

When the configuration program is installed, the default printer is activated. If required, another printer can be directly selected and defined as the default printer.

Print Preview

Print Preview displays the preview of the drawing.

MRU (Most Recently Used files)

The four most recently used configuration files.

Exit Application

Ends the session of the configuration software.

3.5.9.2. Connect

To be able to use this menu, the REF 542plus device must be connected to a PC.

Port configuration

Starts the configuration dialog box for the connection from the PC to REF 542plus and selects the option Serial Port or TCP/IP Port.

Serial Port

Starts the configuration dialog box for the connection from the PC to REF 542plus via the serial port. The baud rate is to be set 9600 for former release 1.0 (version V4C01x), 19200 for release 2.0 (version V4D02x) or for release 2.5 using the existing HMI V4 and 115200 for release 2.5 using the new HMI V5 or connect it directly to the base unit by zero modem cable.

TCP/IP Port

Sets the IP address of the REF 542plus device and ensures that the subnet mask of the PC Ethernet adapter is the same as the one of the REF 542plus device.

The TCP/IP settings of REF 542plus can be read from the Communication dialog box of the Configuration tool in the section MAINBOARD > TCP/IP properties.
Send Configuration

Sends or downloads the data from the opened application in the PC to REF 542plus.

Load Configuration

Loads or uploads the application currently in REF 542plus from the device to the PC.

Send Mainboard Software

Sends or downloads the base software of the Mainboard.

Send COM Board Software

Sends or downloads the base software of the communication board (only for IEC103 or LON).

Read Fault recorder

Loads (or uploads) the fault record data saved in REF 542plus into the PC when the New Data button is clicked in the dialog box.

Input Status

Loads (or uploads) the current status of the binary inputs of the first two input/output boards of REF 542plus when the New Data button is clicked in the dialog box. The data are marked with the current PC system date and time and can be saved and printed.

Output Status

Loads (or uploads) the current status of the binary outputs of the first two input/output boards of REF 542plus when the New Data button is clicked in the dialog box. The data is marked with the current PC system date and time and can be saved and printed.

Measurement

Loads (or uploads) the current status of the operational measured values from REF 542plus. These are certain values that can also be displayed in the LCD screen above the mimic diagram.

The continuous measured value transmission to the PC can be configured in the operational measured values dialog box. The operational measured values and, if wanted, the values from the binary inputs and outputs, are then regularly transmitted from REF 542plus to the PC.
The data is marked with the current PC system date and time and can be saved and printed.

**CB Monitoring**

Displays the dialog that enables the CB Monitoring data reading to:
- upload data from the connected device
- reset data in the connected device
- save uploaded data to a recording file (text format)
- upload data from a recorded file

**Send Lifecycle data ...**

Requests the Lifecycle composition file from the device and sends it automatically to the Lifecycle Service Tool.

**Site information**

Displays the dialog for customer site information stored into REF542plus unit and allows updating it.

![Site Address Data](image)

**Fig. 3.5.9.2.-1 Site address data**
Connect > Version

Reads the current versions of the REF 542plus micro controllers (MC) and the configuration software. The information is displayed in a dialogue box. If a connection to REF 542plus cannot be established, an error message is displayed.

Fig. 3.5.9.2.-2  Connection warning when REF 542plus is not reachable

If the REF 542plus is available, the version dialog box is displayed.

Fig. 3.5.9.2.-3  Software, FUPLA and Char Map versions dialog box
The versions are divided into three groups:

1. Software: micro controller, DSP, HMI, field bus type, analog input 20 mA, configuration software versions. The REF 542plus version must be equal to the REF 542plus Configuration Tool version in order to download a configuration. Uploading is always possible.

2. FUPLA: configuration information like file name, project name, feeder name, FUPLA date, strings file name and license key.

3. For application with the HMI V4 the Char Map is to be used: header version, char map version, char map description and code page (and char map family code page, which is a reserved parameter). The REF 542plus stored char map must be equal to the downloaded configuration STC file. For example, if the REF 542plus Configuration Tool is on English STC file, then the char map on the device must be Latin. If not, it is necessary to download first the char map into the device (refer to Section 4.2.10. Char maps (For operation with HMI V4)) and then the configuration download. For the application with the new HMI V5 the Unicode fonts must be downloaded accordingly.

3.5.9.3. View

Toolbar

Opens the toolbar on the top side of the REF 542plus Configuration Tool.

Status Bar

Sets the status bar at the bottom of the REF 542plus Configuration Tool.

Transfer Bar

Opens the transfer bar below the toolbar.

3.5.9.4. Configure

Global Settings

Starts a configuration dialog box in which the basic settings are made. Functions such as fault monitoring, coil monitoring and default values such as the general filter time and the device address are defined here. In addition, the system messages (events), which can be sent from the system itself to a station control system, can be configured in two other dialog boxes.

This configuration dialog box must be edited before an application can be created.
Hardware

Starts a configuration dialog box in which settings that describe the delivery variations of the REF 542plus device can be made.

This configuration dialog box must be edited before an application can be created.

Communication

This dialog box must be filled in to set the properties for the communication ports.

![Dialog box for the Communication Port Properties](image)

The left side of the box describes the properties of the Ethernet port on the mainboard and the right side the parameter for the communication using the optional communication module. The Ethernet port can be used for MODBUS TCP, SPA TCP, the embedded WEB SERVER and the connection to GSM. In addition, for time synchronization of the mainboard, the connection to SNTP (Simple Network Time Protocol) by using the Ethernet port is also provided.

The optional communication module is foreseen for the following protocols:
The buttons in the Menu section for generating actions on the rcm file are the following:

- **Upload from file**: is used to upload a configuration (rcm file) previously saved on disk. A file pop-up dialog opens showing the folder from where to upload the file.
- **Save to file**: is used to store a configuration (rcm file) on disk. A file pop-up dialog opens showing the folder from which to download the file.
- **Upload from device**: is used to read the communication section parameters from a device.
- **Download to device**: is used to write the configuration of the communication parameters to a device.
- **Clear all settings**: is used to remove all previously configured settings.

Click **OK** to accept all the changes and close the dialog.

Click **Cancel** to discard all the changes and close the dialog.

Click **Apply** to accept all the changes and keep the dialog open.

**MAINBOARD > ETHERNET PORT**

If the connection to REF 542plus has been established, the MAC address can be obtained.

The MAC address is needed for the communication is not possible.

**MAINBOARD > TCP/IP properties**

When the TCP/IP properties have been selected, the following dialog box opens.
The parameters for the IP address of REF 542plus, subnet mask and default gateway are crucial for the TCP/IP communication.

**MAINBOARD > MODBUS TCP**

For the MODBUS TCP section there are two configuration settings to be done for the client IPs on:

- Access control module enabling/disabling
- Priority pool list
Fig. 3.5.9.4.-3 MODBUS TCP properties dialog box

Access Control Module:

If you enable the security access module you have to enter a list of authorized client IPs that are the unique clients that may establish a MODBUS TCP connection (maximum 10 IPs). Connections of clients with different IPs will be refused.

If the Access Control Module is not enabled, all the clients will be accepted to establish a connection.
Access Control Module Enabled

![Image of Access Control Module](A080216)

**Fig. 3.5.9.4.-4 Access control module enabled**

The authorized clients can belong to priority or non-priority connection pools with the constraint that the total number of priority and non-priority connections will be 4. When you enter client IPs in the priority pool from the authorized IP address, the number of free connections will be automatically updated. In fact, the number of non-priority client connections will be defined as the number of remaining free connections (not used by the priority pool) after the priority client connection configuration.

It is also necessary to configure the maximum number of connections allowed for each IP address belonging to the priority connection pool (in the above example the IP 10.10.10.176 of priority pool has 2 available connections, while the IPs 10.10.10.172 and 10.10.10.171 belong to two non-priority connections).

**Access Control Module Disabled**

If the Access Control Module is disabled, all the client's IPs are accepted. The configuration or priority pool/non-priority pools' client remains the same as described above with the freedom to add any IP (it is no longer present in the list of authorized IPs). In the below example, see figure 3.5.9.4.-4, the IP 10.10.10.175 is a priority client with 1 connection and the number of free connections for non-priority pools is then equal to 3.
MAINBOARD > SNTP

The following dialog box shows the SNTP (Simple Network Time Protocol) properties

![SNTP Properties](image)

Fig. 3.5.9.4.-5 SNTP properties

MAINBOARD > SNTP > Read Info Status

The following dialog box shows the SNTP Info Status dialog. From here it is possible to receive information only once or every two seconds about configuration values and status of the SNTP client and the 4 SNTP servers.
The following dialog box shows the SPA TCP properties. The user has to select whether to enable or not the Access Control Module. Only when enabled is it possible to insert one or more clients as authorized IPs.

The maximum number of authorized IP addresses is 10.

**SNTP data**

**MAINBOARD > SPA TCP**

The following dialog box shows the SPA TCP properties. The user has to select whether to enable or not the Access Control Module. Only when enabled is it possible to insert one or more clients as authorized IPs.

The maximum number of authorized IP addresses is 10.
Fig. 3.5.9.4.-7 SPA TCP properties

MAINBOARD > WEB SERVER

The following dialog box shows the user configuration for the embedded WEB server communication.
The following dialog box shows the user administration of new or existing users.
MAINBOARD > GSM/SMS

REF 542plus can operate on its own as an SMS gateway via a GSM modem, or it can refer to another connected device via TCP/IP. Usually only one REF 542plus in a switchgear has a GSM modem, and thus all the others refer to it.

The type of modem to be used can be selected from the modem configuration dialog box.

The modem does not require a PIN code for the SIM card.
COM BOARD

This part of the dialog box is dedicated for the communication setting using an optional module.

COM BOARD > MODULE TYPE

Several different module types can be selected:

- SPA
- ABB LON per LAG 1.4
- IEC 60870-5-103
- MODBUS RTU (the same module can be reprogrammed for SPA)
- Ethernet module for IEC 61850 or MODBUS TCP (both protocols can be applied simultaneously).

COM BOARD > PORTS

The slave address or unit ID for the communication can be defined in the following dialog box.
In case of the Ethernet module, the IP addresses of the two ports are not configured yet and are fixed to temporary invalid values 0.0.0.0. The configuration of valid IP addresses is needed, otherwise it is not possible to accept the changes made in the dialog or to download REF542plus of the *.rcm file. To configure the IP addresses, perform the following steps:

- Click the **Properties** button. A dialog for configuring the Ethernet card parameters opens.
- Click the **Read info status** button. A dialog displaying information status values for the Ethernet card opens.

The following Port1 and Port2 related parameters configured in the Properties dialog are displayed in the PORTS section:

- **Protocol**: the type of protocol loaded in the communication card.
- **IP address**: the IP address for the port.
- **MAC Address**: the MAC address for the port.

These values are displayed after you have given input in the Properties dialog. After clicking the **Properties** button, the Properties dialog opens and it is ready for data input.
The parameters that need configuring are grouped into three main sections (round circled in the Fig. 3.5.9.4.-13):

- **TOPOLOGY**
- **TCP/IP**
- **TIME SYNCHRONIZATION**

If you select the Single Channel topology option button, you need to select the channel number. The default value is CHANNEL 1.

After that the input data area for parameter settings of channel 1 (port 1) or channel 2 (port 2) is enabled. If required, for example for redundancy purposes, Dual Channel topology can also be used. Note that each port has to be connected to different network.

The default IP address for a completely new Ethernet module is 192.168.2.10. The related subnet mask is 255.255.255.0

A subnet mask does not work like an IP address, nor does it exist independently from the IP address. Instead, a subnet mask accompanies an IP address and the two values work together. All valid subnet masks contain two parts: the left side with all
mask bits set to '255' (the extended network portion) and the right side with all bits set to '0' (the host portion). If an invalid address for the IP address or for the subnet mask is inserted, an error message is displayed (see Fig. 3.5.9.4.-14).

![Error message for wrong IP address or the related subnet mask](A070416)

**Fig. 3.5.9.4.-14 Error message for wrong IP address or the related subnet mask**

If the Ethernet parameters are invalid, it is not possible to accept the changes made in the dialog or to download REF 542plus of the *.rcm file. An error message is displayed, see Fig. 3.5.9.4.-15.

![Error message for wrong Ethernet module configuration](A070417)

**Fig. 3.5.9.4.-15 Error message for wrong Ethernet module configuration**

If the Ethernet parameters in an existing *.ref file are already configured with communication parameters, it is strongly recommended to cross-check them by uploading the existing communication settings from the device.

It is always possible to save the *.rcm file, but the same error message appears again if the file is reused.

Use the check box in the Time Synchronization section to enable or disable the SNTP based time synchronization of the REF 542plus.

To accept the input data and close the dialog, click **OK**.

To discard any changes, click **Cancel**.

Once the configuration is completed, it is possible to start the download phase to REF 542plus.

However, if the GPS clock with IRIG-B is connected to the REF 542plus, the time is used as the time source regardless of whether this check box is checked or not.
COM BOARD > Read Info Status

If Module type is “ETHERNET,” the button Read Info Status displays the following dialog to read:

- GENERAL: The working status of the Ethernet board
- PROTOCOLS: For each protocol IEC61850 or MODBUS TCP it is possible to read
  - Status information
  - The number of active clients and the indication of the maximum number of allowed connections
  - Protocol configuration with the name of the configuration file.
- TCP/IP: The following information is provided for each port:
  - MAC address
  - IP address
  - Subnet mask
  - Default gateway
  - Status
- TIME SYNCHRONIZATION: Provides the CONFIGURATION value and the STATUS information regarding:
  - SNTP Client
  - SNTP Server 1
  - SNTP Server 2
  - SNTP Server 3
  - SNTP Server 4

The button Start polling can be used to refresh data every two seconds.
### Terminals

The Terminals menu item enables the selection of three submenu items. With them the analog inputs, analog inputs 20 mA and analog outputs 20 mA can be configured. Correct configuration of the analog inputs in particular is very important if REF 542plus is to function properly.

**Terminals > Analog Inputs**

Starts a configuration dialog box in which settings can be made to adapt the analog inputs of REF 542plus to the sensors or transformers used. These informations are important for starting and tripping protection functions. Measured values are also recorded with these sensors or transformers.

This configuration dialog box allows also the arrangement of other parameters: network settings and calculated values, such as the selection of metering system and the type of power calculation.
The same sensors or transformers are used for the protection and the measurement functions.

**Terminals > Analog Inputs 20 mA**

Starts a configuration dialog box in which settings can be made to adapt the 20mA Analog Inputs of the REF 542plus to the used sensors. Several SF6-density sensors but also general purpose sensors with 4..20mA-interface can be connected to these inputs.

**Terminals > Analog Outputs 20 mA**

Starts a configuration dialog box in which settings can be made to adapt the analog output 20 mA board of the REF 542plus used.

**Component**

Not applicable for the time being.

**Drawing**

Starts the function chart editor. Function blocks can be added, connected and configured to set the wanted functions for the bay control and protection unit.

The menu bar with the drawing menu is displayed. The menu items of the drawing menu are described later.

**HMI**

The HMI menu item enables the selection of further submenu items for the configuration of the single line diagram to be shown on the display, the language selection and so forth.

**HMI > Single Line Diagram**

Starts the editor for the LCD. The single-line diagram can be set up. Its elements are connected to the corresponding function blocks. At any time it is always possible to select IEC or ANSI bitmaps to be shown on the HMI.
HMI > Display Language

Starts the dialog box that sets the language version for the texts displayed on the LCD. At the same time the correct message texts for the application are selected. The dialog box shows also the char set code page of the selected language. The REF 542plus Configuration Tool uses this value in order to handle properly the non-Latin characters like Arabic, Cyrillic and Hebrew.

HMI > User Text

In case two languages are configured, the first language is always defined as the local one and the second language as English as default language. The display can be switched from one language to the other alternatively. This submenu item shows the text of the information to be displayed in those two languages.

HMI > Download Unicode Fonts

The Unicode fonts are already implemented on the HMI V5. If for some reason other unicode fonts need to be used, the download can be performed with this submenu item.

HMI > Char Maps

The user can manage the Char Maps bitmap fonts both on the PC and in REF 542plus. Refer to Section 4.2.10. Char maps (For operation with HMI V4)(for operation with HMI V4.

HMI > Key Code

The HMI > Key Code menu contains two submenus that allow online setting up of the protection and control keys. If REF 542plus is connected properly, the current key is displayed in the dialog box. Then the key can be changed. When the OK button is clicked, the key is sent to REF 542plus.

The key can be composed of maximum 16 alphanumeric chars.

HMI > Key Codes > Set protection key

Opens the dialog box to change the current protection key.

HMI > Key Codes > Set control key

Opens the dialog box to change the current control key.
HMI > LED Bars

Assigns the display of the measurement values to the LED bars according to the following configuration dialog box.

![LED Bars Configuration Dialog Box]

Fig. 3.5.9.4.-17 Configuration dialog box to assign the measurement values of the LED bars

CB Monitoring

With Release 2.6 the CB monitoring function is introduced. It can be used to supervise the contact wear condition by calculating of the switched current and to help fault analysis by storing all configured measurements in case of CB trip. The function can be opened in menu configure on the main page of the REF 542 configuration or operation tool. For more detailed information please refer to the same section in REF 542 Product Manual, document number 1MRS755860.

Utilities

Check Drawing F9

Starts the software routine that checks the drawing according to specific criteria. If necessary, relevant error messages are displayed after the check.

Generate Report Files

Creates report file of the currently opened configuration file.
Generate SPA Addresses File

Creates a file with SPA addresses of all configured blocks for the application.

Protection Functions

Lists all protection functions configured. The configuration dialog box for the setting parameter can be opened by double-clicking the wanted protection function.

Events

This feature is provided for the automatic events checking. The configuration tool setup will provide a default ETHERNET_IEC61850.RCE file with default events for each configured FUPLA object based on the 61850 data model. This default file is in accordance with the 61850 data model. It is also possible to edit/modify it and create other *.rce files. The configuration tool can be used to select which *.rce file to be used through the menu option called “Options,” which will be described later.

The menu Events precedes the following submenus:

- Set All Events
- Clear All Events
- Set Default Events
- Save Default Events

With the functions “Set Default Events” and “Save Default Events” the required default events for the configured application can be defined and saved. The defined default events can be used for other similar applications. Functions for set and clear all events are also provided.

3.5.9.6. Options

Customize

This menu provides the customization of location for a file generated by the tool (ie SPA RCA file and Com RCE file), the language to be used and the handling of Lifecycle Service remote server for test. The following two figures show the customization of the file location SPA RCA file and the COM RCE file.
In this dialog it is possible to select the folder containing the default events RCE file. If more files are present, it is possible to select one of them that will be used in the application. Moreover, it is also possible to create a new empty RCE file that will be filled afterwards from inside the events page of each FUPLA object.

The following figures show the customization of the language used in the configuration or in the operating tool and the options for the Lifecycle Service definition. More detailed information can be obtained in the corresponding manual for the Lifecycle Tool.
Fig. 3.5.9.6.-3 Customization of the language in the configuration/operating tool

Fig. 3.5.9.6.-4 Customization of the Lifecycle Service remote servers

This dialog provides the possibility to configure a test remote server for the ABB Lifecycle Service to avoid sending “dummy” data to official production database.
Fig. 3.5.9.6.-5  **Customization of the log**

This dialog provides the possibility to enable the log system in order to register actions in a log file during the daily use of Configuration Tool. The location of the log file can be chosen in this customization page.

Fig. 3.5.9.6.-6  **Customization of User Manager**

This dialog provides the possibility to enable the user profile management that assigns one of the four levels of capability to use Configuration Tool. The login window requires user ID and the password "Super-User."

### 3.5.9.7. Help

**Function key F1**

Opens an information window that shows the assignment of the function keys on the PC keyboard. The appropriate function keys are also shown with the corresponding menu items.
Table 3.5.7.-1 shows the assignment of the function keys in the main menu and in the drawing menu.

<table>
<thead>
<tr>
<th>Key</th>
<th>Main Menu</th>
<th>Drawing Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help on function keys</td>
<td>Information dialog box function keys</td>
</tr>
<tr>
<td>F2</td>
<td>Open file…</td>
<td>-</td>
</tr>
<tr>
<td>F3</td>
<td>-</td>
<td>Wire mode: Connect FUPLA symbols</td>
</tr>
<tr>
<td>F4</td>
<td>-</td>
<td>Draw mode: Move FUPLA symbols</td>
</tr>
<tr>
<td>F5</td>
<td>-</td>
<td>Refresh drawing (screen refresh)</td>
</tr>
<tr>
<td>F6</td>
<td>Save</td>
<td>Save</td>
</tr>
<tr>
<td>F7</td>
<td>Save as…</td>
<td>-</td>
</tr>
<tr>
<td>F8</td>
<td>-</td>
<td>Repeat last add action (only for logic symbols)</td>
</tr>
<tr>
<td>F9</td>
<td>Check Drawing</td>
<td>Check drawing</td>
</tr>
<tr>
<td>F10</td>
<td>-</td>
<td>Sequences ON/OFF</td>
</tr>
<tr>
<td>F11</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>F12</td>
<td>-</td>
<td>FUPLA Monitor</td>
</tr>
</tbody>
</table>

About

Opens an information window with copyright and version information of the REF 542plus Configuration Tool.

3.5.10. Description of the Drawing menu items

The menu items of the configuration software are grouped into main and drawing menus. The following sections provide a description of drawing menu items.

The main menu is displayed after starting the configuration software. The drawing menu is displayed when Main Menu > Configure > Drawing has been selected. The main menu items are described in Section 3.5.9. Description of the Main menu items.

3.5.10.1. File

Save F6

The open application file is saved. If a new application file has been created, the file new.ref is saved in the default work directory of the configuration software. In case of a new file, use the menu item Save as when it is saved for the first time.

A project can also be saved by pressing the F6 function key on the PC keyboard.

Before saving, the configuration tool runs a check of the application. Any messages that are displayed must be acknowledged before saving.
Exit Edit

The editor used to create and edit the function chart is closed. The function chart display disappears and the main menu bar is displayed again.

3.5.10.2. Edit

Copy Page

The displayed page on the editor is copied into the Windows clipboard.

Paste Page

If the Windows clipboard contains a Drawing page, then it is pasted into the displayed page. The REF 542plus Configuration Tool checks the pasted object. Thus, if an object reached the maximum number of installations, it is not pasted into the page.

Insert Page

Opens a dialog box with which a page can be added. The number of the page is entered in the text box before an empty page is added. An information window displays the last page that has been used in the application. The Accept and Cancel buttons are used to add the page or to cancel the procedure. The dialog box is closed and the user is returned to the drawing menu.

The configuration software provides a maximum of 99 pages for one application.

Delete Page

Opens a dialog box with which the current page can be deleted. The Accept and Cancel buttons are used to delete the page or to cancel the procedure. The dialog box is closed and the user is returned to the drawing menu.

Delete All

The Delete All menu item has two submenu items. They provide the option of deleting all connections or all pages.

After the selection, a confirmation window is displayed. Click OK to confirm the deletion or Cancel to cancel the deletion. The dialog box is closed and the user is returned to the drawing menu.

Domain

Not applicable for the time being.
Search Wire

Opens a dialog box where all connections with the same number can be found. The connection number is entered into the appropriate text box.

The OK button closes the dialog box and the connections with the number input are marked red on all pages of the function chart.

The Cancel button closes the dialog box and returns the user to the drawing menu.

Search Object

The Search Object menu item has two submenu items. They enable a function block (referred to as an object here) to be searched either by its Field bus address or its object number.

A dialog box is displayed after making the selection. The Field bus address or the object number can be entered into the text box.

The OK button closes the dialog box and the object with the Field bus address or the object number that was entered is displayed in the function chart.

The Cancel button closes the dialog box and returns the user to the drawing menu.

View

Toolbar

Opens the toolbar on the top side of the REF 542plus Configuration Tool.

Status Bar

Sets the status bar at the bottom of the REF 542plus Configuration Tool.

Sequences F10

The Sequences menu item shows and hides all labels on the function blocks and connections. The F10 function key on the PC keyboard does the same thing.

Wires

The Wires menu item has two submenu items. This enables the user to select whether connections can run only at right angles (perpendicular and horizontal) or in straight lines (perpendicular, horizontal and diagonal).

This setting may be changed at any time and affects all connections.
Next page PgDn

Shows the next page in the function chart. The PgDn (Page Down) key or Screen↓ on the PC keyboard does the same thing.

Previous page PgUp

Shows the previous page in the function chart. The PgUp (Page Up) key or Screen↑ on the PC keyboard does the same thing.

Go to page

Opens a dialog box with which any page of the function chart can be displayed. The number of the page required is entered into the text box. An information window displays the last page that has been used in the application. The OK and Cancel buttons display the page or cancel the procedure. The dialog box is closed and the user is returned to the drawing menu.

The configuration software provides a maximum of 99 pages for one application.

Zoom

Opens a dialog box with which the page view can be enlarged. The percentage factor is entered into the appropriate text box. It is always based on the default size of 100%.

Redraw F5

Refreshes the display on the screen. The size and the markings of searched objects remain as before.

Reset

Removes the markings on searched objects and resets the size to the default factor of 100%. Page 1 of the application is displayed also.

3.5.10.4. Insert

A menu with all possible function blocks arranged by function groups is displayed. The various submenus are used to select the corresponding function blocks. The selected one is then added to the function chart.

The sequence of descriptions corresponds to the menu structure of the Insert menu described here. Therefore, a list of the function groups with their function blocks is not given here.
3.5.10.5. Utilities

Check drawing F9

Checks the drawing according to specific points. If necessary, relevant error messages are displayed after the check.

FUPLA Monitor F12

The FUPLA Monitor menu item can be marked by selecting it. A <✓> is then displayed beside the menu item. If also the special cable for the optical – RS 232 interface for the communication between the PC with the HMI control unit is connected, the logical level of the connection in the FUPLA can be shown on line.

Switching objects

An information dialog box is displayed. It lists the field bus addressField bus addresses available for the switching objects. Additional information is also shown adjacent:

- - - - - - - - - : The field bus addressField bus address is not used by a switching object.

“EXAMPLE TEXT”: Text from the Comment text box in the configuration dialog box of the switching object.

“empty“: The field bus addressField bus address is used by a switching object. However, no comment text has been entered.

When the cursor is placed over a line with the data of a switching object and the left mouse button is double-clicked, the dialog box is closed and the switching object is marked in the function chart.

DSP Information

The dialog box is shown in Fig. 3.5.10.5.-1. The DSP load, number of protection parameters and the number of protection functions used are listed accordingly.
Protection functions

The dialog box shown in Fig. 3.5.10.5.-2 is displayed. It lists the protection functions in the application.

Double-clicking a protection function from the list, the protection function block on the editor is shown and marked. The Close button ends the dialog.

Wires

An information dialog box with the numbers of the connections in use opens. The number of connections with this number is shown adjacent in parentheses. At the end of the text that was entered into the Comment text box of the configuration dialog box of the connection follows.
When the cursor is placed over a line with the data of a connection and the left mouse button is double-clicked, the dialog box is closed and all relevant connections are marked in the function chart.

**Drawing Set 1**

Shows the configured protection trip characteristics according to parameter set 1.

**Drawing Set 2**

Shows the configured protection trip characteristics according to parameter set 2.

### 3.5.10.6. Options

**Block Moving of Objects**

Objects already present in FUPLA cannot be moved anymore.

**Moving Objects Transparently**

Objects in FUPLA can be moved transparently.

**FUPLA Monitor**

Can be used to monitor online the logical condition of the signals in the FUPLA.

**Unicode Fonts**

The fonts are used for application with HMI V5 and checked by default if HMI V5 is selected as Hardware in menu Configuration.

### 3.5.10.7. Help

**Function key F1**

The function key F1 opens an information window that shows the assignment of the function keys on the PC keyboard. The function keys are also shown with the corresponding menu items.
About

Opens an information window with copyright and version information of the REF 542plus Configuration Tool.

3.5.11. Description of the status bar

The main view status bar shows the following information:

- COM port settings: the selected COM port and the base unit address
- Web server settings: it is displayed if the Web server is enabled. The IP address is shown as well between square brackets.
- String file name (STC): When the opened configuration is an old one (Release 1–V4C or older) the file name is not shown. Then it is strongly suggested to update it with the new STC files.
- Charset and codepage: It represents the charset used by the REF 542plus Configuration Tool in order to interpret and convert the Unicode strings of the configuration to the ASCII chars handled by REF 542plus.
4. Setting REF 542plus

In this chapter the following information is available:

- Options for adding required functions to the configuration of the REF 542plus device
- Settings that can be made in the configuration software to adapt the REF 542plus to the application
- Configuring the function chart or plan (FUPLA) to the bay in which the unit is operating
- Implementing the protection functions by using the related function blocks
- All other function blocks that can be added to the FUPLA

If the unit has been delivered with a custom application, this section helps in understanding the function blocks with respect to their function and configuration.

The variety of functions offered by REF 542plus results mainly from the PLC-like programming option provided by the REF 542plus Configuration Tool. Various function blocks are linked to one another in one FUPLA.

The objects that can be added to the function chart are referred to as function blocks. They are used to address binary and analog inputs and outputs and to define switching operations, interlocking and protection functions.

Each function block has inputs and/or outputs that can be used within the FUPLA. To open the configuration dialog box of a function block, point the wanted function block and double-click the left mouse button.

Normally a configuration or an application has been created to be precisely customized for the purpose and location location of the REF 542plus device. The configuration has been loaded and saved into the related REF 542plus device. The configuration specifies what protection functions are applied, when and what interlockings are activated and what initial variables are set for the analog and binary outputs of REF 542plus. The application implemented with the FUPLA provides exactly the protection, measurement, supervision and control functions that are required.

4.1. Connecting inputs and outputs

The REF 542plus device receives a great variety of information on the equipment being monitored through its analog and binary inputs. These input quantities are digitally processed in the function chart. The REF 542plus outputs are addressed from the FUPLA, for example to trip the switching objects in the bay.

To enable the REF 542plus inputs and outputs to be used in the function chart, they are represented by function blocks, the switching objects. This enables several inputs and outputs to be combined.
4.2. General settings

Before a FUPLA can be created and exported to REF 542plus, settings must be made in the PC.

4.2.1. Serial Port

To configure the serial port (RS-232) of the computer, the applicable Serial tab must be selected.

Fig. 4.2.1.-1 Serial port properties

The tab has five option fields where the settings for the computer serial port can be made.
ComPort

Under ComPort click the active interface on the computer to enable communication from the PC to REF 542plus over a special serial optical cable.

Setting range: COM1, COM2
Default: COM 1

BaudRate

Under BaudRate click the baud rate of the COM port. Release 1.1 supports 9600 bps, release 2 supports 19200 bps and release 2.5 115200 bps.

Setting range: 9600, 19200 and 115200
Default: 115200 (for release 2.5)

Data Bits

Under Data Bits click the data bits of the COM port. REF 542plus V4D.02 operates with 8 bits. Older versions operate with 7 bits.

Setting range: 7, 8
Default: 8

Slave Address

Enter the REF 542plus base unit slave address in the Slave Address text box. This address allows the user to connect more REF 542plus base units to the same HMI. It has nothing to do with the REF 542plus communication card interface.

Setting range: 1 … 254
Default: 99

Since it is possible to connect more REF 542plus base units to the HMI, the engineer must configure the referred base unit. In fact, the REF 542plus Configuration Tool uploads/downloads the configuration from/to the REF 542plus base unit addressed by the base unit slave address in the serial port configuration.

Fig. 4.2.1.-2 shows a PC with the REF 542plus Configuration Tool that is connected to an HMI via serial communication port (COM1 or COM2). The HMI is shared by three REF 542plus base units, which have three different addresses (on a RS-485 bus). In order to connect the REF 542plus Configuration Tool with a certain REF 542plus base unit it is necessary to configure the right salve unit address. For
example if the REF 542plus Configuration Tool wants to communicate with the first
REF 542plus base unit, then the slave address base unit (in the serial port dialog
box) must be set to 99.

![Diagram of PC connected via HMI to several base units]

**Fig. 4.2.1.-2**  
**PC connected via HMI to several base units**

The base unit address set in the Serial Port dialog box can be different
from the slave address set into the hardware configuration. This is the
case when it is necessary to change a slave address of a REF 542plus
base unit. For example if it is needed to change the second
REF 542plus base unit address (in Fig. 4.2.1.-2) from 100 to 103, it is
necessary to communicate with the current base unit which has address
100, but then configure the hardware configuration with 103. After the
download of the configuration, REF 542plus restarts with the new
address 103. Any further connection request with address 100 fails.

By default, in production, the REF 542plus base unit is set with
address 99 (which is the default of the REF 542plus Configuration
Tool as well).

The following options are set:

- **Parity**: Default: Even
- **Stop BITS**: Default: 1

**OK**

Click **OK** to save all settings in the configuration software. The dialog box is closed.
Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

4.2.2. TCP/IP port

To configure the TCP/IP port of the computer to be used to transmit the configuration file of the application, the applicable TCP/IP tab must be edited. It is also possible to set the IP address of the REF 542plus unit involved in the TCP/IP communication.

![TCP/IP port properties](image)

The "Remote device" section allows setting the IP address of the REF 542plus unit involved in a direct communication with Configuration Tool.
The "Local Network Properties" section shows the list of the Ethernet adapters currently installed in the PC. Once an Ethernet adapter is selected, the related TCP/IP parameters are shown as read-only:

- Mac address
- Type of connection (static or DHCP)
- IP address
- Subnet mask
- Default gateway

Both the REF 542plus unit and the PC must be connected to the same network.

To adjust the IP parameters of the PC Ethernet adapter so that it is in the same subnet or in general to modify other TCP/IP parameters, a utility is provided in the TCP/IP tab.

To change the parameters of a PC Ethernet adapter:

- Select the adapter from the list.
- Select "Change network configuration settings" to make the Change Settings button available.
Fig. 4.2.2.-2 Enabling the PC for TCP/IP change

- Click Change Settings to open the TCP/IP dialog to enter new settings.
If the new parameters are correct, **Save Settings** becomes available.

- Click **Save Settings** to start the renewing of the PC Ethernet card.

The configuration can be done also from outside Configuration Tool.

- From **Control Panel > Network connections**, select the Ethernet adapter whose parameters need to be modified.
- Click **Properties** and select form the list "Internet Protocol (TCP/IP)."
After selecting "Internet protocol (TCP/IP)," a window appears that allows the changing of the TCP/IP parameters.
In the Internet protocol property window, the PC Ethernet port is configured to communicate with the address 192.168.2.234 and with the subnet 255.255.255.0. The subnet value must match the subnet value set in the REF 542plus unit, while only the first three digits of the IP address must match the ones of the REF 542plus unit. The fourth digit must be different. After the setting, it is possible to verify the remote connection with a ping command.

**4.2.3. Global Settings**

The Global Settings are available in **Main Menu > Configure > Global**. The wanted general configuration inputs are made in this dialog box. With the exception of those for trip circuit supervision, the inputs are independent of the REF 542plus model supplied.

It is absolutely essential to edit the configuration dialog boxes in **Main Menu > Configure > Global Settings** and in **Main Menu > Configure > Hardware** before the drawing editor is opened.
To assure the correct behavior of the communication using the Ethernet module and the communication protocol IEC 61850, select the No events when function blocked check box. The selection is possible after you have selected the Events check box.

The check box “No Events when function blocked” is a feature for IEC 61850 communication protocol. It is based on the related standard as it is needed to have a complete deactivation of a blocked function in the FUPLA for the generation of the related events.

If the check box “Lifecycle Service used” is not checked and downloaded with the configured application in order to allow for switching off the warning message “Compos. has Changed. Pls Connect to Tool” in the status bar of the HMI.
**Node address**

The Node address sets the addressing of the bay control and protection unit over the field bus. Every device installed on a field bus is assigned a unique device address.

Setting range: 1 ... 255  
Default: 99

**Project**

Enter a name for the project in the Project text box. The name entered is only a more precise description and has nothing to do with the name under which the application can be saved. One project can include several bays.

Setting range: 0 ... 20 characters (standard character set)

**Feeder**

In the Feeder text box, enter a name for the feeder for which the application is created as part of the project above. The name entered is only a more precise description and has nothing to do with the name under which the application can be saved.

Setting range: 0 ... 20 characters (standard character set)

**Global filter time**

In the Global filter time text box, enter the time in ms that is required for an input signal to address the binary input to be detected as such. The general filter time is valid for all binary inputs and is added to a non-adjustable filter time that is set by the design of the unit (1 ms). The last is referred to as the hardware filter time.

Setting range: 0 ... 999 ms (increment: 1 ms)  
Default: 20

**Active protection set**

In the Active protection set text box, enter a parameter set of the protection parameter that is intended to be active when REF 542plus is started. The active parameter set can be changed later with the local control on the REF 542plus operator view.

Setting range: 1 ... 2 (increment: 1)  
Default: 1

**Changes**

A variable that shows the number of changes to the configuration for the service in encrypted form is displayed here.
Name of configuration

The Name of configuration displays the name as which the application file/configuration file is saved.

Coil supervision

In the former version of the binary I/O module version V2 there were four check boxes in the Coil supervision area that enabled trip circuit supervision (= coil supervision) to be activated for two trip circuits each for a maximum of two or three binary input and output modules. However, since REF 542plus release 2.0, the binary I/O module version V2 is not available anymore. Note that the successor version, the binary I/O module version V3, provides only one coil supervision on each module. The maximum number of coil supervision is two or three, depending on the ordered housing.

Card1_1 (not available anymore in BIO V3)

Activates or deactivates trip circuit supervision for binary output 1 on the 1st input and output board.

Card1_2

Activates or deactivates trip circuit supervision for binary output 2 on the 1st input and output board.

Card2_1 (not available anymore in BIO V3)

Activates or deactivates trip circuit supervision for binary output 1 on the 2nd input and output board.

Card2_2

Activates or deactivates trip circuit supervision for binary output 2 on the 2nd input and output board.

Card3_1 (not available anymore in BIO V3)

Activates or deactivates trip circuit supervision for binary output 1 on the 3rd input and output board.

Card3_2

Activates or deactivates trip circuit supervision for binary output 2 on the 3rd input and output board.
Error supervision

In current version of REF 542plus is not to be used anymore.

Doubleswitching

Doubleswitching provides the option of activating double actuation. After selecting a switching object once on the LCD of the REF 542plus HMI control unit, the option of sending two switching commands to this switching object is available. In general, three seconds are available for sending a switching command after selecting a switching device. If double actuation is activated, another 10 seconds is available to send another switching command after the first switching command.

Events

Select the Events check box to allow event data to be generally sent to a station automation system. See also the system events' 1, 2 and 3 buttons.

Autoreclosure (AR)

Since release 2.0 (version V4D02x) the embedded Autoreclose is not to available anymore. Therefore an independent and separate function blocks Autoreclose can be applied.

Test mode

Click the used option button in the Test mode area to allow entry to the test mode via the HMI control unit in general. Click not used in the Test mode area to deny entry to the test mode via the HMI control unit.

System events 1

Clicking on the System events 1 button displays a dialog box in which various device-based events can be enabled. If they occur they are then sent to the station automation system.

See also the buttons System events 2 and System events 3 and the check box events. Events may also be enabled in the configuration dialogs of some function blocks and they are then based on these.

System events 2

Clicking on the System events 2 button displays another dialog box in which various device-based events can be enabled. If these events occur they are then sent to the station control system.
See also the buttons for System events and check box events. Events may also be enabled in the configuration dialogs of some function blocks and they are then based on these.

**System events 3**

Clicking the **System events 3** button displays another dialog box in which various device-based events can be enabled. If these events occur, they are then sent to the station control system.

See also the buttons **System events 1** and **System events 2** and check box events. Events may also be enabled in the configuration dialogs of functions blocks and the events are then based on the dialogs.

**OK**

Click **OK** to save all settings in the configuration software. The dialog box is closed.

**Cancel**

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

### 4.2.4. Hardware

The general hardware configuration is available in **Main Menu > Configure > Hardware**.

It is absolutely essential first to edit the configuration dialog boxes in **Main Menu > Configure > Global Settings** and in **Main Menu > Configure > Hardware** to get to the drawing editor.
Fig. 4.2.4.-1  REF 542plus hardware configuration

**REF 542plus Housing**

Choose 2 IO-Slots option button for a normal housing (2 input/output slots) or 4 IO-Slots option button for a wide housing (4 input/output slots).

**Binary IO Boards**

<-> button increases and <-> button reduces the number of active binary input and output boards. The wanted number is shown on the left after Number:. 

Choose the type of relay that is used on the active binary input and output boards. Either mechanical (conventional) relays or solid state (transistor) relays.

Different binary I/O boards cannot be combined in one REF 542plus device (mechanical relays and solid state relays).

The related information fields binary inputs and binary outputs show how many inputs and outputs are available depending on the number and type of boards in use.
Analog input board

The dialog box provides a selection of predefined analog input boards according to the ordering code. Further description can be found later in Section 4.2.5. Analog inputs.

Analog Input 20 mA Boards

Configure the number of analog input 4-20 mA boards in use under Analog Input 4-20 mA Boards. These boards can only be used in deep housing. The <+> and <-> buttons are used for settings.

Analog Output 20 mA Boards

Configure the number of analog output boards in use under 4-20mA Analog Output Boards. These boards can only be used in deep housing. The <+> and <-> buttons are used for settings. The information field shows the number of possible analog outputs.

Field Bus

Select whether the process bus is to be used or not. CAN option is dedicated only for application designed by ABB switchgear companies.

Communication Interface

In the Communication Interface drop-down menu a field bus variation can be selected. Depending on the type of field bus the parameters button is then activated.

Parameters

Click the Parameters... button and a dialog box is displayed depending on the protocol selection. When SPA is selected, the REF 542plus slave address is required and the network topology. When Modbus is selected, the first and the second port addresses can be set. When IEC 60870-5-103 is selected, it is possible to change the unit address, the baud rate and the ASDU type. When LON is used, only the unit address can be set.

Base Unit

Configure the address of the configured REF 542plus base unit in Slave Address text box under the Base Unit. This value can be different from the current one (refer to Chapter Serial Port settings).
OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

4.2.5. Analog inputs

Main Menu > Configure > Terminals > Analog Inputs displays the dialog box below. The analog measurement inputs of REF 542plus can be configured and set for the transducers in use. The settings are particularly important for the safe and proper functioning of the unit.

![Inputs tab in the Analog Inputs configuration dialog box](image)

The Inputs tab displays the complete overview of the analog input settings: sensors, nominal values, calculated values.

The Analog Input Board field represents the ID of the installed board in REF 542plus. The REF 542plus Configuration Tool automatically configures the sensor when the user selects the board from the dialog box below, by clicking the Get group data button.
Fig. 4.2.5.-2  Analog Boards dialog box

Selecting the board from the list, the sensor type is displayed on the right. The sensor acronyms are:

- CT – current transformer
- RC – current rogowsky coil
- VT – voltage transformer
- VS – voltage sensor
- CT 0.2 – current transformer with Input Nominal Value set to 0.2 A

The REF 542plus Analog Board definition is in Boards\REF542plusAI.xml.

It is always possible to configure manually all the sensors by double-clicking on the correspondent row in the table, or by pressing the SPACEBAR on the keyboard. The sensor dialog box is displayed below.

Every time a new analog board is selected from the analog boards dialog box, all the channel values (RPV, RSV, and so on) are overwritten with the default values.

The analog board name (for example 750170/814) is substituted by the Custom board name when the user makes changes to the analog input channels type.

For more information about the analog input configuration, refer to the REF 542plus Protection Manual.
4.2.6. Analog Input 20 mA

When selecting Main Menu > Configure > Terminals > Analog Inputs 20mA, Analog Inputs 20mA dialog opens. See Fig. 4.2.6.-1. The analog inputs 20mA can be configured and set for the connected sensors. Settings are particularly important for safe and proper functioning of the unit.

The analog input 20 mA module in REF 542plus is designed to work with passive sensors only. The passive sensors are supplied by the module directly. The output supply voltage is about 15 VDC. The standard interface of the sensors shall be 2-wire designed and loop-powered. The loop resistance must be set so that the power consumption of the sensors requires a loop current of 4 mA. The current range between 4 mA and 20 mA is dedicated for the intended measurement range.

The dialog box is initially identical for all Analog Inputs 20mA. For this reason only one input and its configuration is described. Information on the setting ranges of the filtering parameters can be found beside the input fields.

Fig. 4.2.6.-1 Example of the configuration dialog for setting the analog inputs 20mA
Sensor type

In the Sensor type drop-down menu the user can choose between four possible sensor types: Not used, Trafag, Density 4-20 mA and General purpose 4-20 mA. The Thermal Overload Environment Temperature is only available, when the sensor type Gen.-Purpose 4-20 mA is selected.

Density unit

In the Density unit drop-down menu the user can choose the unit identifier for the density measurement to be visualized on the HMI when sensor type is Trafag or Density 4-20mA. There are three possible density units: Kpa, Kg/m³ and Psi.

Measure unit

In case of a general purpose sensor the unit name must be edited through the Measure unit text box. The text box is disabled when sensor type is Unused, Trafag or Density 4-20mA. The string can be seven characters long at the most.

Measure name

Measure name is the string descriptor of the measurement acquired by the sensor. It is what the user sees on the HMI Measurement Table. The name can be 20 characters long at the most.

Temperature name

Temperature name is the descriptor of the temperature measurement acquired by the Trafag sensor. It is what the user sees on the HMI Measurement Table. If the Sensor type is not Trafag the text box is disabled. The name can be 22 characters long at the most.

Data value at 4 mA and 20 mA

Data values at 4 mA and 20 mA are the engineering values corresponding to the current levels of 4 mA and 20 mA. The text box for setting this parameter is enabled only in case of Sensor type density 4-20 mA and Gen. Pur. 4-20 mA. If Sensor type is Unused or Trafag then the parameters are not used and the corresponding text boxes are disabled. The unit is the one set through the dedicated parameter. The resolution displayed below the data values represents the resolution used by the device to scale the parameters to 16 bits values. The resolution is calculated automatically by the REF 542plus Configuration Tool and it is applied automatically to the approximation to the data values when the edit box looses the focus.
Averaging time

The Averaging time parameter sets the width of the time window used to calculate the average value. The Averaging time is expressed in minutes.

Filtering time

When a digital signal is extracted from an analog signal a debouncing operation must be performed. The Filtering time is expressed in milliseconds.

4.2.7. Analog outputs 20 mA

The REF542plus Analog Outputs dialog box is displayed in Main Menu > Configure > Terminals > Analog Outputs where the analog outputs on the REF 542plus analog output board can be configured. The selection list always shows all possible measured and calculated values. In fact only the following values can be output:

- Measured values applied to the analog inputs and
- Calculated values required by a configured protection function

Select a REF 542plus measured or calculated value from the drop-down list by clicking the arrow.<

Fig. 4.2.7.-1 Configuration dialog box for the analog outputs

Because all analog outputs are configured in the same way, only one output is described here. All setting options for an analog output can be found on one index card.
0 mA = and 4 mA =

In the 0 mA = and 4 mA text boxes the user can specify what multiple of the rated value of a measured or calculated value is mapped to the initial value of the analog output board. The initial value of the output range of the analog output changes here depending on the mode marked. If 0 mA or 4 mA can be tapped at the analog output, the current measured or calculated value is \([-4.000 \ldots +4.000]\) multiplied by its rated value.

Setting range: \(-0.0000 \ldots +4.0000\)
Default: \(+0.0000\) (increment: 0.0001)

20 mA =

In the 20 mA = text box the user can specify what multiple of the rated value of a measured or calculated value is mapped to the final value of the analog output board. If 20 mA is generated at the analog output, the current measured or calculated value is \([-4.000 \ldots +4.000]\) multiplied by its rated value.

Setting range: \(-4.0000 \ldots +4.0000\)
Default: \(+0.0000\) (increment: 0.0001)

Mode

Select the output mode in the Mode area. This sets the output range to which the input range set above is mapped. The option with zero signal current allows a continuous current to flow through the line from the analog output board to the display device. This enables an error message to be generated by the display device if no signal is received over the line. However, this limits the output range.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

If the powerfactor \(\text{cos } \phi\) is selected for the output, the meaning of the text boxes is different:

The configuration-value of the 0 mA (4 mA) nominal value becomes the minimal capacitive \(\text{cos } \phi\).

The configuration value of the 20 mA nominal value becomes the maximal inductive \(\text{cos } \phi\).
If $\cos \varphi$ is outside of the configured range, the output is 24 mA.

If $\cos \varphi$ is not available ($I, U < 1\%$ of nominal value), the output is 0 mA (4 mA).

See the following Fig. 4.2.7.-2 and Fig. 4.2.7.-3.

![Configuration dialog box for the analog output of powerfactor \( \cos \varphi \)](Fig. 4.2.7.-2 Configuration dialog box for the analog output of powerfactor \( \cos \varphi \))

<table>
<thead>
<tr>
<th>Example 1:</th>
<th>0 mA = 0 ( \cos \varphi ) capacitive</th>
<th>20 mA = 0 ( \cos \varphi ) inductive</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\varphi'$</td>
<td>( \cos \varphi )</td>
<td>Analogue output/mA</td>
</tr>
<tr>
<td>-180</td>
<td>-1 capacitive</td>
<td>24</td>
</tr>
<tr>
<td>-90</td>
<td>0 capacitive</td>
<td>0</td>
</tr>
<tr>
<td>-60</td>
<td>0.5 capacitive</td>
<td>5</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>10</td>
</tr>
<tr>
<td>+60</td>
<td>0.5 inductive</td>
<td>15</td>
</tr>
<tr>
<td>+90</td>
<td>0 inductive</td>
<td>20</td>
</tr>
<tr>
<td>+180</td>
<td>-1 inductive</td>
<td>24</td>
</tr>
<tr>
<td>not available</td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

This leads to the following analogue outputs:

<table>
<thead>
<tr>
<th>Example 2:</th>
<th>4 mA = 0 ( \cos \varphi ) capacitive</th>
<th>20 mA = 0 ( \cos \varphi ) inductive</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\varphi'$</td>
<td>( \cos \varphi )</td>
<td>Analogue output/mA</td>
</tr>
<tr>
<td>-180</td>
<td>-1 capacitive</td>
<td>24</td>
</tr>
<tr>
<td>-90</td>
<td>0 capacitive</td>
<td>4</td>
</tr>
<tr>
<td>-60</td>
<td>0.5 capacitive</td>
<td>8</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>12</td>
</tr>
<tr>
<td>+60</td>
<td>0.5 inductive</td>
<td>16</td>
</tr>
<tr>
<td>+90</td>
<td>0 inductive</td>
<td>20</td>
</tr>
<tr>
<td>+180</td>
<td>-1 inductive</td>
<td>24</td>
</tr>
<tr>
<td>not available</td>
<td></td>
<td>4</td>
</tr>
</tbody>
</table>

![Examples for analog output of powerfactor \( \cos \varphi \)](Fig. 4.2.7.-3 Examples for analog output of powerfactor \( \cos \varphi \))
4.2.8. **Single line diagram**

The REF 542plus Display dialog box in Section 4.2.8.1. User controls of the LCD editor is available in **Main Menu > Configure > HMI > Single Line Diagram**. This editor is used to configure the single-line diagram displayed on the LCD in standard operation. The editor is also used to configure the connection between the single-line diagram and the switching device.

4.2.8.1. **User controls of the LCD editor**

![Figure 4.2.8.1.-1 Editor for configuring the single-line diagram](image)

The elements labeled in the figure above are described in the following paragraphs.

**Drawing field**

This area represents the area of the LCD of the HMI control unit REF 542plus usable for the single-line diagram. The single-line diagram configured here always fits between the measured value display and the status line on the LCD.
Coordinates of the cursor position

When cursor is in the drawing field, the location coordinates are shown in the form x, y.

Buttons

Close

The Close button closes the editor. The single-line diagram is automatically saved with the configuration. When the editor is closed the user is prompted to save the single-line diagram.

Import and Export

The Import and Export buttons offer the option of reusing a previously configured single-line diagram. Usually, the single-line diagram is saved in the *.ref file as the rest of the configuration. However, it could be useful to import in the current configuration a previously saved single-line diagram. To do this the single-line diagram must first be exported. After clicking on the appropriate button, a standard dialog box for saving the file to be exported is displayed. The file name has the ending *.lcu. If the user wishes to reuse or change a previously configured single-line diagram, click the Import button. A standard dialog box in which the file to be imported can be selected is displayed. The file name must have the ending *.lcu.

Single-line diagrams that were not prepared with the editor described above cannot be imported.

Clear All

When clicking the Clear All button, all elements on the drawing field are deleted. If the configuration has been previously saved, the drawing as it stands at this point is saved with it.

Tools

The four buttons set the mode in which work on the drawing field is conducted. The appearance of the cursor also depends on the mode.
Edit

Elements can be selected, moved and deleted in the editing mode. The editing mode is always activated again after using other modes.

Symbol

Any symbol can be added and configured on the drawing field in the Symbol mode.

Thin Line

Use the Thin Line mode to draw thin lines in the drawing field.

Thick Line

Use the Thick Line mode to draw thick lines in the drawing field.

Text Field

Use the Text Field mode to write text.

The exact usage of the buttons is explained in more detail after the editor controls have been explained.

Check boxes

Enable Sloping Lines

When the Enable Sloping Lines check box is selected, diagonal lines can be drawn on the drawing field as well as perpendicular and horizontal lines.

Block Moving

Selecting the Block Moving check box prevents unwanted movement of elements on the drawing field. To move an element, hold down the SHIFT key. This key must also be used for extending, shortening or changing the direction of lines.

Selected element

A selected element is shown inverted. All operations can only be conducted on the selected element. For this reason only one element can be selected at a time.
Free Resources

The Free Resources area displays information on the number of symbols and lines (the possible elements) that can still be drawn.

Marked Element

The Marked Element area displays information on the element that is to be selected.

Lines: coordinates of the start and finish points, the line thickness (thin/thick) and the line length in pixels.

Switching objects: coordinates of the lower left corner, Field bus address and comment for the function block that is represented.

Other symbols: coordinates of the left lower corner.

Cursor appearance

The cursor can appear differently depending on the specific mode in the drawing field.

- **Standard appearance** is shown when the cursor is not on any element.
- **Movement cursor** is shown when the cursor is on an element. Click the left mouse button to select the element.
- **Drag cursor** is shown when the cursor is on the end of a selected line. The line can then be shortened or lengthened by dragging with the left mouse button held down.
- **Symbol cursor** is used in the Symbol mode. Click the mouse to open the configuration dialog box for a new symbol.
- **Line cursor** is used in the Line mode. Hold the left mouse button down and drag to draw perpendicular, horizontal or diagonal (if enabled) lines.

4.2.8.2. Working with the LCD editor

Select an element/deselect selection

To select a symbol or a line, click the left mouse button when the cursor is on them.

The selected symbol is shown inverted: the sizing handles at the ends of the line are emphasized.

To deactivate a selection, click the left mouse button when the cursor is not on an element in the drawing field.
Select sizing handle

1. Select a line.
2. The sizing handles are shown.
3. Move the cursor to the sizing handle and hold the left mouse button down. Drag the sizing handle with the mouse.

OR:

1. Mark one or the other sizing handle by using the key combination CTRL + SPACEBAR several times.
2. The arrow keys on the keyboard can be used to make very precise movements of the sizing handle.

Open context-dependent pop-up menus

In addition to the options for conducting various operations described above, the editor for the LCD also has content-dependent pop-up menus. Open pop-up menus by clicking the right mouse button. The contents depend on where the cursor is on the drawing field at that time (pop-up menus can only be opened there). A menu beside the cursor opens in which various editing options can be selected. This offers faster access to the various functions. All functions offered there can also be accessed as described above.

To display a specific contextual menu, click the right mouse button when the cursor is on an element (line, symbol or text) in the drawing field. The menu items depend on the selected element. All the elements have the following commands: delete, to delete the element and edit, to configure the element.

Some elements, for example the switching objects, has in addition the State menu which can set the status of the selected element (for example closed, opened, in error or moving).

Click the right mouse button when the cursor is not on an element and a pop-up menu is displayed. The menu contains the following commands: Insert symbol, line and text, Import, Export, Clear All, and Copy. The last command copies the bitmap in the Windows clipboard. The other commands are the same as the dialog box buttons.

Move element

Select the element and drag the mouse with the element while holding the left mouse button down.

OR:

After selecting the element move it with the arrow keys on the keyboard.
**Insert symbol**

1. Click the symbol button.
2. Move the cursor to the wanted position for the symbol in the drawing field.
3. Click the left mouse button to open the symbol configuration dialog box.

**Configure existing symbol**

Move the cursor over the symbol and double-click the left mouse button. The configuration dialog box opens.

**Insert line**

1. Click the thin line or thick line button.
2. Move the cursor in the drawing field to the wanted position for the beginning of the line.
3. Click the left mouse button and hold it down to set the beginning point of the line.
4. Drag the mouse with the button held down to the end point of the line.
5. Release the mouse button.

**Configure existing line**

Move the cursor over the line and double-click the left mouse button. The configuration dialog box opens.

**Delete element**

1. Select the element that is to be deleted.
2. Click Delete on the keyboard.
3. The user is prompted to confirm or cancel the deletion.

**Change line size**

1. Select sizing handle.
2. Drag the mouse with the sizing handle while holding the left mouse button down.

OR:

After selecting the sizing handle move it with the arrow keys on the keyboard.

**Change the appearance of a switching object**

Click on the switching object symbol while holding the CTRL key down. Every switching object has four different appearances, which represent its switching status.

OR:
Select the switching object and change its appearance with the key combination CTRL+SPACEBAR.

**Select elements one after the other**

1. Select an element
2. Use the keys CTRL+right arrow or CTRL+up arrow to select the next or the previous element according to an internal sorting process.

Use the keys CTRL+left arrow or CTRL+down arrow to select the next or the previous element in the opposite direction to the internal sorting process.

**Copy drawing field to the clipboard**

Use the INSERT key on the keyboard to copy the entire drawing field to the clipboard as a two-color bitmap graphic.

### 4.2.8.3. Configuration dialog box for symbols

The configuration dialog box Set Symbol is displayed when a new symbol is added or if it is opened as described in the previous Section 4.2.8.2. Working with the LCD editor. The type of shapes depends on the standard selection: IEC or ANSI.

![Configuration dialog box for symbols in the editor for the LCD](image)

*Fig. 4.2.8.3.-1 Configuration dialog box for symbols in the editor for the LCD*

**Shape**

Click the arrow < ▼ > to open the drop-down menu Shape that displays optional appearances of the symbols. A description and the dimensions of the image (height, width) are adjacent to the image. In the case of the switching objects, please note that only one of four possible images is shown.
Field Bus Address

Set the connection between the element on the LCD and the function chart in the Field Bus Address drop-down menu. The selected symbol represents the switching object with the corresponding Field bus address on the LCD. After clicking the arrow that opens the list < ▼ >, the selection of possible Field bus addresses that have been used in the function chart for switching objects is displayed. The comment that can be entered in the configuration dialog box of that switching object is adjacent.

The drop-down menu Field Bus Address is opened automatically when a symbol in the Symbol list has been selected.

Position

The x and y coordinates are displayed at the lower left corner of the symbol. Other coordinates can be entered in the Position text box to move the symbol.

Single Object/Combined Object

To select whether the wanted switching object is represented by one or two symbols, choose Single Object or Combined Object option button. The second symbol can be selected with the option buttons Earth Switch and Isolator. Only these two options are available for the second symbol.

Example:

A 3-position switch (with some exceptions) can be shown using a combination consisting of an earthing switch and an isolator.

Selectability

Select under Selectability how the switching object can be directly selected locally.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>privileged</td>
<td>The first switching object that is selected.</td>
</tr>
<tr>
<td>selectable</td>
<td>This switching object can be selected. The sequence in which the switching objects are selected is set internally. Only the switching object that is selected first can be set (see above).</td>
</tr>
<tr>
<td>not selectable</td>
<td>This switching object cannot be selected locally on the REF 542plus. It can only be addressed from the station control system.</td>
</tr>
</tbody>
</table>

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
4.2.8.4. Configuration dialog box for lines

The configuration dialog box Edit Line for lines is opened as already described in the previous Section 4.2.8.3. Configuration dialog box for symbols.

Start Position

Enter the x and y coordinates of the starting point of the line into the two text boxes. The current values are displayed there when the dialog box is opened.

End Position

Enter the x and y coordinates of the end point of the line into the two text boxes. The current values are displayed there when the dialog box is opened.

Line Width

Select whether the selected line should be drawn thick or thin. The current values are displayed there when the dialog box is opened.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

4.2.9. Display language

Main Menu > Configure > HMI > Display Language displays the dialog box below. Select the language file from which the texts that is displayed on the LCD display screen is read.
The first part of the dialog box shows the current display language stored into the configuration and the charset codepage. Old configuration is refreshed by selecting the new display language and the correspondent codepage. For example when the English string file is loaded the codepage Latin is chosen. Instead, for Russian string file the Cyrillic codepage is used.

Choose New Display Language

Click the arrow < to open a list of files. The file is selected depending on the wanted language and the configuration used. The language English and German are provided as default. Translation into other languages can be done easily by editing the related .stc file.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

The standard language file provided is english.stc. To change to another language, this file needs to be translated correspondingly.
4.2.10. Char maps (For operation with HMI V4)

Main Menu > Configure > HMI > Char Maps displays the dialog box below. With the dialog box it is possible to download the “font” (also called char map) used by the LCD to display the texts to the device.

![Configuration dialog box to handle font bitmaps and character map files](image)

Fig. 4.2.10.-1 Configuration dialog box to handle font bitmaps and character map files

The list on the left contains the char bitmaps folder installed in the PC. It is possible to add new bitmaps folder (for example for new languages). The REF 542plus does not use directly such bitmaps, but a generated binary file, called *.rfn.

As shown in Fig. 4.2.10.-2, the installation provides two *.rfn binary files. They are generated from the installed (if selected during installation) bitmap folders.

These files can be generated clicking the Generate File On Disk button. The generated files have the same name of the folder.

![Installed files](image)

Fig. 4.2.10.-2 Installed files

The list on the right contains the *.rfn file already installed in the PC. Selecting a character map file it is possible to download this binary file to the device where it is used by the HMI to display the text.

It is always possible to retrieve the font file *.rfn from a REF 542plus device, by clicking the Upload File From Device button. Depending on the version and on the character set, it can overwrite an existing *.rfn file.

The folder and file names follow this convention:

<Codepage name>-<codepage>-<internal use>-<version>
For example “Hebrew-1255-1000-003” is the third version of the Hebrew char map.

The version in the file names is important in order to keep also the previous char maps on disk whenever changes are applied. Otherwise the last generated or uploaded char map file overwrites the existing one.

A bitmaps folder contains the chars from ASCII code 32 to 255. A bitmap char is 8x8 pixels black and white. The normal background is white and the char/symbol is black. In order to display a readable char the following rule must be followed: the bitmap must be edited with a char of 5x7 pixels. The rest of the pixels can be used by the HMI for special effects (underline, and so on).

The char bitmap file name must follow this rule:

<string>_xyz.bmp

The <string> can be the charset name, and it must not contain “.”. The digits “xyz” instead represent the ASCII code of the char (always between 032 and 255).

Fig. 4.2.10.-3 Installed bitmap files for Latin char set

A bitmaps folder contains the chars from ASCII code 32 to 255. A bitmap char is 8x8 pixels black and white. The normal background is white and the char/symbol is black. In order to display a readable char the following rule must be followed: the bitmap must be edited with a char of 5x7 pixels. The rest of the pixels can be used by the HMI for special effects (underline, and so on).

The char bitmap file name must follow this rule:

<string>_xyz.bmp

The <string> can be the charset name, and it must not contain “.”. The digits “xyz” instead represent the ASCII code of the char (always between 032 and 255).

Fig. 4.2.10.-4 Example of bitmap (Latin_057)

If the HMI V5 is applied, the provided Unicode fonts must be downloaded and used. The following screenshot shows how to find the Unicode fonts.
4.2.11. LED Bars

Main Menu > Configure > HMI > LED Bars displays the dialog box LED Bars. With the dialog box it is possible to configure the three LED (light emitting diode) bars on the HMI. It is possible to assign a defined signal to a LED bar and the label shown aside.

Fig. 4.2.11.-1 Configuration dialog box LED bars
4.3. Function and configuration of the function blocks

This section describes all function blocks that can be added to the FUPLA or that are already present in the FUPLA. The structure is adapted to the menu structure of the Add menu in the function chart editor. Every description has a similar structure.

Description of the function blocks

In the following descriptions of the function blocks, a diagram of a function block is followed by an explanation of its function, its connections and, if applicable, a typical application. This is followed by a screenshot of the configuration dialog box associated with the function block if it is not an information dialog box, which only has the OK or Cancel buttons.

Finally, the various elements of the configuration dialog boxes are explained. If input parameters are involved, the input range and its optional increment and the default value are also given. To ensure that every function block has a complete description, elements that occur repeatedly are always described.

Description of the switching objects

Only the sections where the switching objects are described have a different procedure. They are preceded by an additional section that describes a selected switching object in detail. This includes information on the appearance of a switching object in the function chart and its configuration dialog box. All descriptions are somewhat shorter in the sections on every single switching object.

Object number

The number on the left side, above every function block is the sequential number (object number), which is assigned by the configuration software. It may be assigned several times in the images of the function blocks. Every object number is only assigned once in a correct application.

4.3.1. Control panel on the HMI control unit

Following sections contain the descriptions of the function blocks that are available in Drawing Menu > Insert > Control Panel.
4.3.1.1. Indication LED

Function

The Indication LED function block represents the configurable indication LED’s adjacent to the LCD on the HMI as local control unit. This function block can be used to address the LED’s from the FUPLA and appropriate indication texts can be added.

Connections

The LEDs can be in one of four states depending on the wiring of the two inputs: off, green, red and orange (amber). The indicated text depends on the color displayed by the LED. The following Table 4.3.1.1.-1 shows the corresponding combinations.

<table>
<thead>
<tr>
<th>Color</th>
<th>Green Input</th>
<th>Red Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Green</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Red</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Amber</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Eight LEDs on each of the four pages (totally 32 LEDs) can be addressed.

Typical application

Use of the signaling LED to receive the status indication for temperature supervision of a motor. A green LED stands for example "OK", an amber LED stands for "critical status" (with the starting signal of a protection function) and a red LED stands for "fault: motor too hot" (with the trip signal of a protection function).

Configuration

The following section describes several tabs in the Indication configuration dialog box. In all the tabs the OK and Cancel buttons are available.
OK

Click **OK** to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

General

**Fig. 4.3.1.1.-2 General tab, Indication LED function block**

**Page number**

Input of the number of the LED page that is to be configured.

Setting range: 1 ... 4 (increment: 1)
Default: [number of the next LED that is not configured]

**LED number**

In the **LED number** drop-down menu, select the number of the LED that is to be configured. The number is also put in the function block.
Setting range: 1 … 8 (increment: 1)
Default: Number of the next LED that is not configured

**Texts for the Display**

**OFF**

In the OFF text box, write the text that is displayed in the LCD after the scan of the LED message texts when the LED is off. In the FUPLA, the text is displayed above the function block.

Setting range: 0 … 20 characters (standard character set)
Default: [Empty]

**Green**

In the Green text box, write the text that is displayed in the LCD, when the condition is fulfilled. In the FUPLA, the text is displayed above the function block.

Setting range: 0 … 20 characters (standard character set)
Default: [Empty]

**Amber**

In the Amber text box, write the text that is displayed in the LCD, when the condition is fulfilled. In the FUPLA, the text is displayed above the function block.

Setting range: 0 … 20 characters (standard character set)
Default: [Empty]

**Red**

In the Red text box, write the text that is displayed in the LCD, when the condition is fulfilled. In the FUPLA, the text is displayed above the function block.

Setting range: 0 … 20 characters (standard character set)
Default: [Empty]
**Latch signal**

The Latch signal check box must be selected if an acknowledgement is required after the LED status (off, red, green or amber) has changed. If the reason for the change of the LED state is still in effect, the acknowledgement has no effect.

Setting range: Selected/Not selected  
Default: Not selected

**Send SMS on transition to RED**

The Send SMS on transition to RED check box must be selected if an SMS message should be sent by the Web server (if enabled) whenever the LED turns to red.

Setting range: Selected/Not selected  
Default: Not selected
Pins

![Image of Pin Indication LED]

Fig. 4.3.1.1.-4  Pins tab, Indication LED function block

On the Pins tab, you can see a list of connections on the function block and information about the wire number connected to the pin. There is also information whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has not made connections.

4.3.1.2. Alarm LED

![Image of Alarm LED]

Fig. 4.3.1.2.-1  Function block Alarm LED

Function

The Alarm LED function block represents the alarm LED on the HMI control unit. This enables it to be controlled from the FUPLA.

Connections

The function block connections are not labeled on the function block. They are described as the upper and lower connection.
There are two options for switching the alarm LED on and off:

1. The LED is switched on if the upper connection is at logical 1 and the LED is switched off if the upper connection is at logical 0.

   OR

2. The LED is switched on if the lower connection receives a logical 1 signal and the LED is switched off if there is no longer a logical 1 signal at the lower connection.

   AND

   If the alarm is acknowledged at the REF 542plus control panel.

**Typical application**

The alarm LED is on if a power circuit-breaker OFF command has been generated by a protection function being addressed and the power circuit-breaker has been tripped.

**Configuration**

Only the function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has not made connections. These inputs are then confirmed with the **OK** button.

### 4.3.1.3. Alarm Reset

![Alarm Reset](image)

*Fig. 4.3.1.3.-1 Function block Alarm Reset*

**Function**

The Alarm Reset function block provides return confirmations on the alarm and where from the alarm was acknowledged in the function chart.

**Connections**

ALARM output: Logical 1 if the alarm is still active and the ALARM LED is on (even after an attempted acknowledgement of the alarm)
REMOTE output: Logical 1 impulse if acknowledged from the station control system.

LOCAL output: Logical 1 impulse if acknowledged "locally".

**Typical application**

The signals received can be used to reset flip-flops if an alarm (for example power circuit-breaker off) is acknowledged at the HMI control unit of REF 542plus.

**Configuration**

Only the function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the **OK** button.

### 4.3.1.4. LR-Key

![LR-Key Diagram](image)

*Fig. 4.3.1.4.-1 Function block LR-Key*

**Function**

The LR-Key function block provides information on the position of the “local/remote” key switch on the REF 542plus control panel at both outputs.
Connections

Table 4.3.1.4.-1  Connection at the function block Local - Remote

<table>
<thead>
<tr>
<th>Connection</th>
<th>Local</th>
<th>Remote</th>
</tr>
</thead>
<tbody>
<tr>
<td>No control (OFF)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Remote</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Local</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Local &amp; Remote</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Typical application

A reconfirmation of the key switch setting that can also be forwarded to a substation automation system is possible with the LR-Key function block. This enables switching authorizations to be assigned, for example no switching operations permitted at the HMI control unit.

Configuration

Only the function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the **OK** button.

4.3.1.5. Emergency Buttons

Function

The Emergency Buttons function block represents the two Emergency Switch Off buttons on the HMI control unit. If a switch is actuated, a logical 1 is displayed at the corresponding function block output.

Connections

LEFT output: Logical 1 is displayed if the left key on the HMI control unit is actuated.
Both outputs: Logical 1 is displayed if the both keys on the HMI control unit are actuated.

**Typical application**

A typical application for the emergency buttons is an actuation of the tripping of the circuit-breaker with both emergency switches.

**Configuration**

Only the function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

### 4.3.1.6. HMI Command

![HMI Command Function Block](image)

*Fig. 4.3.1.6.-1 Function block HMI Command*

**Function**

The HMI Command function block represents a command launched by the user via the HMI control unit menu. When the user selects the command from the HMI menu, then the output of the function block is set for one-FUPLA-cycle to logical 1. The name of the HMI menu (visible in the HMI menu) is set into the configuration dialog box of the function block.

**Connections**

Output: Logical 1 for a FUPLA cycle if the command is selected.

**Configuration**

The unique parameter is the command name.
**Enable/Disable**

The new constant block, also called Enable/Disable, produces a 0 or 1 depending on the user’s settings. The user can change the constant value via LD HMI or via communication board. It is possible to instantiate till 40 Enable/Disable function blocks.

**Connections**

Output: Logical value of the constant.
Configuration

The configuration dialog box allows the user to choose the Field bus address (used for the communication board), the name of the constant (used for the HMI), the constant value, and the flag in order to enable the parameter on the HMI.

![Configuration dialog box of the function block Enable/Disable](image)

**Fig. 4.3.1.7.-2** Configuration dialog box of the function block Enable/Disable

4.3.2. Binary IO (switching objects)

This section describes the function blocks that are available in Drawing Menu > Insert > Binary IO.

The function blocks described here are switching objects. A switching object represents one or more combined binary inputs and outputs in the function chart. Instead of function chart the abbreviation FUPLA is used in the following. A switching object enables signals at the binary inputs to be used in the FUPLA. For example, the message from a sensor that monitors the spring of a circuit-breaker or the position messages of a switching device.

A switching object also enables signals to be sent to the binary outputs from the FUPLA. For example, a switching command can be sent to a switching device in this way. Both power and signal outputs can be addressed in case of outputs.

All the switching objects described in the following sections have identically structured FUPLA displays and configuration dialog boxes. To clarify the principle, a switching object 2-1 is described below. However, all elements of the FUPLA display and of the configuration dialog box are explained with the individual switching objects. The explanation there is somewhat shorter.
The switching object labeling already shows the principal structure. An example of a switching object 2-1 can be seen in the next figure. The above mentioned switching object represents the logical combination of two binary outputs and one binary input.

![Switching Object Example](image)

*Fig. 4.3.2.-1 Example of a switching object in the function chart (Fupla symbol)*

### Number of the switching object

The sequential number is displayed in the upper left side of the function block in the FUPLA. It is automatically assigned by the configuration software and updated when function blocks are deleted or new ones are added. It is used to localize the relevant function block in the event of error messages from the configuration software. It is also required in the internal processing of the function blocks in REF 542plus.

### Connection comment/connection number

Every connection drawn in the function chart is assigned a connection number. A comment is also attached to the connection. Comment and number are displayed with every connection in the function chart and the connection number is also displayed in the configuration dialog boxes of the connected function blocks.

### Number and type of the physical input

Physical binary inputs from the primary system are always placed in the right half of the FUPLA display of a switching object. Their connections are also on the right. The signal that is displayed to the physical input can be tapped at the relevant connection. The type (BI - binary input and so on) and the input number of the physical input are also shown in the function chart display.

### Number and type of the physical output

Physical binary outputs to the primary system are always placed in the left half of the FUPLA display of a switching object. Their connections are also on the left. A logical signal to the appropriate connection starts, if authorized, an output relay switching operation. To enable this, a logical 1 must be at the IL input and a logical
0 at the BL input. Otherwise, the interlocking status LED turns to red or the switching operation is suppressed. The type (OP - Open or CL - close and so on) and the channel number of the physical input are also displayed in the FUPLA.

**Pulse output**

The connection pulse output is available only with switching objects that represent at least one physical input and output. Because most switchgears can only switch with short impulses, a closing time of 0 to 65000 ms is provided. This logical 1 is canceled in case of switching objects with a limit stop if a return confirmation regarding the successful switching operation has been transmitted over a binary input of the switching object. Switching objects have a limit stop if they represent at least one physical input and output.

**Limit stop**

If inputs and outputs are combined in one switching object and internally interconnected, the function block includes a limit stop. A limit stop operates when the wanted position of a switch is reached and the reconfirmation is received via a binary input. The switching impulse (generated at P) is canceled, even if the configured impulse length has not yet been reached.

The connection time monitor output Time> is available only with switching objects that represent at least one physical input and output. A logical 1 is displayed at the connection if the impulse time (at pulse output P) has expired and a reconfirmation regarding the successful switching operation is not received by the binary input.

**Interlocking input**

The interlocking input (interlocking) connection is available only with switching objects that represent at least one physical output. To enable a switching operation, there must be a logical 1 at the connection IL. If a switching operation is started and the interlocking input IL is at logical 0, an error message "interlocking violation" is generated and displayed at the REF 542plus control panel using the LED provided for that purpose (interlocking status LED).

**Blocking input**

The connection blocking input (blocking) is available only with switching objects that represent at least one physical output. If a logical 1 is applied to this connection, a switching operation can be blocked. A logical 1 at the BL connection places the function block out of service. If the interlocking input IL is set to logical 1, a switching operation would be allowed. However, this can be blocked by a logical 1 signal at the connection BL. If a signal for the switching operation is given to the connection of the physical output, no switching takes place and an "interlocking violation" error message (interlocking status LED) is also generated.
Field bus address

The combined inputs can be addressed under a Field bus address as shown in the figure below, in which a configuration dialog box is displayed after double clicking the FUPLA symbol. The Field bus address is to be selected in the configuration dialog box.

![Switching Object Configuration Dialog Box](image)

Fig. 4.3.2.-2 Example of the switching object configuration dialog box

Furthermore there are:

Number and type of the physical input

Enter a channel number for the physical binary inputs from the primary system.

Setting range: 0...[number of binary inputs] (increment: 1)
Default: 0

Filtertime [ms]

Enter a period in ms during which an input signal at the binary input must be applied to be detected as such. The function block-dependent filter time entered here is added to the general filter time, which is specified in the configuration dialog box REF 542plus Global Settings, and to the hardware filter time, which is set by the design of the binary input/output board.

hardware filter time + general filter time = total filter time
Number and type of physical output

Enter a channel number for the physical binary outputs to the primary system.

Setting range: 0… [number of binary outputs] (increment: 1)
Default: 0
Note the different relay types.

Imp.length [ms]

Because most switchgears can only switch with short impulses, a closing time of 0 to 65000 ms can be written in the configuration dialog box under impulse length, which has exactly the same effect on the current output. This "extended" switching signal is generated as logical 1 at the pulse output P connection. This logical 1 is canceled in the case of switching objects with a limit stop if a return confirmation regarding the successful switching operation has been transmitted over a binary input of the switching object. Switching objects have a limit stop if they represent at least one physical input and output.

No. of cycles

Enter the value of the mechanical switching cycle counter at the circuit-breaker in the No. of cycles text box. The value entered in the No. of cycles text box is the starting value of the switching cycle counter in REF 542plus. When the configuration is exported from REF 542plus to the PC, the current value of the switching cycles is entered to this position.

In this program version the text box is only used by the Switching Object 2-2 if a circuit-breaker is applied. It has no function with all other switching objects.

Field bus address

The Field bus address is shown at the bottom left side of the FUPLA beside the switching object: "Adr.: XX". It is automatically assigned in the configuration dialog box, so every Field bus address is only used once. Addresses that are freed (when a function block is deleted) are assigned again by the configuration software. As an alternative the Field bus address can also be assigned in the configuration dialog box with the field bus selection list. The selection list is displayed by clicking the < button.
Setting range: 5 ... 49 and 111 ... 127 (increment: 1)
Default: The next free Field bus address

**Pins**

Under Pins in the Switching Object dialog box is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

**Setting for switching object-specific special function**

Check boxes for activating or deactivating functions appear here. Further information can be found in the switching object description.

**Events**

The Events button cannot be selected if the transmission of events is generally suppressed in the REF 542plus Global Settings. Click the Events button to display a dialog box where the events are released that are then sent to the station automation system. The default is for all events to be released for sending.

An event that has been sent is a message to the station control system regarding a change in status. Depending on the function block type, different events can be generated and released. The input can be accepted or canceled in the dialog box with the OK and Cancel buttons.

**Comment**

Enter comments regarding the switching object in the Comment text box. The comment is also shown on the upper left side of the switching object in the function chart.

Setting range: 0 ... 20 characters (standard character set)
Default: [Empty]

**OK**

Click OK to save all settings in the configuration software. The dialog box is closed.

**Cancel**

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
4.3.2.1. Switching Object 0-1

The signal of a physical binary input is made available in the Switching object 0-1 function block.

Connections

BI output: Connection at which the binary input signal of the represented physical input can be tapped.

<table>
<thead>
<tr>
<th>FUPLA display</th>
<th>Parameter setting range of the configuration dialog box</th>
<th>Connection label in the configuration dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bl</td>
<td>Input</td>
<td>Bl</td>
</tr>
</tbody>
</table>

Typical application

A typical application for the switching object 0-1 is a connection of a gas pressure monitor that sends a logical 1 or 0 to the relevant binary input.
Configuration

Field bus address

The Field bus address is automatically assigned so that every Field bus address is used only once. As an alternative the Field bus address can also be selected from the list, which is displayed by clicking the < button.

Setting range: 5 ... 49 and 111 ... 127 (increment: 1)
Default: Next free Field bus address

Input No. [Name] (once per represented input)

In the Input No. [Name] text box enter the number of the physical input to be represented. The assigned number, underlined in white, is also shown in the function block adjacent to the connection.

Setting range: 0 ... [number of binary inputs] (increment: 1)
Default: 0

Filtertime [ms] (once per represented input)

In the Filtertime[ms] text box enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.
Comment

Enter comments (for example purpose) on the switching object in the Comment text box. The text is also displayed in the FUPLA on the left side above the switching object.

Setting range: 0 ... 21 characters (standard character set)
Default: [Empty]

Pins

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

Events

Click the Events button to open a dialog box. Select (activate) the events that are sent to the station control system over the field bus. The button is available only when the events function has been activated in the Global Settings.

4.3.2.2. Switching Object 0-3

![Diagram of Switching Object 0-3](image)

Fig. 4.3.2.2.-1  Function block Switching Object 0-3
Function

The signal of three physical binary inputs is made available in the Switching Object 0-3 function block. All connections are addressed over one Field bus address.

Connections

EARTH, OPEN and LINE outputs: Connections at which the binary input signals of the various represented physical inputs can be tapped.

<table>
<thead>
<tr>
<th>Table 4.3.2.2.-1</th>
<th>Connection labels switching object 0-3</th>
</tr>
</thead>
<tbody>
<tr>
<td>FUPLA display</td>
<td>Parameter setting range of the</td>
</tr>
<tr>
<td></td>
<td>configuration dialog box</td>
</tr>
<tr>
<td></td>
<td>Connection label in the</td>
</tr>
<tr>
<td></td>
<td>configuration dialog box</td>
</tr>
<tr>
<td>EARTH</td>
<td>Input No. earth</td>
</tr>
<tr>
<td>OPEN</td>
<td>Input No. open</td>
</tr>
<tr>
<td>LINE</td>
<td>Input No. line</td>
</tr>
</tbody>
</table>

Typical application

Position a confirmation signal from a manually operated switching device, for example a 3-position isolator.

Configuration

Fig. 4.3.2.2.-2  Configuration dialog box Switching Object 0-3
Field bus address

The Field bus address is automatically assigned so that every Field bus address is only used once. As an alternative, the Field bus address can also be selected from the list, which is displayed by clicking the < button.

Setting range: 5 ... 49 and 111 ... 127 (increment: 1)
Default: Next free Field bus address

Input No. [Name] (once per represented input)

In the Input No. [Name] text box enter the number of the physical input that is to be represented. The assigned number, underlined, underlined in white, is also shown in the function block adjacent to the connection.

Setting range: 0 ... [number of binary inputs] (increment: 1)
Default: 0

Filtertime [ms] (once per represented input)

In the Filtertime [ms] text box enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.

Comment

In the Comment text box enter comments (for example purpose) on the switching object. The text is also displayed in the FUPLA on the left side above the switching object.

Setting range: 0 ... 21 characters (standard character set)
Default: [Empty]

Pins

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
Events

Click the **Events** button to open a dialog box. Select (activate) the events that are sent to the station control system over the field bus. The button is available only when the events function has been activated in the Global Settings.

4.3.2.3. Switching Object 1-0

**Fig. 4.3.2.3.-1 Function block Switching Object 1-0**

Function

Switching Object 1-0 actuates a physical binary output from the function chart.

Connections

IL input is an interlocking input. A switching operation can only be conducted if there is a logical 1 signal.

BL input is a blocking input. If there is a logical 1 signal here, the switching operations of the represented output are blocked.

PO input is a signaling input for a physical output. A logical 1 signal initiates, if enabled, an output relay switching operation.

P output is a pulse output. A logical 1 can be tapped for the duration of the output relay switching operation.

**Table 4.3.2.3.-1 Connection labels switching object 1-0**

<table>
<thead>
<tr>
<th>FUPLA display</th>
<th>Parameter setting range of the configuration dialog box</th>
<th>Connection label in the configuration dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO</td>
<td>Output No.</td>
<td>PO active</td>
</tr>
<tr>
<td>IL</td>
<td>-</td>
<td>IL</td>
</tr>
<tr>
<td>P</td>
<td>-</td>
<td>Pulse</td>
</tr>
<tr>
<td>BL</td>
<td>-</td>
<td>BL</td>
</tr>
</tbody>
</table>

Typical application

Use as output for the contact signaling of for example general start.
Configuration

Field bus address

The Field bus address is automatically assigned so that every Field bus address is only used once. As an alternative the Field bus address can also be selected from the list which is displayed by clicking the < button.

Setting range: 5 \ldots 49 \ldots 111 \ldots 127 (increment: 1)
Default: Next free Field bus address

Output No. [Name] (once per represented output)

Enter the number of the physical output that is to be represented in the Output No. text box. The assigned number, underlined, underlined in white, is also shown in the function block adjacent to the connection.

Setting range: 0 \ldots \text{[number of binary outputs]} (increment: 1)
Default: 0

Imp.length [ms] (once per represented output)

Enter the maximum duration of the output relay switching operation in the Imp. length [ms] text box. In function blocks with limit stops the switching operation ends before if necessary.
No. of cycles (once per represented output)

Not used.

Comment

Enter comments (for example purpose) on the switching object in the Comment text box. The text is also displayed in the FUPLA on the left side above the switching object.

Setting range: 0 … 21 characters (standard character set)
Default: [Empty]

Pins

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

Use Two Step Switch Command

If two-stage switching is activate, a switching object must be selected with a command from the station control system and switched with a 2nd command. This option does not refer to local switching.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

Events

Click the Events button to open a dialog box. Select (activate) the events that are sent to the station control system over the field bus. The button is available only when the events function has been activated in the Global Settings.
**4.3.2.4. Switching Object 1-1**

![Diagram of Switching Object 1-1](image)

**Fig. 4.3.2.4.-1 Function block Switching Object 1-1**

**Function**

Switching Object 1-1 function block actuates a physical binary output from the function chart. The return confirmation is received via the physical binary input, which can be tapped in the function chart.

**Connections**

IL input is an interlocking input. A switching operation can only be conducted if there is a logical 1 signal here.

BL input is a blocking input. If there is a logical 1 signal here, the switching operations of the represented output are blocked.

PO input is a signaling input for a physical output. A logical signal to this function block input starts, if enabled, a corresponding switching operation of the represented output relay.

P output is a pulse output. A logical 1 can be tapped for the duration of the output relay switching operation.

BI output is a signal output at which the binary input signal of the represented physical input can be tapped.

Time > output is a time monitor output. If a logical 1 can be tapped here, the set impulse time is expired and a return confirmation regarding the correct switching operation is no longer received over the represented binary input.

**Table 4.3.2.4.-1 Connection labels switching object 1-1**

<table>
<thead>
<tr>
<th>FUPLA display</th>
<th>Parameter setting range of the configuration dialog box</th>
<th>Connection label in the configuration dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>IL</td>
<td>-</td>
<td>IL</td>
</tr>
<tr>
<td>BL</td>
<td>-</td>
<td>BL</td>
</tr>
<tr>
<td>PO</td>
<td>Output No.</td>
<td>PO Active</td>
</tr>
<tr>
<td>TIME&gt;</td>
<td>-</td>
<td>Time&gt;</td>
</tr>
<tr>
<td>BI</td>
<td>Input No.</td>
<td>BI</td>
</tr>
<tr>
<td>P</td>
<td>-</td>
<td>Pulse</td>
</tr>
</tbody>
</table>
Typical application

A typical application for the Switching Object 1-1 is using the physical output to actuate a tension motor for the spring of a power circuit-breaker. The return confirmation over the physical input provides information on the spring status.

Configuration

![Configuration dialog box Switching Object 1-1](image)

**Fig. 4.3.2.4.-2 Configuration dialog box Switching Object 1-1**

Field bus address

The Field bus address is automatically assigned so that every Field bus is only used once. As an alternative the Field bus address can also be selected from the list, which is displayed by clicking the < button.

- Setting range: 5 … 49 and 111 … 127 (increment: 1)
- Default: Next free Field bus address

Output No. [Name] (once per represented output)

Enter the number of the physical output that is to be represented in the Output No. text box. The assigned number, underlined, underlined in white, is also shown in the function block adjacent to the connection.
Setting range: 0 … [number of binary outputs] (increment: 1)
Default: 0

**Imp.length [ms] (once per represented output)**

Enter the maximum duration of the output relay switching operation in the Imp. length [ms] text box. In function blocks with limit stops the switching operation ends before if necessary.

**No. of cycles (once per represented output)**

Not used.

**Input No. [Name] (once per represented input)**

Enter the number of the physical input that is to be represented in the Input No. text box. The assigned number, underlined, underlined in white, is also shown in the function block adjacent to the connection.

Setting range: 0 … [number of binary inputs] (increment: 1)
Default: 0

**Filtertime [ms] (once per represented input)**

In the Filtertime [ms] text box enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.

**Comment**

Enter comments (for example purpose) on the switching object in the Comments text box. The text is also displayed in the FUPLA on the left side above the switching object.

Setting range: 0 … 21 characters (standard character set)
Default: [Empty]

**Pins**

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.
Use Two Step Switch Command

If two-stage switching is activated, a switching object must be selected with a command from the station control system and switched with a 2nd command. This option does not refer to local switching.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

Events

Click the Events button to open a dialog box. Select (activate) the events that are sent to the station control system over the field bus. The button is available only when the events function has been activated in the Global Settings.

4.3.2.5. Switching Object 1-2

Switching Object 1-2 function block actuates a physical binary output from the function chart. The return confirmation is received via two physical binary inputs, which can be tapped in the function chart.

Connections

IL input is an interlocking input. A switching operation can only be conducted if there is a logical 1 here.

BL input is a blocking input. If there is a logical 1 signal here, the switching operations of the represented output are blocked.
PO input is a signaling input for a physical output. A logical signal to this function block input starts, if enabled, a corresponding switching operation of the represented output relay.

Time > output is a time monitor output. If a logical 1 can be tapped here, the set impulse time is expired and a return confirmation regarding the correct switching operation is no longer received over the represented binary input.

OP, CL outputs are signal outputs at which the binary input signal of the represented physical input can be tapped.

P output is a pulse output. A logical 1 can be tapped for the duration of the output relay switching operation.

Table 4.3.2.5.-1 Connection labels switching object 1-2

<table>
<thead>
<tr>
<th>FUPLA display</th>
<th>Parameter setting range of the configuration dialog box</th>
<th>Connection label in the configuration dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>IL</td>
<td>-</td>
<td>IL</td>
</tr>
<tr>
<td>BL</td>
<td>-</td>
<td>BL</td>
</tr>
<tr>
<td>PO</td>
<td>Output No.</td>
<td>PO Active</td>
</tr>
<tr>
<td>TIME&gt;</td>
<td>-</td>
<td>Time&gt;</td>
</tr>
<tr>
<td>OP</td>
<td>Input No. open</td>
<td>BI open</td>
</tr>
<tr>
<td>CL</td>
<td>Input No. closed</td>
<td>BI closed</td>
</tr>
<tr>
<td>P</td>
<td>-</td>
<td>Pulse</td>
</tr>
</tbody>
</table>
Configuration

Field bus address

The Field bus address is automatically assigned so that every Field bus address is only used once. As an alternative the Field bus address can also be selected from the list which is displayed by clicking the < button.

Setting range: 5 ... 49 and 111 ... 127 (increment: 1)
Default: Next free Field bus address

Output No. [Name] (once per represented output)

Enter the number of the physical output that is to be represented to the Output No. text box. The assigned number, underlined in white, is also shown in the function block adjacent to the connection.

Setting range: 0 ... [number of binary outputs] (increment: 1)
Default: 0

Imp.length [ms] (once per represented output)

Enter the maximum duration of the output relay switching operation in the Imp. length [ms] text box. In function blocks with limit stops the switching operation is ended before if necessary.
No. of cycles (once per represented output)

Not used.

Input No. [Name] (once per represented input)

Enter the number of the physical input that is to be represented in the Input No. text box. The assigned number is also shown in the function block adjacent to the connection.

Setting range: 0 … [number of binary inputs] (increment: 1)
Default: 0

Filtertime [ms] (once per represented input)

In the Filtertime [ms] textbox, enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.

Comment

Enter comments (for example purpose) on the switching object in the Comment text box. The text is also displayed in the FUPLA on the left above the switching object.

Setting range: 0 … 21 characters (standard character set)
Default: [Empty]

Pins

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

Indicate Intermediate Position

If this check box is selected, an intermediate setting is displayed on the LCD screen during the switching operation. This enables a visual confirmation of the switching operation on the LCD. Otherwise only the initial and final positions are displayed during a switching operation.

Use Two Step Switch Command

If two-stage switching is activated, a switching object must be selected with a command from the station control system and switched with a 2nd command. This option does not refer to local switching.
OK

Click **OK** to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

Events

Click the **Events** button to open a dialog box. Select (activate) the events that are sent to the station control system over the field bus. The button is available only when the events function has been activated in the Global Settings.

4.3.2.6. Switching Object 2-1

![Function block Switching Object 2-1](image)

**Fig. 4.3.2.6.-1 Function block Switching Object 2-1**

Function

Switching Objects 2-1 function block actuates two physical binary outputs from the function chart. The return confirmation is received via the physical binary input, which can be tapped in the function chart.

Connections

IL input is an interlocking input. A switching operation can only be conducted if there is a logical 1 here.

BL input is a blocking input. If there is a logical 1 signal here, the switching operations of the represented output are blocked.

OP, CL inputs are signaling inputs for one physical output each. A logical signal to this function block input starts, if enabled, a corresponding switching operation of the represented output relay.

Time > output is a time monitor output. If a logical 1 can be tapped here, the set impulse time is expired and a return confirmation regarding the correct switching operation is no longer received over the represented binary input.
BI output is a signal output at which the binary input signal of the represented physical input can be tapped.

P outputs are pulse outputs, one for each represented output. A logical 1 can be tapped for the duration of the switching operation of the output relay.

**Table 4.3.2.6.-1 Connection labels switching object 2-1**

<table>
<thead>
<tr>
<th>FUPLA display</th>
<th>Parameter setting range of the configuration dialog box</th>
<th>Connection label in the configuration dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>IL</td>
<td>-</td>
<td>IL open</td>
</tr>
<tr>
<td>IL</td>
<td>-</td>
<td>IL closed</td>
</tr>
<tr>
<td>BL</td>
<td>-</td>
<td>BL</td>
</tr>
<tr>
<td>OP</td>
<td>Output No. open</td>
<td>PO open</td>
</tr>
<tr>
<td>CL</td>
<td>Output No. close</td>
<td>PO closed</td>
</tr>
<tr>
<td>TIME&gt;</td>
<td>-</td>
<td>Time&gt;</td>
</tr>
<tr>
<td>BI</td>
<td>Input No.</td>
<td>BI</td>
</tr>
<tr>
<td>P</td>
<td>-</td>
<td>Pulse open</td>
</tr>
<tr>
<td>P</td>
<td>-</td>
<td>Pulse close</td>
</tr>
</tbody>
</table>

**Configuration**

![Configuration dialog box Switching Object 2-1](image)

**Fig. 4.3.2.6.-2 Configuration dialog box Switching Object 2-1**
Field bus address

The Field bus address is automatically assigned so that every Field bus address is only used once. As an alternative the Field bus address can also be selected from the list which is displayed by clicking the < button.

Setting range: 5 ... 49 and 111 ... 127 (increment: 1)
Default: Next free Field bus address
Setting range for physical outputs: Every text box exists once per represented output.

Output No. [Name] (once per represented output)

Enter the number of the physical output that is to be represented to the Output No. text box. The assigned number, underlined in white, is also shown in the function block adjacent to the connection.

Setting range: 0 ... [number of binary outputs] (increment: 1)
Default: 0

Imp.length [ms] (once per represented output)

Enter the maximum duration of the output relay switching operation in the Imp. length [ms] text box. In function blocks with limit stops the switching operation is ended before if necessary.

No. of cycles (once per represented output)

Not used.

Input No. [Name] (once per represented input)

Enter the number of the physical input that is to be represented in the Input No. text box. The assigned number is also shown in the function block adjacent to the connection.

Setting range: 0 ... [number of binary inputs] (increment: 1)
Default: 0

Filtertime [ms] (once per represented input)

In the Filtertime [ms] text box, enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.

Comment

Enter comments (for example purpose) on the switching object in the Comment text box. The text is also displayed in the FUPLA on the left above the switching object.
Setting range: 0 ... 21 characters (standard character set)
Default: [Empty]

Pins

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

Use Two Step Switch Command

If two-stage switching is activated, a switching object must be selected with a command from the station control system and switched with a 2nd command. This option does not refer to local switching.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

Events

Click the Events button to open a dialog box. Select (activate) the events that are sent to the station control system over the field bus. The button is available only when the events function has been activated in the Global Settings.

4.3.2.7. Switching Object 2-2

![Function block Switching Object 2-2](image)

Fig. 4.3.2.7.-1 Function block Switching Object 2-2
Function

Switching Objects 2-2 function block actuates two physical binary outputs from the FUPLA. The reconfirmation is received via two physical binary inputs, which can be defined in the FUPLA. This switching object can also be used to actuate a circuit-breaker.

Connections

IL inputs are interlocking inputs, one per represented output. A switching operation can be conducted if a logical 1 is here.

BL input is a locking input. If there is a logical 1 signal here, the switching operations of the represented output are blocked.

OP, CL inputs (left) are FUPLA inputs for actuating each time the related physical output. A logical signal to this function block input starts, if enabled, a corresponding switching operation of the related output relay.

SYNCH. input is not a synchronized input. A closing operation is only allowed if a logical 0 signal is present at the input.

RES. GRANT input is a reservation grant input. A switching operation is only possible, if the logical 1 signal is present at the input. This input is normally used in connection with LON communication per LAG (LON Application Guide) version 1.4 as confirmation the reservation request.

Time > output is a time monitor output. If a logical 1 can be tapped here, the set impulse time is expired and a return confirmation regarding the correct switching operation is no longer received over the represented binary input.

OP, CL outputs (right): Channel definition of the signal outputs coming from the status information of the primary switching device.

P outputs are pulse outputs, one per represented output. A logical 1 can be tapped for the duration of the switching operation of the output relay

DEF OPEN output is a defined open output, which generates a logical 1 signal if the switching device has reached the definitive open position.

DEF CLOSE output is a defined close output, which generates a logical 1 signal if the switching device has reached the definitive close position.

DEF POS output is a defined Position output, which generates a logical 1 signal if the switching device has reached the definitive open or closed position.

ERROR POS output is an error position output, which generates a logical 1 signal if both open and close output has a logical 1 signal or if the switching operation is interrupted by overreaching the time monitor.
RES. REQ output is a reservation request output, which is normally used in connection with LON communication per LAG 1.4. Before starting the switching operation, a reservation request must be done by generating a logical 1 signal at this output.

Table 4.3.2.7.-1  Connection labels switching object 2-2

<table>
<thead>
<tr>
<th>FUPLA display</th>
<th>Parameter setting range of the configuration dialog box</th>
<th>Connection label in the configuration dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>IL</td>
<td>-</td>
<td>IL open</td>
</tr>
<tr>
<td>IL</td>
<td>-</td>
<td>IL closed</td>
</tr>
<tr>
<td>BL</td>
<td>-</td>
<td>BL</td>
</tr>
<tr>
<td>OP (left)</td>
<td>Output No. open</td>
<td>PO open</td>
</tr>
<tr>
<td>CL (left)</td>
<td>Output No. close</td>
<td>PO closed</td>
</tr>
<tr>
<td>SYNCH.</td>
<td>-</td>
<td>NOT Synchronized</td>
</tr>
<tr>
<td>RES. GRANT</td>
<td>-</td>
<td>Reservation Granted</td>
</tr>
<tr>
<td>TIME OUT</td>
<td>-</td>
<td>Time Limit Expired</td>
</tr>
<tr>
<td>OP (right)</td>
<td>Input No. open</td>
<td>-</td>
</tr>
<tr>
<td>CL (right)</td>
<td>Input No. close</td>
<td>-</td>
</tr>
<tr>
<td>BI</td>
<td>-</td>
<td>BI</td>
</tr>
<tr>
<td>P</td>
<td>-</td>
<td>Pulse pin open</td>
</tr>
<tr>
<td>P</td>
<td>-</td>
<td>Pulse pin close</td>
</tr>
<tr>
<td>DEF. OPEN</td>
<td>-</td>
<td>Defined open</td>
</tr>
<tr>
<td>DEF. CLOSE</td>
<td>-</td>
<td>Defined Closed</td>
</tr>
<tr>
<td>DEF. POS</td>
<td>-</td>
<td>Def Position</td>
</tr>
<tr>
<td>ERROR POS</td>
<td>-</td>
<td>Error Position</td>
</tr>
<tr>
<td>TIMEOUT</td>
<td>-</td>
<td>Time Limit Expired</td>
</tr>
<tr>
<td>RES. REQ</td>
<td>-</td>
<td>Reservation Request</td>
</tr>
</tbody>
</table>

Typical application

A typical application is the use of the binary outputs to actuate a motor-driven isolator. The position status confirmation signal is received via the two binary inputs.

Configuration

The following section describes several tabs in the Switching Object 2-2 configuration dialog box. In all the tabs there are OK or Cancel buttons.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.
Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

**General**

![Image](image.png)

*Fig. 4.3.2.7.-2 General tab, function block Switching Object 2-2*

**Field bus address**

The Field bus address is automatically assigned so that every Field bus address is only used once. As an alternative the Field bus address can also be selected from the list, which is displayed by clicking the `< ▼ >` button.

Setting range: 5 ... 49 and 111 ... 127 (increment: 1)
Default: Next free Field bus address

**Comment**

Enter comments (for example purpose) on the switching object in the Comment text box. The text is also displayed in the FUPLA on the left side above the switching object.
Setting range: 0 ... 20 characters (standard character set)
Default: [Empty]

**Kind of switching device**
Select the check box corresponding to the switching device used.

**Options**
Under Options select the option required for displaying the switching operation on the LCD:

**Indicate intermediate position**
If the Indicate intermediate position check box is selected, an intermediate setting is displayed on the LCD screen during the switching operation. This enables a visual return confirmation of the switching operation on the LCD. Otherwise only the initial and final positions are displayed during a switching operation.

**Enable two step command**
If the Enable two step command check box is selected, two-stage switching is activated. The switching object must be selected with a command from the station automation system and switched with a 2nd command. This option does not refer to local switching.

**Invert inputs**
If the Invert inputs check box is selected, the logical signal of the inputs are inverted.

**Open/Close activated by**
Select the signal used for the switching operation.
Outputs

Fig. 4.3.2.7.-3 Outputs tab, function block Switching Object 2-2

Output Open

Output

In the Output text box enter the number of the physical output that is to be represented. The assigned number is also shown in the function block adjacent to the connection.

Setting range: 0 ... 27 [number of binary outputs] (increment: 1)
Default: 0

Pulse length [ms]

In the Pulse length [ms] text box enter the maximum duration of the output relay switching operation. In function blocks with limit interrupts the switching operation if necessary.

Setting range: 0 ... 65000 (increment: 1)
Default: 100
Output Close

Output

In the Output text box enter the number of the physical output that is to be represented. The assigned number is also shown in the function block adjacent to the connection.

Setting range: 0 … 27 [number of binary outputs] (increment: 1)
Default: 0

Pulse length [ms]

In the Pulse length [ms] text box enter the maximum duration of the output relay switching operation. In function blocks with limit interrupts the switching operation if necessary.

Setting range: 0 … 65000 (increment: 1)
Default: 100

Switch cycles

In the Switch cycles text box enter the number of switching cycle during the reconfiguration of the REF 542plus device.

Setting range: 0 … 65000 (increment: 1)
Default: 0
Inputs

Fig. 4.3.2.7.-4 Inputs tab, function block Switching Object 2-2

Position Indication: Open

Input [Name]

In the Input text box enter the number of the physical input that is to be represented. The assigned number is shown in the function block adjacent to the connection.

Setting range: 0 ... 42 (increment: 1)
Default: 0

Filter time [ms]

In the Filter time text box enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.

Setting range: 0 ... 65000 (increment: 1)
Default: 100

Position Indication: Close

Input [Name]

In the Input text box enter the number of the physical input that is to be represented. The assigned number is shown in the function block adjacent to the connection.
Setting range: 0 … 42 (increment: 1)
Default: 0

Filter time [ms]

In the Filter time text box enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.

Setting range: 0 … 65000 (increment: 1)
Default: 100

Response time

In the Response time text box enter the maximum duration of the time for the granting the reservation.

Setting range: 0 … 65000 (increment: 1)
Default: 100

Synchron time

In the Synchron time text box enter the maximum duration of the time for the synchronization of the closing operation.

Setting range: 0 … 65000 (increment: 1)
Default: 100
Events

Fig. 4.3.2.7.-5  Events tab, function block Switching Object 2-2

The main part in the tab is the list of events. The channel number over which the events are sent is shown in the left column near to the check box. To enable the individual events to be transmitted to the substation automation system, transmission of events must be generally enabled.

The events of the function block Power Factor Controller must also be enabled. Mark the adjacent check box so the event is generated and sent as required.

**Set All**

Click the Set All button to select, generate and send all events as required.

**Clear All**

Click the Clear All button to clear the selection.

**Set Default**

Click the Set Default button to use the default configuration for events. The default configuration for events for each function object is defined in the associated *.rce file.
Save Default

Click the Save Default button to save the checked events in the associated *.rce file.

Event Masks E15 … E0 and E31 … E16

The selecting of events is also possible under Event Masks. The input must be in hexadecimal code. Refer to the following Table 4.3.2.7.-2 for the events E0 to E15. The input for the events from E16 to E31 is in principle similar. The events E28 to E31 are not used in this function block. If you select the check boxes in the list you can read the hexadecimal code in the text boxes.

Table 4.3.2.7.-2 shows an overview of the events of the function block Unbalanced Load Protection.

**Table 4.3.2.7.-2 Switching Object 2-2**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Moving</td>
<td>Input opened</td>
<td>Output opened</td>
<td>End position not reached started</td>
<td>Error</td>
<td>Error</td>
<td>End position not reached back</td>
<td>Output 2 opened</td>
<td>Blocked inactive</td>
<td>E2</td>
<td>Input closed</td>
<td>E31</td>
<td>Output closed</td>
<td>E30</td>
<td>Interloced inactive</td>
<td>E31</td>
<td>Interloced active</td>
<td>E30</td>
<td>Synch. Bypass inactive</td>
<td>E31</td>
<td>Bypass inactive</td>
<td>E29</td>
<td>Selected back</td>
<td>E31</td>
<td>Selected started</td>
<td>E29</td>
<td>Bypass active</td>
<td>E29</td>
<td>Execution confirmation positive</td>
<td>E31</td>
<td>Select confirmation positive</td>
<td>E29</td>
<td>Execution termination positive</td>
</tr>
</tbody>
</table>
In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.2.8. Switching Object 2-2 H-Bridge

This switching object can only be used with the input/output board with solid state relays. One switching object 2-2 H-Bridge or 4-4 H-Bridge can be used in the application per board.
Function

The Switching Object 2-2 H-Bridge function block is used to actuate four binary physical outputs, which are specially designed for the motor control unit. The required return confirmations are received via the three physical binary inputs. Only two of the four physical outputs in use can be actuated. The other two are used to implement the wanted functions and are actuated internally.

Connections

IL inputs are interlocking inputs, one per represented output. A switching operation can be conducted if there is a logical 1 here.

BL input is a blocking input. If there is a logical 1 signal here, the switching operations of the represented output are blocked.

LINE, EARTH inputs (left) are signaling inputs for one physical output each. A logical signal to this function block input starts, if enabled, a corresponding switching operation of the represented output relay. The unlabelled inputs cannot be influenced; their function is implemented over the relay circuitry.

RES. GRANT inputs are reservation grant inputs. A switching operation is only possible if the logical 1 signal is present at the input. This input is normally used in connection with LON communication per LAG 1.4 as confirmation of the reservation request.

Time > output is a time monitor output. If a logical 1 can be tapped here, the set impulse time is expired and a return confirmation regarding the correct switching operation is no longer received over the represented binary input.

LINE, EARTH outputs (right) are signal outputs at which the binary input signal of the represented physical input can be tapped.

PP outputs are pulse outputs, one per represented output. A logical 1 can be tapped for the duration of the switching operation of the output relay.

RES. REQ output is a reservation request output, which is normally used in connection with LON communication per LAG 1.4. Before starting the switching operation, a reservation request must be done by generating a logical 1 signal at this output.

Table 4.3.2.8.-1 Connection labels Switching Object 2-2 H-Bridge

<table>
<thead>
<tr>
<th>FUPLA display</th>
<th>Parameter setting range of the configuration dialog box</th>
<th>Connection label in the configuration dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>IL (EARTH)</td>
<td>-</td>
<td>IL earth</td>
</tr>
<tr>
<td>IL (LINE)</td>
<td>-</td>
<td>IL line</td>
</tr>
<tr>
<td>EARTH (left)</td>
<td>Earth</td>
<td>Earth</td>
</tr>
<tr>
<td>LINE (left)</td>
<td>Line</td>
<td>Line</td>
</tr>
<tr>
<td>BL</td>
<td>-</td>
<td>BL</td>
</tr>
</tbody>
</table>
FUPLA display | Parameter setting range of the configuration dialog box | Connection label in the configuration dialog box
---|---|---
EARTH (right) | Input No. earth | BI earth
LINE (right) | Input No. line | BI line
RES. GRANT | - | Reservation granted
TIME > | - | Timeout
VALID | - | Valid Position
RES. REQ | - | Reservation Request

**Typical application**

This switching object can be used to control a motor-driven transfer switch without an intermediate setting. This functions with special circuitry of two relays on the binary input/output board with solid state relays.

**Configuration**

The following section describes several tabs in the Switching Object 2-2 H-Bridge dialog box. In all tabs the **OK** and **Cancel** buttons are available.

**OK**

Click **OK** to save all settings in the configuration software. The dialog box is closed.

**Cancel**

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.
General

**Fig. 4.3.2.8.-2** General tab, function block Switching Object 2-2 H-Bridge

**Field bus address**

The Field bus address is automatically assigned so that every Field bus address is used only once. As an alternative, the Field bus address can also be selected from the list, which is displayed by clicking the `< ▼ >` button.

Setting range: 5 ... 49 and 111 ... 127 (increment: 1)
Default: Next free Field bus address

**Comment**

Enter comments (for example purpose) on the switching object in the Comments text box. The text is also displayed in the FUPLA on the left side above the switching object.

Setting range: 0 ... 20 characters (standard character set)
Default: [Empty]

**Options**

Under Options select the option required for displaying the switching operation on the LCD:
Indicate intermediate position

If the Indicate intermediate position check box is selected, an intermediate setting is displayed on the LCD screen during the switching operation.

Enable two step command

If the Enable two step command check box is selected, the two-stage switching is activated and a switching object must be selected with a command from the station automation system and switched with a 2nd command. This option does not refer to local switching.

Invert inputs

If the Invert inputs check box is selected, the logical signal of the inputs is inverted.

Parameter

![Parameter configuration](image)

Fig. 4.3.2.8.-3  Parameters tab, function block Switching Object 2-2 H-Bridge

Brake Time

In the Brake Time text box enter a time in ms for which the motor windings are short-circuited to brake the motor after reaching the end position.
Setting range: 0 ... 65 000 ms (increment: 1 ms)
Default: 100

Waiting Time

In the Waiting Time text box enter a time in ms during which no switching command can be sent to prevent overloading the transistors on the input/output board and the motor.

Setting range: 2 000 ... 65 000 ms (increment: 1 ms)
Default: 2 000

MaxTimeToGrant

In the MaxTimeToGrant text box enter a time in ms during which the reservation of the switching operation in connection with the LON Communication per LAG 1.4 is granted.

Outputs

Fig. 4.3.2.8.-4 Outputs tab, function block Switching Object 2-2 H-Bridge

No. of Cycles (available twice)

Not used.
Pulse Length

In the Pulse Length text box enter the maximum duration of the output relay switching operation. In function blocks with limit stops the switching operation ends before if necessary.

Inputs

![Input Settings Line/Earth](image)

**Input Settings Line/Earth**

The number of the represented physical output is a fixed assignment.

Setting range: \(0 \ldots \text{[number of binary outputs]}\) (increment: 1)

Default: 0

**Input No. [Name] (once per represented input)**

In the Input No. [Name] text box enter the number of the physical input to be represented. The assigned number is also shown in the function block adjacent to the connection.
Setting range: 0 ... 42 [number of binary inputs] (increment: 1)
Default: 0

Filter time [ms] (once per represented output)

In the Filter time [ms] enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.

Events

Fig. 4.3.2.8.-6 Events tab, function block Switching Object 2-2 H-Bridge

Set All
Click the Set All button to select, generate and send all events as required.

Clear All
Click the All button to clear the selection.

Set Default
Click the Set Default button to use the default configuration for events. The events 0 ... 7, 18, 19 and 24 ... 27 are selected.
The selecting of events is also possible under Event Masks. The input must be in hexadecimal code. Refer to the following table for the events E0 to E15. The input for the events from E16 to E31 is in principle similar. The events E28 to E31 are not used in this function block. If you select the check boxes in the list you can read the hexadecimal code in the text boxes.

The following Table 4.3.2.8.-2 shows an overview of the events of the function block Unbalanced Load Protection.

Table 4.3.2.8.-2 Switching Object 2-2

<table>
<thead>
<tr>
<th>8 E0</th>
<th>Switch Position Intermediate</th>
<th>8 E4</th>
<th>Switch Position Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 E1</td>
<td>Switch Position Open</td>
<td>8 E2</td>
<td>Switch Position Closed</td>
</tr>
<tr>
<td>8 E9</td>
<td>Command timeout inactive</td>
<td>8 E10</td>
<td>Command timeout active</td>
</tr>
<tr>
<td>8 E13</td>
<td>Interlocking error left</td>
<td>8 E14</td>
<td>Interlocking error right</td>
</tr>
<tr>
<td>8 E15</td>
<td>Blocked inactive</td>
<td>8 E16</td>
<td>Blocked active</td>
</tr>
<tr>
<td>8 E17</td>
<td>Interlocked inactive</td>
<td>8 E18</td>
<td>Interlocked active</td>
</tr>
<tr>
<td>8 E21</td>
<td>Selected inactive</td>
<td>8 E22</td>
<td>Selected active</td>
</tr>
<tr>
<td>8 E23</td>
<td>Interlocking bypass inactive</td>
<td>8 E24</td>
<td>Interlocking bypass active</td>
</tr>
<tr>
<td>8 E26</td>
<td>Select confirmation positive</td>
<td>8 E27</td>
<td>Select confirmation negative</td>
</tr>
<tr>
<td>8 E28</td>
<td>Execution confirmation positive</td>
<td>8 E29</td>
<td>Execution confirmation negative</td>
</tr>
<tr>
<td>8 E30</td>
<td>Execution termination positive</td>
<td>8 E31</td>
<td>Execution termination negative</td>
</tr>
</tbody>
</table>

Pins

Fig. 4.3.2.8.-7 Pins tab, function block Switching Object 2-2 H-Bridge
In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.2.9. **Switching Object 4-4 H-Bridge**

This switching object can only be used with the binary input output board with solid state relays. One switching object 2-2 H-Bridge or 4-4 H-Bridge can be used in the application per board.

**Function**

The function block Switching Object 4-4 H-Bridge is used to actuate four binary physical outputs, which are specially designed for the motor control unit. The required return confirmations are received via the five physical binary inputs. The function block itself assumes the subsequent sequential control.

The VALID signaling output signals a valid position of the 3-position switch:

- Earth switch closed
- Intermediate setting (earth switch and line open)
- Line opened.

The valid position is reached when the pulse outputs are logical 0 and the binary inputs signal is in one of the three positions above.

The binary input SUP/earth switch supervision enables sensors that also supervise the all-pole correct earthing to be connected. If this binary input is not used, the connection pin on the function block must be set to logical 1 or connected with the earth switch OFF connection pin.
Connections

IL inputs are interlocking inputs, one per represented output. A switching operation can be conducted if there is a logical 1 here.

BL input is a blocking input. If there is a logical 1 signal here, the switching operations of the represented output are blocked.

BO: Earth switch ON/OFF, BO: Line ON/OFF inputs (left) are signaling inputs for one physical output each. A logical signal to this function block input starts, if enabled, a corresponding switching operation of the represented output relay. The unlabelled inputs cannot be influenced; their function is implemented over the relay circuitry.

TIME> output is a time monitor output. If a logical 1 can be tapped here, the set impulse time is expired and a return confirmation regarding the correct switching operation is no longer received over the represented binary input.

RES. GRANT inputs are reservation grant inputs. A switching operation is only possible if the logical 1 signal is present at the input. This input is normally used in connection with LON communication per LAG 1.4 as confirmation of the reservation request.

BI: Earth switch ON/OFF, BI: Line ON/OFF outputs (right) are signal outputs at which the binary input signal of the represented physical input can be tapped.

PP RIGHT/PP LEFT outputs are pulse outputs, one per represented output. A logical 1 can be tapped for the duration of the switching operation of the output relay PP RIGHT is the pulse output for the busbar–intermediate setting–earth movement direction and PP LEFT is the pulse output for the earth–intermediate setting–busbar movement direction.

VALID output is a signaling output. If a logical 1 can be tapped here, the 3-position switch has reached a valid position.

SUP is a signaling output for a physical input. It is used for additional supervision of the position earth switch all-pole closed.

RES. REQ outputs are reservation request outputs, which are normally used in connection with LON communication per LAG 1.4. Before starting the switching operation, a reservation request must be done by generating a logical 1 signal at this output.
Table 4.3.2.9.-1  Connection labels switching object 4-4 H-Bridge

<table>
<thead>
<tr>
<th>FUPLA display</th>
<th>Parameter setting range of the configuration dialog box</th>
<th>Connection label in the configuration dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>BL</td>
<td>-</td>
<td>Block</td>
</tr>
<tr>
<td>IL</td>
<td>-</td>
<td>IL close Earth</td>
</tr>
<tr>
<td>IL</td>
<td>-</td>
<td>IL open earth</td>
</tr>
<tr>
<td>IL</td>
<td>-</td>
<td>IL close line</td>
</tr>
<tr>
<td>IL</td>
<td>-</td>
<td>IL open line</td>
</tr>
<tr>
<td>BO: Earthswitch ON</td>
<td>Earth close</td>
<td>Close earth</td>
</tr>
<tr>
<td>BO: Earthswitch OFF</td>
<td>Earth open</td>
<td>Open earth</td>
</tr>
<tr>
<td>BO: Line ON</td>
<td>Line close</td>
<td>Close line</td>
</tr>
<tr>
<td>BO: Line OFF</td>
<td>Line open</td>
<td>Open line</td>
</tr>
<tr>
<td>RES. GRANT</td>
<td>-</td>
<td>Reservation granted</td>
</tr>
<tr>
<td>PP right</td>
<td>-</td>
<td>PP right</td>
</tr>
<tr>
<td>PP left</td>
<td>-</td>
<td>PP left</td>
</tr>
<tr>
<td>RES. GRANT</td>
<td>-</td>
<td>Reservation granted</td>
</tr>
<tr>
<td>TIME &gt;</td>
<td>-</td>
<td>Timeout</td>
</tr>
<tr>
<td>VALID</td>
<td>-</td>
<td>Valid Position</td>
</tr>
<tr>
<td>BI: Earth switch ON</td>
<td>Earth closed</td>
<td>BI Earth closed</td>
</tr>
<tr>
<td>BI: Earth switch OFF</td>
<td>Earth opened</td>
<td>BI Earth opened</td>
</tr>
<tr>
<td>BI: Line ON</td>
<td>Line closed</td>
<td>BI Line opened</td>
</tr>
<tr>
<td>BI Line OFF</td>
<td>Line opened</td>
<td>BI line closed</td>
</tr>
<tr>
<td>SUP</td>
<td>Earth switch supervision</td>
<td>Earth supervision</td>
</tr>
<tr>
<td>RES. REQ</td>
<td>-</td>
<td>Reservation Request</td>
</tr>
</tbody>
</table>

**Typical application**

The Switching Object 4-4 H-Bridge function block enables a 3-position switch to be actuated with a motor drive. Additional auxiliary relays for activating and deactivating the motor are not required. Information on the switch status is received via three freely configurable binary inputs. The switching object assumes the subsequent control sequences:

- Checks the interlock conditions
- Switches on pole reversal relay, depending on selection
- Switches on motor relay
- Switches off motor relay after reaching the end position
- Brakes motor by short circuiting the motor windings
- Activates timing circuit for dead time

Switching Object 4-4 H-Bridge functions with special circuitry of two relays on the binary input/output board with conventional relays.

A 3-position isolator is represented by two separate objects (isolator and earth switch) on the HMI LCD, which are then configured as a combined object.
Configuration

The following section describes several tabs in the Switching Object 4-4 H-Bridge dialog box. In all tabs the OK and Cancel buttons are available.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

General

Field bus address

The Field bus address is automatically assigned so that every Field bus address is used only once. As an alternative the Field bus address can also be selected from the list, which is displayed by clicking the < ▼ > button.
Setting range: 5 ... 49 and 111 ... 127 (increment: 1)
Default: Next free Field bus address

Comment

Enter comments (for example purpose) on the switching object in the Comments text box. The text is also displayed in the FUPLA on the left side above the switching object.

Setting range: 0 ... 20 characters (standard character set)
Default: [Empty]

Options

Under Options select the option required for displaying the switching operation on the LCD:

Indicate intermediate position

If the Indicate intermediate position check box is selected, an intermediate setting is displayed on the LCD screen during the switching operation.

Enable two step command

If the Enable two step command check box is selected, the two-stage switching is activated and a switching object must be selected with a command from the station automation system and switched with a 2nd command. This option does not refer to local switching.

Invert inputs

If the Invert inputs check box is selected, the logical signal of the inputs is inverted.
Parameters

Fig. 4.3.2.9.-3 Parameters tab, function block Switching Object 4-4 H-Bridge

Brake Time

In the Brake Time text box enter a time in ms for which the motor windings are short-circuited to brake the motor after reaching the end position.

Setting range: 0 ... 65 000 ms (increment: 1 ms)
Default: 100

Waiting time

In the Waiting Time text box enter a time in ms during which no switching command can be sent to prevent overloading the transistors on the input/output board and the motor.

Setting range: 2 000 ... 65 000 ms (increment: 1 ms)
Default: 2 000

MaxTimeToGrant

In the MaxTimeToGrant text box enter a time in ms during which the reservation of the switching operation in connection with the LON Communication per LAG 1.4 is granted.
Outputs

*Fig. 4.3.2.9.-4 Outputs tab, function block Switching Object 4-4 H-Bridge*

**Earth close/open, Line close/open**

The number of the represented physical output is a fixed assignment.

Setting range: 0 ... [number of binary outputs] (increment: 1)
Default: 0

**No. of Cycles (once per represented output pair)**

Not used.

**Pulse Length (once per represented output pair)**

Enter the maximum duration of the output relay switching operation in the Pulse Length text box. In the function blocks with limit stops the switching operation ends before if necessary.
Inputs

Earth/Line closed/opened input (once per represented input)

Enter the number of the physical input that is to be represented. The assigned number, underlined in white, is also shown in the function block adjacent to the connection.

Setting range: 0 ... 42 [number of binary inputs] (increment: 1)
Default: 0

Filter time [ms] (once per represented output)

In the Filter time [ms] enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.
Inputs

Fig. 4.3.2.9.-6 Inputs tab, function block Switching Object 4-4 H-Bridge

Input

Enter a 0 (zero) as number of the represented input so that the earth switch supervision (SUP) binary input is not used.

Filter time [ms] (once per represented output)

In the Filter time [ms] enter the time during which a signal must be applied at the physical binary input to be detected as a logical signal. The input filter time is added to the hardware and to the general filter time.
Events

The main part in the Events tab is the list of events. The channel number over which the events are sent is shown in the left column near to the check box. To enable the individual events to be transmitted to the substation automation system, transmission of events must be generally enabled.

The events of the function block Power Factor Controller must also be enabled. Mark the adjacent check box so the event is generated and sent as required.

Set All

Click the Set All button to select, generate and send all events as required.

Clear All

Click the Clear All button to clear the selection.

Set Default

Click the Set Default button to use the default configuration for events. The default configuration for events for each function object is defined in the associated *.rce file.
**Save Default**

Click the **Save Default** button to save the checked events in the associated *.rce file.

**Event Masks E15 … E0 and E31 … E16**

The selecting of events is also possible under Event Masks. The input must be in hexadecimal code. Refer to the following table for the events E0 to E15. The input for the events from E16 to E31 is in principle similar. The events E28 to E31 are not used in this function block. If you select the check boxes in the list you can read the hexadecimal code in the text boxes.

The following Table 4.3.2.9.-2 shows an overview of the events of the function block Unbalanced Load Protection.

<table>
<thead>
<tr>
<th>Event</th>
<th>Text</th>
<th>Event</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>E0</td>
<td>Disc. Pos. Intermediate</td>
<td>E16</td>
<td>Blocked active</td>
</tr>
<tr>
<td>E1</td>
<td>Disc. Pos. Closed</td>
<td>E17</td>
<td>Disc. Interlocked inactive</td>
</tr>
<tr>
<td>E2</td>
<td>Disc. Pos. Opened</td>
<td>E18</td>
<td>Disc. Interlocked active</td>
</tr>
<tr>
<td>E3</td>
<td>not selectable</td>
<td>E19</td>
<td>Earth interlocked inactive</td>
</tr>
<tr>
<td>E4</td>
<td>Disc. Pos. Error</td>
<td>E20</td>
<td>Earth interlocked active</td>
</tr>
<tr>
<td>E5</td>
<td>Earth Pos. Intermediate</td>
<td>E21</td>
<td>Selected inactive</td>
</tr>
<tr>
<td>E6</td>
<td>Earth Pos. Closed</td>
<td>E22</td>
<td>Selected active</td>
</tr>
<tr>
<td>E7</td>
<td>Earth Pos. Opened</td>
<td>E23</td>
<td>Interlock bypass inactive</td>
</tr>
<tr>
<td>E8</td>
<td>Earth Pos. Error</td>
<td>E24</td>
<td>Interlock bypass active</td>
</tr>
<tr>
<td>E9</td>
<td>Command timeout inactive</td>
<td>E25</td>
<td>not selectable</td>
</tr>
<tr>
<td>E10</td>
<td>Command timeout active</td>
<td>E26</td>
<td>Select confirmation positive</td>
</tr>
<tr>
<td>E11</td>
<td>not selectable</td>
<td>E27</td>
<td>Select confirmation negative</td>
</tr>
<tr>
<td>E12</td>
<td>not selectable</td>
<td>E28</td>
<td>Execution confirmation positive</td>
</tr>
<tr>
<td>E13</td>
<td>Interlocking error left</td>
<td>E29</td>
<td>Execution confirmation negative</td>
</tr>
<tr>
<td>E14</td>
<td>Interlocking error right</td>
<td>E30</td>
<td>Execution termination positive</td>
</tr>
<tr>
<td>E15</td>
<td>Blocked inactive</td>
<td>E31</td>
<td>Execution termination negative</td>
</tr>
</tbody>
</table>
Pins

In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.2.10. Module for truck (withdrawal unit)

Function

The Module for truck function block is used to move or hide switch symbols on the LCD. Fixed symbols (transducers, motors, generators and so on) cannot be hidden or moved because they do not have a unique Field bus address.

The switch symbol interconnections on the LCD screen with the switching objects in the function chart are shown with the Field bus address. In the same way, the function block module for thrust is linked to the switching symbol that is to be moved or hidden with the Field bus address.
Connections

If the Jump (move) input is set to logical 1, a symbol on the LCD is moved 11 pixels to the left. If the input is set to logical 0 again, the symbol on the LCD resumes its initial position.

If the Disapp. input is set to logical 1 again, the symbol on the LCD is hidden. If the input is set to logical 0 again, the symbol on the LCD becomes visible again.

Typical application

If the power circuit-breaker is on a trolley (thrust), it must also be possible to show its end positions on the LCD. The power circuit breaker symbol must be correctly displayed depending on the current position of the thrust (operating or test position).

In addition, if the power circuit-breaker is no longer connected with the other secondary technology, this status must be shown on the LCD. For example, this occurs when the symbol is hidden.

Configuration

Field bus address

Click the < button to open a list of the Field bus addresses used in the function chart. Select the Field bus address of the switching object whose symbol is to be moved on the LCD screen.

Jump/Disappear

The connections of the function block with the connection number connected to it are shown here. Inputs are not possible. If there are yet no connections on the function block, connection number 1 is displayed. It indicates an input.
OK

Click **OK** to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

4.3.2.11. IO-Supervision

The IO-Supervision function block provides messages from the trip circuit supervision to the function chart. The REF 542plus Global Settings referring to trip circuit supervision and the FUPLA are linked in this way. The single messages can be blocked independently of one another. In addition, the entire function block can be blocked; a signal regarding that can be tapped at one of its outputs. The error messages from the trip circuit supervision cannot be suppressed on the LCD screen.

Up to two output channels can be monitored for the first two binary input/output boards (cards). The trip circuit supervision must be activated in the Global Settings of the configuration software for every channel.

Connections

Because the labeling of the inputs and outputs is partly abbreviated in the function block and in the configuration dialog box, the list below explains the abbreviation further if necessary.
<table>
<thead>
<tr>
<th>Input/Output</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCS11/BI.Ca.1 Co.1 input</td>
<td>Blocking Coil Supervision 11/blocking board 1 coil 1</td>
<td>If a logical 1 is set on this channel, the output signal is blocked and the supervision function of this coil is generated.</td>
</tr>
<tr>
<td>BCS12/BI.Ca.1 Co.2 input</td>
<td>Blocking Coil Supervision 12/blocking board 1 coil 2</td>
<td>If a logical 1 is set on this channel, the output signal is blocked and the supervision function of this coil is generated.</td>
</tr>
<tr>
<td>BCS21/BI.Ca.2 Co.1 input</td>
<td>Blocking Coil Supervision 21/blocking board 2 coil 1</td>
<td>If a logical 1 is set on this channel, the output signal is blocked and the supervision function of this coil is generated.</td>
</tr>
<tr>
<td>BCS22/BI.Ca.2 Co.2 input</td>
<td>Blocking Coil Supervision 22/blocking board 2 coil 2</td>
<td>If a logical 1 is set on this channel, the output signal is blocked and the supervision function of this coil is generated.</td>
</tr>
<tr>
<td>BCS31/BI.Ca.3 Co.1 input</td>
<td>Blocking Coil Supervision 31/blocking board 3 coil 1</td>
<td>If a logical 1 is set on this channel, the output signal is blocked and the supervision function of this coil is generated.</td>
</tr>
<tr>
<td>BCS32/BI.Ca.3 Co.2 input</td>
<td>Blocking Coil Supervision 32/blocking board 3 coil 2</td>
<td>If a logical 1 is set on this channel, the output signal is blocked and the supervision function of this coil is generated.</td>
</tr>
<tr>
<td>B.A.S./BI. active superv. input</td>
<td>Blocking Active Supervision/blocking input switch supervision</td>
<td>If a logical 1 is applied to this connection, switch supervision is deactivated.</td>
</tr>
<tr>
<td>Coil supervision Card1 Coil1/St. Ca.1 Co.1 output</td>
<td>Start board 1 coil 1</td>
<td>If a logical 1 can be tapped at this output, the trip circuit supervision for the corresponding coil has detected an error.</td>
</tr>
<tr>
<td>Coil supervision Card1 Coil2/St. Ca.1 Co.2 output</td>
<td>Start board 1 coil 2</td>
<td>If a logical 1 can be tapped at this output, the trip circuit supervision for the corresponding coil has detected an error.</td>
</tr>
<tr>
<td>Coil supervision Card2 Coil1/St. Ca.2 Co.1 output</td>
<td>Start board 2 coil 1</td>
<td>If a logical 1 can be tapped at this output, the trip circuit supervision for the corresponding coil has detected an error.</td>
</tr>
<tr>
<td>Coil supervision Card1 Coil2/St. Ca.2 Co.2 output</td>
<td>Start board 2 coil 2</td>
<td>If a logical 1 can be tapped at this output, the trip circuit supervision for the corresponding coil has detected an error.</td>
</tr>
<tr>
<td>Coil supervision Card3 Coil1/St. Ca.3 Co.1 output</td>
<td>Start board 3 coil 1</td>
<td>If a logical 1 can be tapped at this output, the trip circuit supervision for the corresponding coil has detected an error.</td>
</tr>
<tr>
<td>Coil supervision Card3 Coil2/St. Ca.3 Co.2 output</td>
<td>Start board 3 coil 2</td>
<td>If a logical 1 can be tapped at this output, the trip circuit supervision for the corresponding coil has detected an error.</td>
</tr>
<tr>
<td>Active Supervision/St. active superv. output</td>
<td>Start switch supervision</td>
<td>If a logical 1 can be tapped at this output, the switch supervision is operating. If a logical 0 can be tapped, the switch supervision is not active because it has been blocked via the B.A.S. input.</td>
</tr>
</tbody>
</table>
Typical application

The trip-circuit supervision can be used to detect defective trip solenoids on the power circuit-breaker. For example, the return confirmation over the function block trip-circuit supervision can be used to generate an event for a station control system. Interlocking of the power circuit-breaker is also possible.

Configuration

Only the function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible. The names of the connections in the configuration dialog box are German and in the FUPLA display English. Both labels can be found in the connection description.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.3. Digital logic 1

The following sections describe the function blocks that are available in Drawing Menu > Insert > Digital Logic 1.

4.3.3.1. Inverter

The Inverter function block inverts the input signal and sends it to its output.

<table>
<thead>
<tr>
<th>Table 4.3.3.1.-1</th>
<th>Logic table</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

Function

The Inverter function block inverts the input signal and sends it to its output.

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.
The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.3.2. Constant 1/Constant 0

Function

The two function blocks continuously send a logical 0 and a logical 1 respectively to their outputs.

<table>
<thead>
<tr>
<th>Table 4.3.3.2.-1</th>
<th>Logic table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant 0 Output</td>
<td>Constant 1 Output</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.3.3. AND logic gate with inverting output

Function

The AND logic gate inverts the output signal. Otherwise, the function is identical to the standard AND logic gate.
Table 4.3.3.3.-1 Logic table

<table>
<thead>
<tr>
<th>On 1</th>
<th>On 2</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.3.4.

AND logic gate with an inverting input

![Function blocks AND logic gate with an inverting input]

Function

AND logic gates have all an inverting input. Because only the inverted input is changed, only one function block is described here.

Table 4.3.3.4.-1 Logic table

<table>
<thead>
<tr>
<th>On 1</th>
<th>On 2</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.
4.3.3.5.  AND logic gate

Function

The AND logic gates execute a logical AND interconnection on their inputs (left on the function block). The result of this logical operation is available on the output (right on the function block). Therefore a logical 1 is displayed on the output when all inputs are set to logical 1.

The AND logic gates above differ only in the number of inputs.

<table>
<thead>
<tr>
<th>Table 4.3.3.5.-1 Logic table</th>
</tr>
</thead>
<tbody>
<tr>
<td>On 1</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

The logic Table 4.3.3.5.-1 shows as an example the function of the AND logic gate with two inputs.

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.
4.3.3.6. OR logic gate

Function

The OR logic gates execute a logical OR interconnection of their inputs (left on the function block). The result of this logical operation is available on the output (right on the function block).

Therefore a logical 1 is displayed on the output when one of the inputs is set to logical 1.

The OR logic gates above differ only in the number of inputs.

Logic table

The following logic Table 4.3.3.6.-1 shows as an example the function of the OR logic gate with two inputs.

<table>
<thead>
<tr>
<th>On 1</th>
<th>On 2</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.
4.3.3.7. OR logic gate with inverting output

Function

This OR logic gate inverts the output signal. Otherwise, the function is identical to the standard OR logic gate.

Table 4.3.3.7.-1 OR logic gate with inverting output

<table>
<thead>
<tr>
<th>On 1</th>
<th>On 2</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.4. Digital logic 2

The following sections describe the function blocks that are available in Drawing Menu/Insert/Digital Logic 2.
4.3.4.1. **Exclusive OR logic gate**

![Fig. 4.3.4.1.-1](image)

*Fig. 4.3.4.1.-1 Function block exclusive OR logic gate with varying input number*

**Function**

The exclusive OR logic gates execute a logical exclusive OR interconnection of their inputs (left on the function block). The result of this logical operation is available at the output (right on the function block).

Therefore a logical 1 is displayed at the output when at least one of the inputs is set to logical 1. In contrast to the OR logic gate, a logical 0 is displayed on the output if all inputs are set to logical 1. The exclusive OR logic gates shown in Fig. differ only in the number of inputs.

**Logic table**

The following logic Table 4.3.4.1.-1 shows as an example the function of the exclusive OR logic gate with two inputs.

<table>
<thead>
<tr>
<th>On 1</th>
<th>On 2</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

**Configuration**

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the **OK** button.
4.3.4.2. Exclusive OR logic gates with inverting output

Function

The exclusive OR logic gates with inverting output execute a logical exclusive OR interconnection of their inputs (left on the function block). The result of this logical operation is available in inverted form at the output (right on the function block).

Therefore, a logical 1 is displayed at the output if all inputs are set to logical 0 or logical 1. In contrast to OR logic gates with inverting output, a logical 1 is displayed at the output if all inputs are set to logical 1.

Logic table

The following logic table 4.3.4.2.-1 shows as an example the function of the exclusive OR logic gate with two inputs.

<table>
<thead>
<tr>
<th>On 1</th>
<th>On 2</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.5. Flip-Flops

The following sections describe the function blocks that are available in Drawing Menu > Insert > Flip-Flops.
Flip-Flops are memory elements with two stable states. Switching between the states is referred to as toggling. A suitable actuation (depending on the type of flip-flop) switches it to the other state. Because this state remains effective at the outputs of the flip-flop if there are no input signals, they are referred to as memory elements. Some flip-flops are also actuated by a timing input.

To enable the time sequence to be taken into account in the logic tables as well, a time before toggling the flip-flop (t_n) and a time after toggling (t_{n+1}) are defined. Therefore, output signals before toggling are labeled Q_n and Q_{n+1} after toggling.

If the flip-flop has also a timing input, the state before the timing input is labeled index n and the state after the timing input as index n+1. The change of state at the timing input from logical 0 to logical 1 or vice versa is decisive for the switching process. It is referred to as the rising or falling slope.

4.3.5.1. R-S Flip-Flop

![R-S Flip-Flop Diagram]

**Function**

A logical 1 at the S-input results in a logical 1 at the Q-output. A logical 1 at the R-input results in a logical 0 at the Q-output.

If the input signals are reset to logical 0, the signals remain active at the outputs. If both inputs are at logical 1, the R-input is dominant. However, this state contradicts the basic flip-flop principle of two stable states and must therefore be avoided.
Logic table

Q\textsubscript{inverted} is not included in the following Table 4.3.5.1.-1 because the state is always opposite to Q.

<table>
<thead>
<tr>
<th>R</th>
<th>S</th>
<th>Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Qn</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.5.2.

R-S Flip-Flop with timing input (clock)

Function

A logical 1 at the S-input combined with a rising slope at the timing input (C) results in a logical 1 at the Q-output. A logical 1 at the R-input combined with a rising slope at the timing input (C) results in a logical 0 at the Q-output.

If the input signals are reset to logical 0, the signals on the outputs remain active if there is no longer a rising slope at the timing input. With the rising slope the signals at the inputs are input.

If both inputs are at logical 1, both outputs are at logical 1 with the rising slope at the timing input. However, this state contradicts the basic flip-flop principle of two stable states and therefore must be avoided.
Logic table

Q\textsubscript{inverted} is not included in the following Table 4.3.5.2.-1 because the state is always set opposite to Q.

\( t_n \) is the time before the rising slope at the timing input

\( t_{n+1} \) is the time after it.

<table>
<thead>
<tr>
<th>( t_n )</th>
<th>( t_{n+1} )</th>
<th>( R )</th>
<th>( S )</th>
<th>( Q )</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td>Qn</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td></td>
<td>Illegal state</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.5.3. J-K Flip-Flop

Function

A logical 1 at the J-input (logical 0 at the K-input) combined with a falling slope at the timing input (C) results in a logical 1 at the Q-output. A logical 1 at the K-input (logical 0 at the J-input) combined with a falling slope at the timing input (C) results in a logical 0 at the Q-output.

If the input signals are reset to logical 0, the signals remain active at the outputs regardless of the timing input.

If both inputs are at logical 1, the signals on the two outputs with the falling slope are inverted at the timing input.
Logic table

$Q_{\text{inverted}}$ is not included in the following Table 4.3.5.3.-1 because the state is always set opposite to $Q$.

t$_n$ is the time before the falling slope at the timing input.

t$_{n+1}$ is the time after it.

<table>
<thead>
<tr>
<th>tn</th>
<th>tn+1</th>
<th>J</th>
<th>K</th>
<th>Q</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0</td>
<td>0</td>
<td>$Q_n$</td>
<td>The prior state remains</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td>$Q_n$</td>
<td>The prior state is inverted</td>
</tr>
</tbody>
</table>

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.5.4. D Flip-Flop

The signal at the D-input of the flip-flop is transferred with the next positive slope of the $Q$-output. The timing pulses (clock) cause a delayed output of the input signal on the output.
Logic table

<table>
<thead>
<tr>
<th>tn</th>
<th>tn+1</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Q</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Q_{inverted} is not included in the following table because the state is always set opposite to Q.

$t_n$ is the time before the rising slope at the timing input and $t_{n+1}$ is the time after it.

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.5.5. T Flip-Flop

Function

The signals at the outputs are inverted with the positive slope at the timing input T. Q is logical 0 as the output state, to ensure that there is a defined state during the REF 542plus starting procedure. The signal at the output is always opposite to the signal at the output Q.

This enables the T flip-flop to operate as a binary divider; the period duration of the signals at the outputs is double the length of the clock at the T-input. A constant frequency clock signal is required.
Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.5.6. Monoflop retriggerable

<table>
<thead>
<tr>
<th>165</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
</tr>
<tr>
<td>RES</td>
</tr>
<tr>
<td>Time [ms] 15</td>
</tr>
</tbody>
</table>

*Fig. 4.3.5.6.-1  Function block Monoflop retriggerable*

Function

The logical value at the D-input is directly incorporated (in practice with its own rising slope) on the Q-output. It remains there for the configurable time. Finally, the output falls back to the only stable state of logical 0 again. The Q-output is set immediately to logical 0 by a logical 1 on the reset input (RES or K). If a rising slope occurs at the D-input again while the output is also still at logical 1, the timing circuit is restarted.

The signal at the inverted is always opposite to the signal at the output Q.

Configuration

Time [ms]

Enter the time in ms in the Time text box for which the output signal should be kept after a rising slope of the input signal.

Setting range: 15 … 65 000 ms (increment: 1 ms)
Default: 15

Pins

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.
OK

Click **OK** to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

4.3.5.7. **Monoflop non-retriggerable**

![Function block Monoflop non-retriggerable](image)

**Function**

The logical value at the D-input is directly incorporated (in practice with its own rising slope) on to the Q-output. It remains there for the configurable time. Finally, the output falls back to the only stable state of logical 0 again. The Q-output is set immediately to logical 0 by a logical 1 on the reset input (RES or K). If a rising slope occurs at the D-input again while the output is also still at logical 1, this signal is ignored.

The signal at the inverted is always opposite to the signal at the output Q.

**Configuration**

**Time [ms]**

Enter the time in ms in the Time text box for which the output signal should be kept after a rising slope of the input signal.
Setting range: 15 ... 65 000 ms (increment: 1 ms)
Default: 15

Pins

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

OK

Click **OK** to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

### 4.3.5.8. Drop Delay/Rise Delay (slope delay)

![Slope Delay Diagram]

*Fig. 4.3.5.8.-1  Function blocks slope delay: rising and falling*

**Function**

Drop Delay and Rise Delay function blocks delay the falling and rising slope of a logical signal at the input (left connection).

The delayed logical signal is then available at the output (right connection). The delay period can be input in the configuration dialog box.

The following Fig. 4.3.5.8.-2 shows how the two function blocks operate.
Fig. 4.3.5.8.-2  Flow chart of the slope delay function blocks

Configuration dialog box

![Configuration dialog box](image)

Fig. 4.3.5.8.-3  Configuration dialog box slope delay rising (and falling)

The setting options are identical in both configuration dialog boxes. Only the name of the function block in the window’s title bar is different.

**Time [ms]**

Enter the delay period in ms in the Time [ms] text box. The rising/falling slope of the output signal is delayed for this period relative to the input signal. The input period is also shown in the function chart below the FUPLA symbol.
Setting range: 15 … 65 000 ms (increment: 1 ms)
Default: 15

Pins

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

OK

Click **OK** to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

4.3.5.9. Counter

![Function block Counter](image)

**Number:** 0

*Fig. 4.3.5.9.-1  Function block Counter*

**Function**

The function block Counter puts a logical 1 on its output (right on the function block) after a preset No. of cycles have been sent to its CLOCK input (timing input, left on the function block). The output is set with the rising slope of the last required input impulse.

If a logical 1 is set to the RESET input (left on the function block), the output is reset to logical 0 or the counting process is stopped and the internal counter is set to 0.
Configuration dialog box

Fig. 4.3.5.9.-2 Configuration dialog box Counter

Number

Enter the number of input impulses required to generate a logical 1 at the output of the function block (right on the FUPLA symbol). The rising slopes of the input signal are decisive for the function block. The number is also shown in the function chart below the FUPLA symbol.

Setting range: 0 … 65 000 ms (increment: 1 ms)
Default: 0

Pins

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
4.3.5.10. Pulse generator

**Function**

The function block Pulse generator sends a pulse sequence at its output (right on the function block). Logical 1 and logical 0 values alternate in this process. Their duration can be set in the configuration dialog box.

The following Fig. 4.3.5.10.-2 shows the setting options for the pulse generator.

```
Fig. 4.3.5.10.-1 Function block Pulse generator
```

```
Fig. 4.3.5.10.-2 Output signal of the Pulse generator
```

**Output (right on the function block)**

The generated pulse sequence can be tapped here.
Configuration

High Time [ms]
The duration in ms of the logical 1 impulse ($t_{ON}$) is entered in the High Time [ms] text box. The input period is also visible in the FUPLA below the function block.

Setting range: 15 ... 65 000 ms (increment: 1 ms)
Default: 15

Low time [ms]
The duration in ms of the logical 0 impulse ($t_{OFF}$) is entered in the Low Time [ms] text box. The input period is also visible in the FUPLA below the function block.

Setting range: 15 ... 65 000 ms (increment: 1 ms)
Default: 15

Pins
Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

OK
Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel
When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
4.3.5.11. Digital Store object

**Function**

The digital store object continuously saves the current digital values at its input. If the auxiliary supply voltage fails, the last saved values are kept. In this event they are available at the appropriate outputs after REF 542plus has restarted. If the reset or RESET input is at logical 1, the output signals are set to logical 0.

**Typical application**

The signals that, for example, have generated a switching authorization, are kept in this way after a power failure. Otherwise the switching authorization would be lost, because all outputs and inputs on the REF 542plus take a defined state.

**Configuration**

The connections of the function block are shown in the configuration dialog box with the connection numbers to which they are connected. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the **OK** button.
4.3.6. Analog Objects

The following sections contain the descriptions of the function blocks that are available in Drawing Menu > Insert > Analog Objects.

4.3.6.1. Analog Threshold

![Function block Analog Threshold](image)

**Function**

Each of the eight analog measuring inputs can be monitored to detect if it falls below or exceeds a threshold value. If the measured value falls below or exceeds the configurable trip threshold (threshold value), the supervision function is activated. If the trip threshold exceeds or is below the threshold after a configurable period, a trip signal is generated. The trip threshold and the period for exceeding or falling below the measured value can be configured separately.

**Connections**

- **B> input:** If there is a logical 1 at this input, the trip signal for signaling that the threshold value has been exceeded is suppressed.
- **B< input:** If there is a logical 1 at this input, the trip signal for signaling that the threshold value has not been reached is suppressed.
- **S> output:** The starting signal (logical 1) can be tapped here if the threshold value has been exceeded.
- **S< output:** The starting signal (logical 1) can be tapped here if the threshold value has not been reached.
- **> output:** The trip signal (logical 1) can be tapped here if the threshold value has been exceeded.
- **< output:** The trip signal (logical 1) can be tapped here if the threshold value has not been reached.
- **Valid output:** A logical 1 is set whenever the chosen analog signal is valid.
- **Not Valid output:** A logical 1 is set whenever the chosen analog signal is not valid.
Typical application

The threshold values can be used to ascertain that a bay has no voltage. It is recommended to generate various interlock conditions with this signal. Please observe the restrictions regarding the threshold object:

- Maximum of 10 threshold objects per analog measuring input (= 80 per configuration)
- Minimum reaction time around 50 to 100 ms
- The threshold objects cannot select a direct switching output

Configuration

OK

Click **OK** to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

General

This is automatically assigned but can also be changed in the adjacent set limits. All (max. 10) threshold objects that refer to a measuring input have the same Field bus address. The Field bus address is used for addressing the function block in the event of field bus commands. It is also shown in the function chart below the function block.
**Number**

The sequential number of the threshold object is entered in the *Number* drop-down menu. It is also shown in the function chart below the function block. It is also used to distinguish a maximum of 10 threshold objects per analog measuring input.

**Analog inputs**

The measuring input that is to be monitored by the threshold object can be selected from the *Analog Inputs* drop-down menu.

- **Setting range:** All configured analog signals
- **Default:** None

**TR >**

The trip threshold for exceeding the threshold is entered in the TR> text box in multiples of the rated voltage or of the rated current.

- **Setting range:** 0.1 … 10 (increment: 0.01)
- **Default:** 1.00

**Time (under TR>)**

Enter the time in seconds in the Time text box for which the measured value must exceed the threshold value before a trip signal is generated.

- **Setting range:** 0.5 … 300 s (increment 0.01 s)
- **Default:** 1.00

**TR<**

The trip threshold for falling below the threshold is entered in the TR< text box in multiples of the rated voltage or of the rated current.

- **Setting range:** 0.1 … 10 (increment: 0.01)
- **Default:** 1.00

**Time (under TR<)**

Enter the time in seconds in the Time text box for which the measured value must fall below the threshold value before a trip signal is generated.
Setting range: 0.5 ... 300 s (increment 0.01 s)
Default: 1.00

Pins

In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.6.2. Measurement supervision NPS and PPS

REF 542plus provides two types of measurement supervision functions. Each of them can be independently activated:

- Positive Phase Sequence (PPS)
- Negative Phase Sequence (NPS)
Input/output description

Table 4.3.6.2.-1 Input

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BS</td>
<td>Digital signal (active high)</td>
<td>Blocking signal</td>
</tr>
</tbody>
</table>

When the BS signal becomes active, the measurement supervision function is reset no matter its state. This means that all the output pins go low generating the required events (if any), and all the internal registers and timers are cleared. The protection function will then remain in idle state until the BS signal goes low.

Table 4.3.6.2.-2 Output

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>Digital signal (active high)</td>
<td>Warning signal</td>
</tr>
<tr>
<td>Failing</td>
<td>Digital signal (active high)</td>
<td>Failing signal</td>
</tr>
</tbody>
</table>

Warning is the start signal. Warning signal will be activated when the start conditions are true. The negative phase sequence value exceeds the setting threshold value for NPS, and the positive phase sequence value falls below the setting threshold value for PPS.

Failing signal will be activated when the start conditions are true and the operating time has elapsed.

Configuration

![Configuration](image)

Fig. 4.3.6.2.-2 General
Fig. 4.3.6.2.-3 Sensors

The measurement supervision functions operate on all sensors in a triple. The analog channels 1-3 or 4-6 can be used to supervise the phase currents, phase voltages or line voltages.

Fig. 4.3.6.2.-4 Parameters
Start Value: Positive/Negative phase sequence threshold for Start condition detection.

Time: Time delay for Trip condition detection.

Fig. 4.3.6.2.-5 Events

Fig. 4.3.6.2.-6 Pins
Measurement mode

Measurement supervision functions evaluate the measured amount of positive and negative phase sequence values at the fundamental frequency.

Operation criteria

If the negative phase sequence value exceeds the setting threshold value (Start value) in the NPS based functions, or if the positive phase sequence value falls below the setting threshold (Start value) the function enters the START status and raises the warning. After the preset operating time (Time delay) has elapsed, the failing signal is generated.

The measurement function will come back in passive status and the warning signal will be cleared, if the negative phase sequence value falls below 0.95 the setting threshold value for NPS, or if the positive phase sequence value exceed 1.05 the setting threshold value for PPS.

The measurement function will exit the failing status and the failing signal will be cleared when the negative phase sequence value falls below 0.4 the setting threshold value for NPS, or if the positive phase sequence value exceed 1.05 the setting threshold value for PPS.

Setting groups

Two parameter sets can be configured for each of the measurement supervision functions.

Parameters and events

Table 4.3.6.2.-3 Setting values

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Unit</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start value (PPS)</td>
<td>0.30 ... 0.90</td>
<td>In or Un</td>
<td>0.85</td>
<td>PPS threshold to undergo.</td>
</tr>
<tr>
<td>Time delay</td>
<td>30 ... 30000</td>
<td>ms</td>
<td>1000</td>
<td>Time delay from start condition (warning signal) to failing signal.</td>
</tr>
<tr>
<td>Start value (NPS)</td>
<td>0.05 ... 0.40</td>
<td>In or Un</td>
<td>0.10</td>
<td>NPS threshold to be exceeded.</td>
</tr>
<tr>
<td>Time delay</td>
<td>30 ... 30000</td>
<td>ms</td>
<td>1000</td>
<td>Time delay from start condition to failing signal.</td>
</tr>
</tbody>
</table>
### Table 4.3.6.2.-4: Events

<table>
<thead>
<tr>
<th>Code</th>
<th>Event reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>E0</td>
<td>Warning signal is active</td>
</tr>
<tr>
<td>E1</td>
<td>Warning signal cancelled</td>
</tr>
<tr>
<td>E6</td>
<td>Failing signal is active</td>
</tr>
<tr>
<td>E7</td>
<td>Failing signal is back to inactive state</td>
</tr>
<tr>
<td>E18</td>
<td>Function block signal is active</td>
</tr>
<tr>
<td>E19</td>
<td>Function block signal is back to inactive state</td>
</tr>
</tbody>
</table>

**4.3.6.3. Analog Input 20mA object**

Up to 48 Analog Input 20mA objects (instances) can be used. Each object can be assigned to one of the six Analog Inputs 20mA of the REF 542plus. Depending on the state of the measured value of the dedicated sensor, the analog input 20mA object generates a valid/not valid signal. If the measured value of the dedicated sensor exceeds or falls below the configured threshold, a warning signal is generated.

#### Function

The threshold supervision of the Analog Input 20mA objects can, for example, be used for supervision of gas density or temperature. Several thresholds can be assigned to each sensor.

#### Typical application

Connections

Valid output: The valid signal (logical 1) can be tapped here if the dedicated sensor is working properly.

Not valid output: The not valid signal (logical 1) can be tapped here if the dedicated sensor is not working properly.
Warning output: The warning signal (logical 1) can be tapped here.

**Configuration**

Start with the General tab

![Configuration dialog Analog Input 20mA object, tab “general”](image)

The **Instance number** selection list: Select the desired instance number. It is displayed under the FUPLA block through the string “Nr.:x”, where x is the instance number. The selection list includes the numbers from 1 to 48 excluding the already used ones.

The **Name** input field: Name of the warning that shall be displayed on the RHMI. Max. number of characters: 20.

The **Sensor number** selection list. This list shows all configured sensors. Select a sensor number to assign the Analog Input 20mA object to this sensor. Whenever the sensor number is changed, all parameters will be set to their default values.

The Parameters configuration.
The **Direction** selection list: The default-direction is **Up**. This means that the warning signal is active when the measured value of the dedicated sensor exceeds the configured threshold. The direction **Down** has to be selected when the warning signal is active or should be active, that is, when the measured value falls below the configured threshold.

The **Threshold** input field: The desired threshold-level can be entered here. If the measured value of the dedicated sensor exceeds or falls below (according to the configured direction) this threshold, the warning signal is activated.

The **Hysteresis** input field: The desired hysteresis can be entered here. See Fig. 4.3.6.3.-4 and Fig. 4.3.6.3.-5 to view how the hysteresis works depending on configured direction.

![Configuration dialog Analog Input 20mA object, tab “Parameters”](image)

**Fig. 4.3.6.3.-3**  
Configuration dialog Analog Input 20mA object, tab “Parameters”

![Hysteresis (Direction: Down)](image)

**Fig. 4.3.6.3.-4**  
Hysteresis (Direction: Down)
The Debounce time input field: The width of the debounce time window for debouncing the warning can be entered here.

Setting range: 0..100ms (increment: 1ms)

The Override value selection list: The override value overrides the state of the Warning output in case that the state of the dedicated sensor is invalid. The override-value can be Inactive or Active. Default: Inactive.

The Apply button: All settings are saved in the configuration software.

The OK button: All settings are saved in the configuration software. The dialog window is closed.

The Cancel button: Settings are not saved in the configuration software. The dialog window is closed.

Information about pins:
4.3.6.4. Energy management

**Function**

The Energy management function block is used to influence the internal energy calculations in REF 542plus. On one hand the count process can be stopped and on the other hand a return block can be activated. In this case the energy is not counted backwards if the energy direction changes.

Depending on the hardware configuration the power is calculated from the current and voltage values at the analog inputs. The internal REF 542plus time clock is then used to calculate the energy. The energy values can be displayed on the LCD.

The internal energy calculation functions only with configured power calculation.
Connections

COUNT/no count input: The count process is stopped if there is a logical 1 at this input.

BACK/no back input: If there is a logical 1 at this input, backwards counting is suppressed if the energy direction changes.

Typical application

The energy count provides an overview of the generated/consumed bay-specific energy.

Configuration

The function block connections with the connection numbers attached to them are displayed in the configuration dialog box. Inputs are not possible.

The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made. These inputs are then confirmed with the OK button.

4.3.6.5. Energy Counter

default Nr. 1
165

Function

The Energy Counter function block uses impulses to meter energy. Every impulse is assigned to a configurable energy value. The energy metered here is then displayed in the measured value display on the LCD of the REF 542plus HMI control unit.

Typical application

The Energy Counter function block is used if there is an energy measuring instrument in the bay that is being configured. Its impulses can be sent to the energy counter in the function chart over a binary input.
Configuration

Field bus address

The permanently assigned Field bus address is displayed here. All energy counters have the same address.

Number

Enter a number to distinguish several configured energy counters. The number is also shown in the function chart above the function block.

Setting range: 1 ... 15 (increment: 1)
Default: The next free energy counter number

Multiplication factor

The energy in kWh that represents an incoming impulse is entered in the Multiplication factor text box. The multiplier is shown in the function chart in the function block.

Setting range: 0.1 ... 1000 (increment: 0.1)
Default: 100

Display text (LCU)

Enter text in the Display text (LCU) that is to be displayed on the LCD to enable several energy counters to be distinguished more easily.
4.3.6.6. Energy Pulse Output

Function

The Energy Pulse Output function block sends pulses that represent a specific energy quantity to its output (energy). The pulses are generated based on the internal energy calculations of REF 542plus.

The DSP calculates the energy and sends standardized energy packets to the microcontroller. This receives a number of standardized energy packets about twice a second and calculates the absolute energy amount from them.

The energy amount is then converted to the corresponding No. of cycles. If there is a remainder after the conversion into pulses, it is included in the next conversion.

The energy pulse output can send up to 70 pulses after a calculation. Additional pulses are ignored and the overflow output is then set to logical 1. If the number of calculated pulses is reduced below 65 again, the overflow output is reset to logical 0.
To add the Energy Pulse Output function block, the power calculation must be activated.

Use the Energy Pulse Output function block only with binary input/output boards with solid state relays. The conventional relays are limited in their number of switching cycles and therefore are not suited for this.

**Typical application**

Use the Energy Pulse Output function block to control an external energy display with the pulses from REF 542plus.

**Example:**

Application in a system with rated voltage Ur 11 kV and rated current Ir 300A. Under a rated load condition with cos phi = 0.9 and CT rated current 300A, the active power is $\sqrt{3} \times 11 \text{ kV} \times 300 \text{ A} \times 0.9 = 5144 \text{ kW}$. The energy portion per second is $5144 \text{ kW} \times 1 \text{ h} / 3600 \text{ sec} = 1.43 \text{ kWh}$. In case that the setting parameter Pulse per kWh = 0.7 is selected, the value of 1 Pulse is equal to 1 kWh / 0.7 = 1.43 kWh. As a consequence, a pulse is generated every second at the ENERGY output. If the value of the setting parameter is enlarge, for example from 0.7 to 2.1, which means that the value of 1 Pulse is equal to 0.43 kWh, three pulses are generated each second.

**Configuration**

![Configuration dialog box Energy Pulse Output](image)

Fig. 4.3.6.6.-2  Configuration dialog box Energy Pulse Output
Energy
Select here whether the pulse should represent Active or Reactive energy.

Energy Flow
Select the direction of the energy flow. Only energy of this direction is converted to the corresponding pulse.

Pins
Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

Pulse per kWh
Enter the calculated energy amount that an pulse represents in kWh.

Setting range: 0.1 … 1000 (increment: 0.1)
Default: 1.0

Pulse Lenght
The duration of the output pulse in ms can be varied in the Pulse Length text box to ensure that the external energy display functions correctly.

Setting range: 50 … 150 ms (increment: 1 ms)
Default: 150

OK
Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel
When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
4.3.6.7. **Power Factor Controller**

![Function block Power Factor Controller](image)

**Connections**

BL (Blocking) input: A logical 1 signal at this input suppresses the power factor controller functions.

Disconnect input: A logical 1 signal at this input switches off all active capacitor banks.

Reset input: A logical 1 signal at this input resets the General Alarm. If this alarm status is not reset, the control function remains blocked.

Overtemp. input: A logical 1 signal at this input generates a General Alarm message and immediately switches off all capacitor banks.

V MIN/MAX input: A logical 1 signal at this input generates a General Alarm message and immediately switches off all capacitor banks.

V A MAX input: A logical 1 signal at this input results in a General Alarm message.

Mode: Man. input: A logical 1 signal on this input changes switches the operating mode of the Power Factor Controller from automatic to manual.

Set Night input: A logical 1 signal on this input switches the parameter setting from day to night.

Manual Control Bank 0 ... 3 input (once per capacitor bank): A logical 1 signal on this input results in capacitor bank C0 ... capacitor bank C3 being switched on or off depending on its switch status.
Checked Back Bank 0 ... 3 input: A logical 1 signal on this input indicates whether capacitor bank \( C_0 \) ... capacitor bank \( C_3 \) is switched on.

Alarm Q output: A logical 1 signal can be tapped here if all capacitor banks in the network are already switched on and the power factor for the reactive power control still remains below the limit.

Alarm \( \cos \Phi \) output: A logical 1 signal can be tapped here if the set power factor \( \cos \Phi \) for the alarm is instantaneously below the limit.

Alarm Operat. output: A logical 1 signal can be tapped here if the set maximum number of switching cycles for one of the capacitor banks is exceeded.

Alarm General output: A logical 1 signal can be tapped here if a general alarm is generated following relevant input information such as (OVERTEMP., V MIN/ MAX, VA MAX, DISCONNECT).

The function is blocked as long as the alarm is active. The Power Factor Controller is only ready for operation again after the alarm has been acknowledged.

Switch On/Off Bank 0 ... 3 output (once per condensator bank): A logical 1 signal or logical 0 signal can be tapped here if capacitor bank \( C_0 \) ... \( C_3 \) is to be switched on or off.

**Configuration**

The following sections describe several tabs. In all tabs the **OK** and **Cancel** buttons are available.

**OK**

Click **OK** to save all settings in the configuration software. The dialog box is closed.

**Cancel**

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.
General

Field bus address

Set for every protection function and used to address the function block for field bus commands.

Switching Sequence

In the Switching Sequence select how the capacitor banks should be switched on or off when they are the same size:

Linear

It is switched on in ascending sequence and switched off in descending sequence.

Circular

It is switched on and off in ascending sequence.

Switching Hysteresis

Under Switching Hysteresis enter the settings for switching the capacitor banks on or off for reactive power control:
Neutral zone ($K_{OFF}$)

The threshold for switching off is calculated with the adjustable percentage factor, which is based on the smallest installed capacitor output $Q_{C0}$.

Setting range: 105 ... 200 % of $Q_{C0}$ (increment: 1).
Default: 115

Pickup value ($K_{ON}$)

The threshold for switching on is calculated with the adjustable percentage factor, which is based on the smallest installed capacitor output $Q_{C0}$.

Setting range: 0 ... 100 % of $Q_{C0}$ (increment: 1).
Default: 0

Capacitor Banks

![Capacitor Banks](image)

Fig. 4.3.6.7.-3 Capacitor Banks tab, function block Power Factor Controller

Reactive power of smallest bank $Q_{C0}$

The default of the smallest module of the set capacitor output in bank is 0.
Setting range: 1,000 ... 20,000 kVar (increment: 1)
Default: 100,000

Configuration of banks

The default of the combinations of output units of the capacitor banks in the sequence bank 0, bank 1, bank 2 and bank 3. Using less than 4 banks the figures beginning from the right are ignored.

Default: 1:1:1:1

Number of banks

Setting the number of installed capacitor banks.

Setting range: 1 ... 4 (increment: 1)
Default: 1

Maximum switching cycles

An alarm message can be generated with this setting if the number of switching cycles of one switching device of a capacitor bank is exceeded.

Setting range: 0 ... 10000 (increment: 1)
Default: 2500

Control Data

Fig. 4.3.6.7.-4  Control Data tab, function block Power Factor Controller
Setpoint cos phi, day (once per parameter set)

Enter the set point of the power factor cos phi for day control of the reactive power. If the value drops below the set point, the control is activated.

Setting range: 0.70 ... 1.00 (increment: 0.01)
Default: 0.90

Setpoint cos phi, night (once per parameter set)

Enter the set point of the power factor cos phi for night control of the reactive power. If the value drops below the set point, the control is activated.

Setting range: 0.70 ... 1.00 (increment: 0.01)
Default: 0.90

Inductive/capacitive (under Setpoint cos phi)

Allows setting of the type of reactive power to be compensated.

Default: Inductive

Limiting value cos phi (Alarm) Day (once per parameter set)

Enter the limit value of the power factor cos phi for the alarm during day operation. If the value falls below the limit value, an alarm message is generated.

Setting range: 0.00 ... 1.00 (increment: 0.01)
Default: 0.00

Inductive/capacitive (under Limiting value cos phi (Alarm) Day)

Allows setting of the type of reactive power to be compensated.

Default: Inductive

Limiting value cos phi (Alarm) Night (once per parameter set)

Enter the limit value of the power factor cos phi for the alarm during night operation. If the value falls below the limit value, an alarm message is generated.

Setting range: 0.00 ... 1.00 (increment: 1)
Default: 0.00

Inductive/capacitive (under Limiting value cos phi (Alarm) Night)

Allows setting of the type of reactive power to be compensated.
Default: Inductive

**Method of operation (once per parameter set)**

The criteria for controlling the reactive power can be determined directly from the current values or after integration of averaging the values.

Setting range: Direct/integrating
Default: Direct

**Time**

**Discharge blocking time (once per parameter set)**

After a capacitor bank is switched off, it can only be switched on again after the discharge period has expired.

Setting range: 1 ... 7200 s (increment: 1)
Default: 900

**Dead time (once per parameter set)**

After a capacitor bank is switched on, the control function is initially deactivated for the period of the dead time. Setting range: 1 ... 120 s (increment: 1) Default: 10
Setting range: 1 ... 120 s (increment: 1)
Default: 10

Power on delay (once per parameter set)

After a complete switch off of all capacitor banks the reclosing is avoided for the power on delay time.

Setting range: 1 ... 7200 s (increment: 1)
Default: 900

Duration of integration (once per parameter set)

The reactive power or the power factor is determined after the values have been averaged within the set integration period. The Duration of integration parameter is used from the function block only if integration is used as a method of operation.

Setting range: 1 ... 7200 s (increment: 1)
Default: 900

Events

Fig. 4.3.6.7.-6 Events tab, function block Power Factor Controller
The main part in the Events tab is the list of events. The channel number over which the events are sent is shown in the left column near the check box. To enable the individual events to be transmitted to the substation automation system, transmission of events must be generally enabled.

The events of the function block Power Factor Controller must also be enabled. Mark the adjacent check box so the event is generated and sent as required.

**Set All**

Click the **Set All** button to select, generate and send all events as required.

**Clear All**

Click the **Clear All** button to clear the selection.

**Set Default**

Click the **Set Default** button to use the default configuration for events. The default configuration for events for each function object is defined in the associated file *.rce.*

**Save Default**

Click the **Save Default** button to save the checked events in the associated *.rce file.

**Event Masks E15 ... E0 and E31 ... E16**

The selecting of events is also possible in the Event Masks text boxes. The input must be in hexadecimal code (Refer to the following table for the events E0 to E15). The input for the events E16 to E31 is in principle similar. The events 28 to 31 are not used in this function block. If you select the check boxes in the list you can read the hexadecimal code in the text boxes.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>97 E0</td>
<td>Bank 0 ON</td>
</tr>
<tr>
<td>97 E1</td>
<td>Bank 1 ON</td>
</tr>
<tr>
<td>97 E2</td>
<td>Bank 2 ON</td>
</tr>
<tr>
<td>97 E3</td>
<td>Bank 3 ON</td>
</tr>
<tr>
<td>97 E4</td>
<td>Overtemperature started</td>
</tr>
<tr>
<td>97 E5</td>
<td>Bank 0 OFF</td>
</tr>
<tr>
<td>97 E6</td>
<td>Bank 1 OFF</td>
</tr>
<tr>
<td>97 E7</td>
<td>Bank 2 OFF</td>
</tr>
<tr>
<td>97 E8</td>
<td>Bank 3 OFF</td>
</tr>
<tr>
<td>97 E9</td>
<td>Overtemperature back</td>
</tr>
<tr>
<td>97 E10</td>
<td>Va max started</td>
</tr>
<tr>
<td>97 E11</td>
<td>Va max back</td>
</tr>
<tr>
<td>97 E12</td>
<td>Vmin/max started</td>
</tr>
<tr>
<td>97 E13</td>
<td>Vmin/max back</td>
</tr>
<tr>
<td>97 E14</td>
<td>Command DISCONNECT started</td>
</tr>
<tr>
<td>97 E15</td>
<td>Command DISCONNECT back</td>
</tr>
<tr>
<td>97 E16</td>
<td>Cos phi warning started</td>
</tr>
<tr>
<td>97 E17</td>
<td>Cos phi warning back</td>
</tr>
<tr>
<td>97 E18</td>
<td>Alarm Q started</td>
</tr>
<tr>
<td>97 E19</td>
<td>Alarm Q back</td>
</tr>
</tbody>
</table>
In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.7. Communication objects

The sections below describe the function blocks that are available in **Drawing Menu > Insert > Communication Objects**.

The following function block is used for vertical communication to the host with LON per LAG 1.4. Also horizontal communication for interlocking between the bays is possible.
4.3.7.1. Binary Write

The Binary Write function block is used for vertical communication in transmitting the binary information to the host. This function block must be updated by the field bus during the configured time. After a time out the output valid and the 16 data outputs are reset with logical 0. After each new update the output valid is set back again to logical 1. The default time is 1000 ms. If the time is set to 0, the time controlling is not active, valid is permanently 1 and the output is never reset.

A maximum of 32 Binary Write function blocks can be entered.

Connection

Output 1: Connection of the logical signal that is to be sent to the substation control system.

Output VALID: Logical signal 1 is present, if the binary information has a valid qualifier.

Configuration

The following describes two tabs in the Binary Write dialog box. In all the tabs the OK and Cancel buttons are available.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
General

Field bus address

Set for every protection function and used to address the function block for field bus commands.

Instance number

Select the number of the used function block in the Instance number drop-down menu. In total 64 function blocks and respectively instance are available.

Setting range: 1 ... 32 [instance number] (increment: 1)
Default: 1

Refresh timeout period

The time duration to be set for recognizing the information from the host.

Setting range: 0 ... 65000 ms (increment: 1)
Default: 1000
In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.
4.3.7.2. 16-Bit Write

**Function**

The 16-Bit Write function block is dedicated as well for the vertical communication to receive RESERVE requests and RESERVE confirmations as also for horizontal communication to receive the interlocking information from other bays. Each change of the inputs creates an event with the port number of the changed input as its value information.

The function block must be updated by the field bus during the configured time. After a time out the output valid and the 16-data outputs are reset to logical 0. After each new update the output valid is set back again to logical 1. The default time is 1000 ms. If the time is set to 0, the time controlling is not active, valid is permanently 1 and the output is never reset.

A maximum of 64 16-Bit Write function block can be entered.
Connection

Output 1 ... 16: Connection of the logical signal that is to be sent to the substation control system.
Output VALID: Logical signal 1 is present, if the binary information has a valid qualifier.

Configuration

The following describes two tabs in the 16-Bit Write dialog box. In all the tabs the OK and Cancel buttons are available.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

General

Field bus address

The Field bus address is set for every protection function and used to address the function block for field bus commands.
**Instance number**

Select the number of the used function block in the *Instance number* drop-down menu. In total 64 function blocks and respectively instance are available.

Setting range: 1 ... 64 [instance number] (increment: 1)
Default: 1

**Refresh timeout period**

The time duration to be set for recognizing the information from the host.

Setting range: 0 ... 65000 ms (increment: 1)
Default: 1000

**Pins**

![Image of 16-Bit Write function block]

*Fig. 4.3.7.2.-3 Pins tab, function block 16-Bit Write*

In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.
4.3.7.3. Binary Read

Function

The Binary Read function block is used as vertical communication to read binary information transmitted by the host.

A maximum of 32 Binary Read function block can be entered.

Connection

Input 1: Connection of the logical signal that is to be read from the host within the substation control system.

Configuration

The following sections describe two tabs in the Binary Read dialog box. In all tabs the OK and Cancel buttons are available.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
General

Field bus address

The Field bus address is set for every protection function and used to address the function block for field bus commands.

Instance number

Select the number of the used function block in the Instance number drop-down menu. In total 64 function blocks and respectively instance are available.

Setting range: 1 … 64 [instance number] (increment: 1)
Default: 1

Event: 0->1

The event number assigned to the event when sent. The event is generated if the logical state at the input changes from 0 to 1 and is sent via the related channel with the selected event number.

Event: 1->0

The event number assigned to the event when sent. The event is generated if the logical state at the input changes from 1 to 0 and is sent via the related channel with the selected event number.
In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.
### 4.3.7.4. 16-Bit Read

**Function**

The 16-Bit Read function block is used as well for vertical communication to receive the RESERVE requests and RESERVE confirmations transmitted by the host, as also for horizontal communication to receive the interlocking information from other bays. All changes of the inputs create an event with the instance number of the changed input as its value information.

A maximum of 32 binary read function block can be entered.

**Connection**

Input 1 … 16: Connection of the logical signal that is to be read from the host within the substation control system.

**Configuration**

The following sections describe two tabs in the 16-Bit Read dialog box. In all tabs the **OK** and **Cancel** buttons are available.
OK

Click **OK** to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.

General

![General tab, function block 16-Bit Read](image)

**Field bus address**

The Field bus address is set for every protection function and used to address the function block for field bus commands.

**Instance number**

Select the number of the used function block in the **Instance number** drop-down menu. In total 64 function blocks and respectively instance are available.
Setting range: 1 ... 64 [instance number] (increment: 1)
Default: 1

**Delay time**

Setting range: 0 ... 65000 ms
Default: 0

**Event**

The number of the event being used by the function block.

**Pins**

![Image of Pins tab, function block Binary Read]

*Fig. 4.3.7.4.-3 Pins tab, function block Binary Read*

In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.
4.3.7.5. Direct Read-Write

Function

The Direct Read-Write function block enables logical signals to be exported from the function chart to a station control system. Logical signals can also be sent in the reverse direction from the control system to the function chart.

A maximum of 100 Direct Read-Write commands can be entered.

Typical application

A typical application is implementing station-level interlocking over the field bus.

Connections

Input R: Connection of the logical signal that is to be sent to the station control system.

Output W: Signaling output of the logical signal that the station control system is send to the function chart.

Configuration

The following sections describe two tabs in the Direct Read-Write dialog box. In all tabs the OK and Cancel buttons are available.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
**General**

![Image of the Direct Read-Write window](image)

*Fig. 4.3.7.5.-2  General tab, function block Direct read-write*

**Field bus address**

The Field bus address is set for every protection function and used to address the function block for field bus commands.

**Signal number**

Select the signal number/event number over which a logical signal is sent or received. Channel and signal/event number are also shown in the function chart below the function block.

- **Setting range:** 0 ... 99 (increment: 1)
- **Default:** Next free signal number
Pins

In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.7.6. Event Generator

The Event Generator function block generates an event if the state at the input changes from logical 0 to logical 1 or vice versa. This event can be processed by the station control system.

A maximum of 63 events can be generated with event generators, with every event generator being able to transmit 2 events.
Typical application

A typical application is generating a real-time event for the substation control system, if a function block does not provide a corresponding event.

Connections

Input left: Every change of the logical state generates an event.

Configuration

The following section describes two tabs in the Event Generator dialog box. In all the tabs the OK and Cancel buttons are available.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.

General

![Event Generator dialog box](image)

Fig. 4.3.7.6.-2 General tab, function block Event generator
Field bus address

The Field bus address is set for every protection function and used to address the function block for field bus commands.

**Event: 0->1**

The event number assigned to the event when sent. The event is generated if the logical state at the input changes from 0 to 1 and is sent via the related channel with the selected event number. The event is generated if the logical state at the input changes from 0 to 1 and is sent via channel 100 (default) with the selected event number. The input "0" prevents an event from being transmitted.

Setting range: 0 … 63 (increment: 1)
Default: 0

**Event: 1->0**

The event number assigned to the event when sent. The event is generated if the logical state at the input changes from 1 to 0 and is sent via channel 100 (default) with the selected event number. The input "1" prevents an event from being transmitted.

Setting range: 0 … 63 (increment: 1)
Default: 1

**Pins**

Fig. 4.3.7.6.-3 Pins tab, function block Event generator
In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.7.7. Bay Reserve

![Bay Reserve Diagram]

Fig. 4.3.7.7.-1 Function block Bay Reserve

Function

The function block Bay Reserve is used to handle the SELECT/RESERVE mechanism and is needed once per bay. A maximum of 8 switching devices can be served by this function block. As well as the internal bay RESERVE requests, the RESERVE requests from other bays can be processed.

Reservation request

A switching device requires a reservation by putting a logical signal 1 on the related input RES.REQ.i (i = 1 … 8). This request can be configured by the input INT.REQ.i (i = 1 … 8) either only as an internal bay request or as a request, in which external bays must also be taken into account.
Reservation confirmation

The reservation is granted if the following conditions are fulfilled:

- No switching devices have already asked for reservation.
- No reservation request is present.

In case of an external bay reservation, all bays have already confirmed the reservation.

In case of granted reservation, the output RES.GRANT.i (i = 1 … 8) for the switching device, which is requesting the reservation, changes to logical signal 1. The same happens with the output RESERVED. The reservation is then granted until the reservation is reset by the corresponding switching device.

If an external reservation is configured by INT.RES.i (i = 1 … 8) = 0, the request is executed after the input GRANT FROM ANY is set to logical 0, which means that all other bay reservations have been reset. Subsequently the output EXT.RES is set to logical 1. This information must then be transmitted to the host of the substation control system by the 16-Bit Read function block.

The Bay Reserve function block now waits for the logical signal 1 at the input GRANT FROM ALL and the input GRANT VALID, which indicates the validity of the information on the field bus.

Reservation request from other bays

A logical 1 signal at the input of EXT.RES.REQ. shows a reservation request from another bay. The bay must confirm the reservation and cannot generate any bay internal reservation any more. The bay confirms the reservation under the following condition:

- The bay is not internally or externally reserved.
- The input EXT.REQ.VALID is set to a logical 1 signal and indicates the validity of the reservation on the field bus.

The reservation is confirmed, if the related output RES-GRANT.i (i = 1 … 8) becomes a logical 1 signal. This information must then be transmitted by the field bus to the external bay, which is requesting the reservation.

Connections

Input RES.REQ.i (i = 1 … 8): If a reservation of the assigned switching device is requested, the input is set with a logical 1 signal.

Input INT.REQ.i (i = 1 … 8): If an external reservation for the assigned switching device is needed, the input is set with a logical 1 signal. If only internal reservation for the assigned switching device is needed, the input is set with a logical 0 signal.

Input GRANT FROM ALL: If all other external bays have confirmed the reservation, the input is set with a logical 1 signal.
Input GRANT FROM ANY: If at least one external bay still indicates a confirmation of a previous reservation, the input is set with a logical 1 signal.

Input GRANT VALID: If all reservation confirmations are valid after cyclic actuation by the field bus, the input is set with a logical 1 signal.

Input EXT:RES.REQ.: If a reservation request from another bay is present, the input is set with a logical 1 signal.

Input EXT.REQ.VALID: If the external request is valid, the input is set with a logical 1 signal.

Input BLOCK: If all reservations, inclusive the ongoing reservation, is blocked, the input is set with a logical 1 signal.

Input OVERRIDE: If the mechanism of the reservation is set out of order, the input is set with a logical 1 signal. All reservation requests, internally and externally are granted.

Output RES.GRANT.i (i = 1 … 8): If reservation of the assigned switching device is granted, the output becomes logical 1.

Output EXT.RES.: If reservation of the assigned switching device is granted, the output becomes logical 1.

Output EXT.GRANT.: To confirm the related external bays, that this bay is already prepared for executing the reservation request, the output becomes logical 1.

Output RESERVED: To indicate the reservation status of this bay, the output becomes logical 1.

Configuration

The following section describes two tabs in the Bay Reserve dialog box. In all the tabs the OK and Cancel buttons are available.

OK

Click OK to save all settings in the configuration software. The dialog box is closed.

Cancel

When clicking on the Cancel button, the settings are not saved in the configuration software. The dialog box is closed.
General

Fig. 4.3.7.7.-2 General tab, function block Bay Reserve

No parameters can be set in the General tab of the Bay Reserve dialog box.

Pins

Fig. 4.3.7.7.-3 Pins tab, function block Bay Reserve
In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.7.8. Switch Authority Allocation

Function

This function block is used to set and to verify the switch authority allocation of all switching devices installed in the switchgear. Without this function block the status of the electronic key on the HMI as Local Control Unit is taken as the control status (NO CONTROL, LOCAL, REMOTE, LOCAL & REMOTE). This function block can be applied to override the control status of the HMI electronic key or to extend the REMOTE definition for the allocation of the switch authority. In this case, when the control status evaluated by the function is REMOTE the switch authority allocation can be assigned to the Station Control Unit or to the Remote Control System.

Connection

Input VALID: Logical 1 signal makes the status of all inputs valid. Logical 0 causes the reset of all the output signals, that is all the switching commands are rejected. The output signals will be reset with a delay of 500 ms.

Input OFF: Logical 1 signal will set the control status as NO CONTROL. The OFF output signal will be put at logical 1 and the LOCAL/REMOTE/STATION output signals will be put at logical 0, i.e. all switching commands are rejected.

Input EXTERNAL: Logical 1 signal leads to an evaluation of the switch authority allocation to the EXT.KEY LOCAL/REMOTE input signals. The HMI electronic key state cannot be updated anymore. In case of logical 0, the function will evaluate
the switch authority allocation from the HMI electronic key. In this case the EXT. KEY LOCAL/REMOTE input signals are ignored and the HMI electronic key state can be updated.

Input EXT.KEY LOCAL: Logical 1 signal, together with EXTERNAL input at logical 1, activates the LOCAL control status. Logical 0 signal deactivates the LOCAL control status.

Input EXT.KEY REMOTE: Logical 1 signal, together with EXTERNAL input at logical 1, activates the REMOTE control status. Logical 0 signal deactivates the REMOTE control status.

Input STATION LOCAL: Logical 1 rising slope will enable the local control of the station.

Input STATION REMOTE: Logical 1 rising slope will change the station control to remote control.

Input STATION KEY LOCAL: Logical 1 rising slope advises that the station key is set to local.

Input STATION KEY REMOTE: Logical 1 rising slope advises that the station key is set to remote.

Input FORCE VALID: Logical 1 signal forces the control status as REMOTE.

Output VALID: Logical 1 signal is present if the input signal is valid.

Output OFF: Logical 1 signals NO CONTROL status, that is all switching commands are rejected.

Output LOCAL: Logical 1 signals LOCAL control status, that is switching commands from HMI Control Unit are accepted.

Output STATION: Logical 1 signals station control status, that is switching commands from Station Control Unit are accepted. It is activated in REMOTE control status when the local control of the station is enabled (input STATION LOCAL) or the station key is set to local (input STATION KEY LOCAL).

Output REMOTE: Logical 1 signals remote control status, that is switching command from Remote Control System are accepted. It is activated in REMOTE control status when the remote control of the station is enabled (input STATION REMOTE) and the station key is set to remote (input STATION KEY REMOTE).
General

No parameters can be set in the General tab of the Switch Authority Allocation dialog box.

Pins

Fig. 4.3.7.8.-2  General tab, function block Switch Authority Allocation

Fig. 4.3.7.8.-3  Pins tab, function block Switch Authority Allocation
In the Pins tab, the user can see a list of connections on the function block and information about the wire number connected to the pin is available. There is also information regarding whether the pin is an input or an output of the function block. The connection numbers 1 (on one input) or 2 (on one output) are displayed if the function block still has no connections made.

4.3.8. CAN Communication Objects

Applicable only for ABB the switchgear companies.

4.3.9. Miscellaneous objects

The following sections contain the descriptions of the function blocks that are available in Drawing Menu > Insert > Miscellaneous Objects.

4.3.9.1. Parameter Set Selector

Function

The Parameter Set Selector function block can switch the parameters set of the protections via FUPLA. The parameter set can be changed if the device is in “run mode” and one of the activation inputs has a rising edge.

After a parameter set selection the outputs of the function block are updated, showing which parameter set is active. Additionally the FUPLA signals show command and storing feedback and status.

Connections

Input ACTIVATE SET1: If REF 542plus is in “run mode” and input shows a rising edge, parameter set 1 is activated. Default: The input pin is bound to “LOW” (wire number 1; the wire # for open inputs).
Input ACTIVATE SET2: If REF 542plus is in “run mode” and input shows a rising edge, parameter set 2 is activated. Default: The input pin is bound to “LOW” (wire number 1; the wire # for open inputs).

Input DISABLE COMMANDS: A logical 1 signal at this input disables changing of the active parameter set when a command is detected. In this case, that is command detected while SetCommandDisable input is at logical 1, the SetCommandFail output is set to logical 1.

Input DISABLE STORING: A logical 1 signal at this input disables FLASH storing of configuration at successful commands.

Output SET1 ACTIVE: High if Parameter Set 1 is active.

Output SET2 ACTIVE: High if Parameter Set 2 is active.

Output SET CMD ENABLED: A logical 1 at this output indicates that a set command is enabled. The enable conditions are: Logical 0 at Disable Commands input, Autoreclose is not active, and Alarm LED is not active.

Output SET CMD FAIL: A logical 1 at this output indicates that the last set command has been detected but it has not been processed due to fail in the enable conditions.

Output STORING: A logical 1 at this output indicates that a configuration storing is active. Note that the configuration storing signaling is independent from the parameter set selector command, that is it is at logical 1 also after a parameterization (HMI, communication board and so on) or after a configuration download.

Output STORING FAIL: A logical 1 at this output indicates that the last configuration storing has failed. Note that the configuration storing fail signaling is independent from the parameter set selector command, that is it is at logical 1 also when a parameterization (HMI, communication board and so on) or a configuration download storing fails.
Configuration

Fig. 4.3.9.1.-2 General tab of configuration dialog box for Parameter Set Selector

Events

Fig. 4.3.9.1.-3 Events tab of configuration dialog box for Parameter Set Selector
Events description:
E0, E1: Disable commands started/back
E2, E3: Disable storing started/back
E4, E5: Set1 command started/back
E6, E7: Set2 command started/back
E16, E17: Storing started/back
E18, E19: Storing fail started/back
E20, E21: Set command enabled started/back
E22, E23: Set command fail started/back
E24, E25: Set1 active started/back
E26, E27: Set2 active started/back

Pins

Fig. 4.3.9.1.-4 Pins tab of configuration dialog box for Parameter Set Selector
4.3.9.2. **Operating hours counter**

*Fig. 4.3.9.2.-1 Function block Operating hours counter*

**Function**

The Operating hours counter function block counts the operating hours as long as there is a logical 1 at its input. A number of operating hours can be set as the start value.

If an Operating hours counter function block is implemented, the internal Operating hours counter counts only the hours for which REF 542plus is connected to the auxiliary voltage. The number of operating hours is shown on the HMI of the REF 542plus LCD in the operational measured values ring menu. The count of the internal counter or of the Operating hours counter function block, if activated, is used.

![Operating hours counter](image)

Only one Operating hours counter function block can be used in the application.

**Typical application**

A typical application is that the operating hours of any equipment can be recorded.

**Connections**

Input left: If this input is set with logical 1, the operating hours counting begins.
Configuration

![Operating hours counter dialog box](image)

Fig. 4.3.9.2.-2 Configuration dialog box of function block Operating hours counter

**Operating hours**

Input of the factor multiplied by 1000 that sets the initial value of the Operating hours counter.

- Setting range: 0…9 (increment: 0.001)
- Default: 0.000

**Pins**

Under Pins is a list of connections on the function block with adjacent connection number. The connection numbers 1 (on one input) and 2 (on one output) are displayed if the function block still has no connections made.

**OK**

Click **OK** to save all settings in the configuration software. The dialog box is closed.

**Cancel**

When clicking on the **Cancel** button, the settings are not saved in the configuration software. The dialog box is closed.
## Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Tool</td>
<td>Software program to configure the REF 542plus. This program runs on a PC.</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Physical communication network to transfer Internet data of the REF 542plus to the PC and back.</td>
</tr>
<tr>
<td>Modbus</td>
<td>By extension, communication board implementing the Modbus protocol for REF 542plus.</td>
</tr>
</tbody>
</table>
## Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI</td>
<td>American National Standards Institute</td>
</tr>
<tr>
<td>AR</td>
<td>Autoreclosure</td>
</tr>
<tr>
<td>ASCII</td>
<td>American Standard Code for Information Interchange</td>
</tr>
<tr>
<td>ASDU</td>
<td>Application Service Data Unit (IEC 60870-5-103 communication protocol).</td>
</tr>
<tr>
<td>BI</td>
<td>Binary input</td>
</tr>
<tr>
<td>CAN</td>
<td>Controller area network</td>
</tr>
<tr>
<td>CB</td>
<td>Circuit-breaker</td>
</tr>
<tr>
<td>CT</td>
<td>Current transformer</td>
</tr>
<tr>
<td>FUPLA</td>
<td>Function block programming language; Functional programming language; Function plan; Function chart</td>
</tr>
<tr>
<td>GPS</td>
<td>Global positioning system</td>
</tr>
<tr>
<td>HMI</td>
<td>Human-machine interface</td>
</tr>
<tr>
<td>ID</td>
<td>Identifier; identification</td>
</tr>
<tr>
<td>IEC</td>
<td>International Electrotechnical Commission</td>
</tr>
<tr>
<td>IEC 61850</td>
<td>International standard for substation communication and modelling</td>
</tr>
<tr>
<td>IP</td>
<td>Internet protocol</td>
</tr>
<tr>
<td>LAG</td>
<td>Lon application guide</td>
</tr>
<tr>
<td>LCD</td>
<td>Liquid crystal display</td>
</tr>
<tr>
<td>LD HMI</td>
<td>Local detachable human-machine interface</td>
</tr>
<tr>
<td>LED</td>
<td>Light-emitting diode</td>
</tr>
<tr>
<td>LON</td>
<td>Local operating network</td>
</tr>
<tr>
<td>MAC</td>
<td>Media access control</td>
</tr>
<tr>
<td>MC</td>
<td>Micro controller</td>
</tr>
<tr>
<td>MSI</td>
<td>Microsoft installer technology</td>
</tr>
<tr>
<td>NPS</td>
<td>Negative-phase-sequence</td>
</tr>
<tr>
<td>PC</td>
<td>Personal computer</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable logical controller</td>
</tr>
<tr>
<td>PO</td>
<td>Power output, process object</td>
</tr>
<tr>
<td>RSV</td>
<td>Rated secondary value</td>
</tr>
<tr>
<td>SNTP</td>
<td>Simple Network Time Protocol</td>
</tr>
<tr>
<td>SPA</td>
<td>Data communication protocol developed by ABB</td>
</tr>
<tr>
<td>TCP</td>
<td>Transmission Control Protocol</td>
</tr>
<tr>
<td>VS</td>
<td>Voltage supervision</td>
</tr>
<tr>
<td>VT</td>
<td>Voltage transformer</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible markup language</td>
</tr>
</tbody>
</table>